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A
Acquisition Mode (Experiment Setup)
Acquisition Rate
Adaptation of Signals
Alphabetical List of Modules
Amplification (Module Configuration)
Amplitude and Offset (Generator)
Amplitude Correction (Data Window)
Amplitude Scaling (Display Window)
Analog Input    Module
Analog Input (Channel Selection Bar)
Analog Meter    Module
Analog Output    Module



Analog Output (Channel Selection Bar)
Animation (View Menu Command)
ARC Functions (Trigonometry Module)
Arithmetic    Module

Arithmetic (One Operand)
Arithmetic (Operand and Constant)
Arithmetic (Two Operands)

ASCII (Data Format)
Assignment of Scales (Display Window)
Autocorrelation and Cepstrum
Automatic Experiment/Program Start
Autorouter    (General Remarks)
Autorouter (Options Menu Command)
Auto Start (Experiment Menu Command)
Average    Module
Average (Block Average Module)
ax+b

B
Bandpass (Filter Type)
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Bar (Analog / Digital / Counter Input Channel Selection)
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Bar (Channel Number Selection)
Bar Graph    Module
Bartlet (Data Window)
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Black Box Create and Edit
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Black Box Open and Save

Blackman (Data Window)
Blackman-Harris (Data Window)
Block Average    Module
Block Number (Histogram)
Block Number (Statistics)
Block Size (Experiment Setup)
Branches    (General Remarks)

Branches (Create)
Branches (Delete)
Branches (Rearrange)

Buffer    (General Remarks)
Buffer (Driver Buffer Setup)
Butterworth Filter

C
Cartesian Coordinates    Module
Cauchy (Data Window)
Cepstrum
Channel Information (Module Configuration)

Channel Name (Module Configuration)
Channel Selection Bar (Analog / Digital / Counter Input)
Channel Selection Bar (Analog / Digital Output)
Channel Selection Bar (Number of Channels)



Characteristics (Filter)
Chart Recorder      Module
Chart Recorder    Display Window

Chart Recorder (Colors and Lines)
Chart Recorder (Continue)
Chart Recorder (Copy to Clipboard)
Chart Recorder (Cursor)
Chart Recorder (Display Y Unit)
Chart Recorder (Font Style)
Chart Recorder (Freeze)
Chart Recorder (Function Bar)
Chart Recorder (Grid)
Chart Recorder (Measuring Cursor)
Chart Recorder (One Chart/Multiple Charts)
Chart Recorder (Print)
Chart Recorder (Scale Assignment)
Chart Recorder (Time Scale)

Chebyshev Filter
Clipboard    (General Remarks)
Clipboard (Display Window)
Clipboard (Worksheet to Clipboard)
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Colors (Custom)

Colors (List Display Window)
Colors (Options Menu Command)
Colors and Lines (Display Window)
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Configuration (Module Name)
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Constant (Generator Wave Form)
Continue (Display Window)
Continue (Experiment Menu Command)
Control    Module Group
Control Limitation (PID)
Coordinates (Display Window)
Coordinates (Polar/Cartesian Coordinates Module)
Copy to Clipboard (Display Window)
Correlation    Module
Correlation (Autocorrelation)
Correlation Coefficient and Crosscorrelation
Cosine (Power of Cosine Data Window)
Cosine (Trigonometry Module)
Counter    Module
Counter Input    Module
Counter Input (Channel Selection Bar)
Country-specific Settings
Create (Data Channels)
Creating your First Worksheet (Instruction)



Cross Spectrum of two Real Signals (FFT)
Crosscorrelation
Cursor (Display Window)
Customizing the   DASY  Lab   Screen  
Customizing the Display Windows
Cut-off Frequency (Filter)

D
DASY  Lab   (Data Format)  
Data (Read Data Module)
Data (Write Data Module)
Data (Write Multiple Files)
Data Channels    (General Remarks)

Data Channels (Create)
Data Channels (Delete)
Data Channels (Rearrange)

Data Format (ASCII)
Data Format (  DASY  Lab  )  
Data Format (DIA/DAGO)
Data Format (Famos)
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Data Format (Signalys)

Data Reduction    Module Group
Data Window    Module
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Data Window (Blackman)
Data Window (Blackman-Harris)
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Data Window (Poisson)
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Data Window (Specifications)
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Data Window (Vector Size)
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DDE Input    Module
DDE Output    Module
Default (Module Bar)
Definitions (Glossary)
Delay (Time Delay Module)
Delete (Data Channels)
Delete (Module)
Delete Window Arrangement
Demo Worksheets
Description (Module Description)
DIA/DAGO (Data Format)
Differentiation / Integration    Module
Digital Input    Module
Digital Input (Channel Selection Bar)
Digital Meter    Module



Digital Output    Module
Digital Output (Channel Selection Bar)
Display    Module Group
Display Modules    (General Remarks)

Display Window    Chart Recorder
Display Window    List
Display Window    X/Y Chart
Display Window    Y/t Chart
Display Window (Amplitude Scaling)
Display Window (Colors and Lines)
Display Window (Continue)
Display Window (Copy to Clipboard)
Display Window (Display Y Unit)
Display Window (Edit)
Display Window (Font Style)
Display Window (Freeze)
Display Window (Function Bar)
Display Window (Grid)
Display Window (Measuring Cursor)
Display Window (Print)
Display Window (Scale Assignment)
Display Window (Time Scale Chart Recorder)
Display Window (Time Scale Y/t Chart)
Display Window (Waterfall Display)
Display Window (Zoom/Unzoom)
Display Windows (Customizing)
Display Windows (Delete Arrangement)
Display Windows (Hide)
Display Windows (Save Arrangement)
Display Windows (Select Arrangement)
Display Windows (Show)

Display Y Unit (Display Window)
Display/Remove (Function Bar)
Display/Remove (Module Bar)
DMA    (General Remarks)
Driver Buffer    (General Remarks)
Driver Buffer (Experiment Setup)

E
Edit Colors
Edit Menu Commands
Elements of the   DASY  Lab   Screen  
Examples of Worksheets
Exit (File Menu Command)
Experiment (Pause)

Experiment (Resume)
Experiment (Start)
Experiment (Stop)
Experiment Menu Commands
Experiment Setup (Experiment Menu Command)

Export/Import Black Box
Extended Cursor (Display Window)

F
F7F8 Function Keys
Famos (Data Format)



Fast Fourier Transform (see FFT)
FFT    General Remarks

FFT    Modules
FFT (Complex FFT of a Complex Signal)
FFT (Complex FFT of a Real Signal)
FFT (Cross Spectrum of two Real Signals)
FFT (dB Transform)
FFT (Operations)
FFT (Real FFT of a Real Signal)

File Info (File Menu Command)
File Menu Commands
Files    Module Group

Files (ASCII Data Format)
Files (  DASY  Lab   Data Format)  
Files (DIA/DAGO Data Format)
Files (Famos Data Format)
Files (IEEE 32 Bit Data Format)
Files (Read Data Module)
Files (Signalys Data Format)
Files (Write Data Module)
Files (Write Multiple Files)

Filter    Module
Filter (Bandpass)
Filter (Bandstop)
Filter (Bessel)
Filter (Butterworth)
Filter (Characteristics)
Filter (Chebyshev)
Filter (Cut-off Frequency)
Filter (Highpass)
Filter (Lowpass)
Filter (Order)
Filter (Quality Factor)
Filter (Types)

Font Style (Display Window)
Font Style (List Display Window)
Format (ASCII Data Format)

Format (  DASY  Lab   Data Format)  
Format (DIA/DAGO Data Format)
Format (Famos Data Format)
Format (IEEE 32 Bit Data Format)
Format (Page Format)
Format (Signalys Data Format)

Fourier (FFT Module)
Freeze (Display Window)
Frequency (Cut-off Frequency Filter)
Frequency (Generator)
Function Bar    (General Remarks)

Function Bar (Display Window)
Function Bar (Screen Element)
Function Bar Configuration
Function Bar Display

Function Keys (F7/F8)
Functions (Trigonometry)
Functions of Multiple Input Channels



G
Gauss (Data Window)
Generator    Module

Generator (Amplitude and Offset)
Generator (Frequency)
Generator (Phase Shift)
Generator (Real Time Output)
Generator (TTL Pulse Generator Module)
Generator (Wave Form)

Glossary
Grid (Colors)

Grid (Display Window)
Grid (Window Setup)

Group (Module Groups)

H
Hamming (Data Window)
Hanning (Data Window)
Hanning-Poisson (Data Window)
Hardware Setup (Experiment Menu Command)
Help Index
Help Menu Commands (Help Menu Command)
Help on Help
Hide (View Menu Command)
Hide Display Windows (View Menu Command)
Highpass (Filter Type)
Histogram    Module

Histogram (Block Count)
Histogram (Normalization)
Histogram (Range)

Horizontal Cursor (Display Window)
How to Start/Stop an Experiment (Instruction)
How to use   DASY  Lab   Help  
Hyperbolic Functions (Trigonometry Module)
Hysteresis (Pre/Post Trigger)

I
IEEE 32 Bit (Data Format)
IEEE 488 Interface    Module
Import/Export Black Box
Information (Channel Information)
Information on Files (File Menu Command)
Information on Function Bar Symbols
Input (Analog Input Module)
Input (Counter Input Module)
Input (Digital Input Module)
Input Channel Selection Bar (Analog / Digital / Counter Input)
Input/Output    Module Group
Input/Output (Channel Configuration)
Install Modules
Instruments: Analog Meter
Instruments: Digital Meter
Integration    Module
Interface ieee488    Module
Interface RS232    Module
International Settings



Interpolation    Module
Interpolation (Scaling)
Interrupt Request Level (IRQ)    (General Remarks)

J
Junction Points    (General Remarks)
Junction Points (Thermocouple Linearization)

K
Keyboard Operations

L
Lamp (Status Lamp Module)
Latency Period    (General Remarks)
Leakage Effect (Data Window Module)
Leakage Effect (FFT Module)
LED (Status Lamp Module)
Limitation (PID)
Linear Scaling
Linearization (Thermocouple)
Lines (Display Window)
List    Display Module
List    Display Window

List (Color Settings)
List (Continue)
List (Copy to Clipboard)
List (Display Y Unit)
List (Font Style)
List (Freeze)
List (Function Bar)
List (Print)
List (Time Channel)

Logical Operations    Module
Lowpass (Filter Type)

M
Main Menu Options (Help Menu Command)
Manipulation (of Modules)
Mathematics    Module Group
Measuring Cursor (Display Window)
Memory (DMA)
Memory (Driver Buffer)
Menu Bar (Screen Element)
Mode (Acquisition)
Mode (Statistics)
Module    (General Remarks)
Module (Alphabetical List of Available Modules)
Module Bar    (General Remarks)

Module Bar (Default)
Module Bar (Edit Menu)
Module Bar (New)
Module Bar (Open
Module Bar (Save As)
Module Bar (Screen Element)
Module Bar Display

Module Configuration
Module Description (Module Configuration)



Module Group    (General Remarks)
Module Group (Control)
Module Group (Data Reduction)
Module Group (Display)
Module Group (Files)
Module Group (Input/Output)
Module Group (Mathematics)
Module Group (Signal Analysis)
Module Group (Statistics)
Module Group (Trigger Functions)

Module Manipulation
Module Menu Commands
Module Name (Module Configuration)
Module Symbols
Modules (Alphabetical List)
Modules (Display Modules)
Move (Modules)
Multiple Files (Write Data)
Multiple Input Channels
Multiple Charts/One Chart (Display Window)

N
Name (Channel Name)
Name (Module Name)
New (File Menu Command)
New (Module Bar)
New in   DASY  Lab   Version 2  
No Operation (NOP)
Noise (Generator Wave Form)
NOP Function (No Operation)
Normalization (Histogram)
Number of Blocks (Histogram)
Number of Blocks (Statistics)
Number of Channels (Channel Selection Bar)
Number of Charts (Display Window)
Numerical Display Module
Numerical Display Window

O
Offset (Generator)
One Chart/Multiple Charts (Display Window)
One Operand (Arithmetic)
Open (File Menu Command)
Open (Module Bar)
Open (Read Data Module)
Operand (One Operand)

Operand (Operand and Constant)
Operand (Two Operands)

Operations (FFT dB Transform)
Operations (FFT)
Operations (Logical Operations Module)
Operations (Statistics)

Options Menu Commands
Order (Filter)
Output    Module Group

Output (Analog Output Module)



Output (Channel Configuration)
Output (DDE Output Module)
Output (Digital Output Module)

Output Channel Selection Bar (Analog / Digital Output)
Output Setup (Experiment Menu Command)
Overview (View Menu Command)

P
Page Format (File Menu Command)
Password Definition (Options Menu Command)
Password Protection (Options Menu Command)
Pause (Experiment Menu Command)
Phase Shift (Generator)
PID    Control Module

PID (Components)
PID (Control Limitation)

Poisson (Data Window)
Polar/Cartesian Coordinates    Module
Post Trigger    Module

Post Trigger (Hysteresis)
Post Trigger (Range)

Power of Cosine (Data Window)
Pre/Post Trigger    Module

Pre/Post Trigger (Hysteresis)
Pre/Post Trigger (Range)

Print (Display Window)
Print (File Menu Command)
Print (Page Format)

Printer Setup (File Menu Command)
Pulse (Generator Wave Form)
Pulse Generator    Module

Q
Quality Factor (Filter)
QuickInfo
Quit (Exit)

R
Range (Histogram)

Range (Pre/Post Trigger)
Range (Start/Stop Trigger)

Read (File Menu Command)
Read (Module Bar)
Read Data    Module
Real FFT of a Real Signal
Real Time Output (Generator)
Rearrange (Data Channels)
Recorder    Module
Recorder Display Window
Rectangle (Data Window)
Rectangle (Generator Wave Form)
Reduction (Data Reduction Module Group)
Regression    Module
Relay    Module
Resume (Experiment Menu Command)
RS232 Interface    Module



S
Sampling Rate (Experiment Setup)
Save (File Menu Command)
Save (Write Data Module)
Save (Write Multiple Files)
Save As (File Menu Command)
Save As (Module Bar)
Save Window Arrangement
Select Window Arrangement
Sawtooth (Generator Wave Form)
Scale Assignment (Display Window)
Scaling (Amplitude Display Window)
Scaling (Linear)
Scaling/Interpolation    Module
Screen Customization (Instruction)
Screen Elements
Selecting Number of Input/Output Channels
Selection of Channels (Analog / Digital / Counter Input)
Selection of Channels (Analog / Digital Output)
Separate    Module
Setup (Experiment)
Setup (Hardware)
Setup (Output)
Shannon (FFT Module)
Shannon (Generator Frequency)
Show Display Windows (View Menu Command)
Signal Adaptation
Signal Analysis    Module Group
Signal Generator    Module

Signal Generator (Amplitude and Offset)
Signal Generator (Frequency)
Signal Generator (Phase Shift)
Signal Generator (Real Time Output)
Signal Generator (Wave Form)

Signalys (Data Format)
Sine (Generator Wave Form)
Sine (Trigonometry Module)
Slice (Time Slice Module)
Slider Module
Specifications (Data Window)
Spectrum (FFT Operations)
Square (Generator Wave Form)
Start (Automatic Program/Experiment Start)
Start (Auto Start)
Start (Experiment Menu Command)
Start Experiment (Instruction)
Start/Stop at Time (Experiment Menu Command)
Start/Stop Trigger    Module
Start/Stop Trigger (Range)
Statistics    Module Group

Statistics (Mode)
Statistics (Number of Blocks)
Statistics (Statistical Operations)

Statistics (Statistical Values Module)
Status Bar (Screen Element)
Status Lamp    Module



Stop    Module
Stop (Experiment at Time)
Stop (Experiment Menu Command)
Stop Experiment (Instruction)
Stop Trigger    Module
Stop Trigger (Range)
Switch    Module
Symbols (Module Symbols)

T
Tangent (Trigonometry Module)
Thermocouple Linearization (Scaling)
Time (Real Time Output Generator)
Time (Start/Stop Experiment at Time)
Time Channel (List Display Window)
Time Delay    Module
Time Scale (Chart Recorder)
Time Scale (Y/t Chart)
Time Slice    Module
Title Bar (Screen Element)
Triangle (Generator Wave Form)
Trigger (Hysteresis Pre/Post Trigger)

Trigger (Pre/Post Trigger Module)
Trigger (Range Pre/Post Trigger)
Trigger (Range Start/Stop Trigger)
Trigger (Start/Stop Trigger Module)
Trigger Functions    Module Group

Trigonometry    Module
TTL Pulse Generator    Module
Tukey (Data Window)
Two Operands (Arithmetic)
Types of Data Windows
Types of Filters

U
Unfreeze (Display Window)
Unit (Display Window)
Unzoom (Display Window)

V
Vector Size (Data Window)
View Menu Commands

W
Waterfall Display (Display Window)
Wave Form (Generator)
Window Arrangement: Delete
Window Arrangement: Save
Window Arrangement: Select
Window Setup (Options Menu Command)
Window Types (Data Window)
Windows    Module
Work Area (Screen Element)
Worksheet    (General Remarks)
Worksheet Examples
Worksheet to Clipboard (Edit Menu Command)
Write (File Menu Command Save As)



Write (File Menu Command Save)
Write Data    Module

Write Data (ASCII Data Format)
Write Data (  DASY  Lab   Data Format)  
Write Data (DIA/DAGO Data Format)
Write Data (Famos Data Format)
Write Data (IEEE 32 Bit Data Format)
Write Data (Multiple Files)
Write Data (Signalys Data Format)

X
X Axis Scale (X/Y Chart)
X/Y Chart      Module
X/Y Chart    Display Window

X/Y Chart (Colors and Lines)
X/Y Chart (Copy to Clipboard)
X/Y Chart (Display Y Unit)
X/Y Chart (Font Style)
X/Y Chart (Function Bar)
X/Y Chart (Grid)
X/Y Chart (One Chart/Multiple Charts)
X/Y Chart (Print)
X/Y Chart (Scale Assignment)
X/Y Chart (X Axis Scale)

Y
Y/t Chart      Module
Y/t Chart    Display Window

Y/t Chart (Colors and Lines)
Y/t Chart (Continue)
Y/t Chart (Copy to Clipboard)
Y/t Chart (Display Y Unit)
Y/t Chart (Font Style)
Y/t Chart (Freeze)
Y/t Chart (Function Bar)
Y/t Chart (Grid)
Y/t Chart (Measuring Cursor)
Y/t Chart (One Chart/Multiple Charts)
Y/t Chart (Print)
Y/t Chart (Scale Assignment)
Y/t Chart (Time Scale)
Y/t Chart (Waterfall Display)
Y/t Chart (Zoom/Unzoom)

Z
Zoom/Unzoom (Display Window)

Main Menu Options
Help Index
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To obtain information on a Help topic quickly, click the Search button at the top of the Help window or 
press the S key on your keyboard.
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Action

Analog Input

Analog Meter



Analog Output

Arithmetic

Average

B

Bar Graph

Black Box

Block Average

C

Chart Recorder

Correlation

Counter

Counter Input

Cut Block

D

Data Archiving

Data Window



DDE Input

DDE Output

Differentiation / Integration

Digital Input

Digital Meter

Digital Output

E

Export/Import Black Box

F

FFT

Filter

G

Generator

H

Histogram

I

IEEE488 Interface

L



Latch

List Display

Logical Operations

M

Message

Multiplexer/Demultiplexer

P

PID Control

Polar / Cartesian 

Position in the Signal

Pre / Post Trigger

R

Read Data

Regression 

Relay

RS232 Interface



S

Scaling

Separate

Setpoint

Signal Adaptation

Slider

Start / Stop Trigger 

Statistical Values

Status Lamp

Stop

Switch

T

Time Base

Time Delay

Time Slice

Timer



Trigonometry

W

Write Data

X

X/Y Chart

Y

Y/t Chart
Module Installation, Configuration and Manipulation
Module Selection Menu
Help Index



New in DASYLab Version 2
Below, you will find an overview of the most important additions and changes of the current DASYLab 
version. Please select the Back button of the help symbol bar or press the Z key to return to this 
overview.

Arithmetic Module additional function type
Copyright Information at program start
Country Settings formatting of the text output
DDE expanded options, client/server capability
Default Directories define file locations for default settings by file type
Disk Streaming optimized data storage procedure
Display Modules expanded design options, increased capabilities
Display Window Arrangement store and select window arrangements
Event Driven Actions Action module for event driven triggering
Filter now also filter of odd order
Function Bar Info Quick Info assistance
Generator expanded with frequency and amplitude modulation
IEEE488 Interface three types are supported
Module Bar procedures for loading a worksheet
Module Groups some modules assigned to other module groups
Module Name numbered through by default
Module Option   Copy Inputs ...  simplifies worksheet creation
New Modules
Output Settings expanded options, new arrangement
Read/Write Data expanded options, new file formats
Separate Module expanded setup capabilities
Slider increased capabilities
Special   Module Group  groups Black Box and other new modules
Switches can be operated now as momentary switches

Arithmetic Module
The Arithmetic module has been expanded by a fourth function     type:   Operations with two or more 
operands. In this mode, incoming signals of all channels are combined in one arithmetic operation, a 
statistic operation, or a logic operation, with a single module output. 

Copyright Information
At every program start a Copyright Information box is displayed. You can disable this display.

Country Settings
For text output, DASYLab uses the format     definitions   of the Windows control panel.

DDE
The Start/Stop via DDE menu item of the Experiment menu has been discarded. DDE operations are 
possible at any time.

Default Directories
Using the Default     Directory   menu item (in the Options menu) you can set and modify the preset 



locations of drives and directories which DASYLab uses by default for opening or saving files. 
Different directories can be specified for various file types.

Disk Streaming
This function, which is part of the Experiment Setup, enables fast saving of measurement values of all 
channels in a compressed data format. It can also be read in by DASYLab without any problems.
Disk     Streaming   reduces the amount of required mass storage space, speeds up the saving process 
and therefore allows the storage of measurement data gathered at a high acquisition rate.

Display Modules: Enhanced Options
· Now the Analog     Meter   and the Digital     Meter   can process up to 16 data     channels.  
· These two modules, as well as the Bar Graph module, feature a variety of new setting possibilities 

regarding value ranges, colored indications of limit overflows/underflows and the change of the 
values (increase or decrease compared to previous values).

· Colors and fonts can be specified individually.
· The new Copy     Inputs     to     Outputs   function is particularly useful.
· The Status     Display   module also offers this option.
· Now you can store the arrangement of the Display     Windows   and recall the information when required.

Display Window Arrangement
You can store arrangements of the display windows (their size and position on the screen) and 
recall the stored information if desired.

      Save     Window     Arrangement  
Select     Window     Arrangement  

      Delete current     Window     Arrangement  

Event Driven Actions
The concept of event     driven     actions   expands the automation capabilities. If (settable) conditions apply,
one action module can trigger various actions at the receiver module.

Function Bar Info
If the mouse pointer points onto a button in the function bar, a Quick Info window will be displayed 
showing the name of the function. (Quick Info is available in all the windows with a function bar, such 
as the display     windows   of the Y/t     Chart   and the List module.)

Generator Module
A signal generated by the Generator module can be controlled in its frequency and/or amplitude by 
another data channel. During measurement, the frequency and amplitude of the generator signal can 
be changed using a slider, for example.

IEEE488 Interface
In addition to the INES interface DASYLab now supports also the interface cards of the companies 
IOtech and National     Instruments.   You can select the drivers of the cards installed in your system 
during installation of DASYLab.

Module Bar
Using the Load     module     bar     with     worksheet   option (in the Options menu) you can decide whether, 
when opening a new worksheet, the current module     bar   should remain active or should be replaced by
the one stored with the worksheet.

Module Group Assignment



The following modules have been assigned to different module groups from previous DASYLab 
versions:
Icon Module new module group previous module group

              Relay  

Trigger Functions Control

              Polar/Cartesian  

Signal     Analysis  Mathematics

              Logical Operations  

Mathematics Control

              Export/Import  

Special Black Box

              New     Black     Box  

Special Black Box

              Signal     Adaptation  

Special Signal     Analysis  

Module Name
When you create a new module DASYLab suggests a default Module     Name.   Beside the functional 
description the name contains a sequential number of the module type (e.g. Generator02 for the third 
Generator module). This default can be changed at will.

Module Option Copy Inputs to Outputs
The modules of the Display module group as well as the Save     Data   and the DDE     output   modules 
feature the new option Copy     Inputs     to     Outputs.   For the module in the worksheet, this option creates an
output for each activated input. The data is passed unchanged. The worksheet layout remains clearly 
readable since the creation of data channel branching is no longer required.

New Modules
Icon Module Module group

              Position in the Signal  

Statistics

              Latch Function  

Control

              Multiplexer/Demultiplexer  

Data Reduction

              Data Archiving  

Files

              Cut Block  

Data Reduction



              Action  

Special

              Message  

Special

              Time     Base  

Special

Output Setup
The output parameters can be determined using the dialog box of the Experiment     Setup   item (instead 
of the previously separate menu item) of the Experiment menu. The number of setting possibilities has 
been expanded and includes several scan modes (the Acquisition Mode of previous versions), global 
settings for analog and digital output, selection of the time base for all data generating modules etc.
The Disk     Streaming   option is new.

Read/Write Data
The Write     Data   module now also supports the Remus and DADiSP formats.
The Read     Data   module can also read in files stored in the ASCII and IEEE     32     Bit   format.

Separate Module
Using the Separate module a certain number of data values or blocks can be suppressed for one time 
at the start of the measurement.

Slider Module
The Slider module generates up to 16 signals. The setup and operating capabilities have been 
expanded.

Module Group Special
In this new group replacing the previous Black Box module group, you find the new Action, Message 
and Time     Base   modules. It also contains the Black     Box   modules (Empty Black Box, Export/Import) and 
the Signal     Adaptation   module.

Switch Module
The Switch module can now also be used as a One Shot switch.

Help Index



Main Menu Options
Choose any of the main menu options on which you want help:

File
Edit
Modules
Experiment
View
Options
Help

Help Index



Help Menu Commands
Here, the commands of the Help menu can be selected.

Index
This option activates the Help system and shows the index of topics on which help can be obtained
on screen. Then you can select all the Help functions available, except those referring to data 
acquisition hardware.

Hardware
If you have installed a data acquisition board in your system, choose this menu function to obtain 
specific help about the installed board. The information is specific to the board type you selected 
when you installed the DASYLab software.

Glossary
This function provides a list of terms for which the definition can be displayed.

Using Help
This option provides help for how to use the online help system.

System Information
Information on your hardware, operating system, Windows version, system resources etc. is 
presented on screen.

About DASYLab
Information on the current DASYLab version is presented on screen.

Main Menu Options
Help Index



How to use the DASYLab Help System
How to Scroll this Help Window
· Use the scroll bars at the sides of this Help window,
· or press the , ¯, PgUp and PgDn keys on your keyboard.

How to Start Help
· To activate the online Help system, click Help from the Main Menu and choose the Help     Index   or one 

of the other options available there.
· You can usually obtain information on the function you are currently using by pressing the F1 function 

key or by clicking the Help button included in many dialog boxes. Then, either specific information on 
the current function, command or dialog box, or the Help Index will be displayed.
> You can obtain further information on how to use the Windows Help system itself by pressing the 

F1 function key while using a Help window or by choosing Using Help from the Help menu.

How to use the Help Index
The Help Index displays the index of topics on which help can be obtained on screen. There you can 
select all the Help functions available, except those referring to data acquisition hardware.
· Click on the underlined topic on which you want help,
· or press the TAB key on your keyboard until the topic on which you want help is selected; then press 

the ENTER key.
· You can return to the Help Index page any time by clicking the Contents button at the top of each Help 

window or by pressing the C key on your keyboard.

How to Find Help on a Topic
Use the Search function or the Alphabetical Indexes to obtain help on a specific topic quickly.
· How to use the Search function:

· Click on the Search button at the top of the Help window,
· or press the S key on your keyboard.

The Alphabetical Indexes contain all the topics on which online help is available. Scroll through the lists; 
then choose the topic on which you want to obtain information.
· How to Scroll the Help Window:

· Use the scroll bars at the sides of the Help window,
· or press the , ¯, PgUp and PgDn keys on your keyboard.

· How to Choose a Help Topic:
· Click on the topic on which you want to obtain information,
· or select a topic by repeatedly pressing the TAB key until the topic is highlighted, then press 

ENTER.
How to Return to Previous Help Topics
After reading the information on a topic, you can return to the help pages previously displayed
· by (repeatedly) clicking the Back button at the top of the Help window,
· or by (repeatedly) pressing the B key on your keyboard.

How to Close the Help Window
· Double-click the Control-menu box in the upper left corner of the Help window,
· or press ALT+F4,
· or choose Exit from the File menu of the Help window (ALT, F, X).

Help Index



The Elements of the DASYLab Screen
The following elements of the DASYLab screen are often referred to in the online Help. Please click the 
underlined topics to obtain further information.

Title Bar
The Title Bar is the upper border of the DASYLab window and shows the name of the application 
(DASYLab) and the file name of the current worksheet. If the current worksheet has not yet been 
saved, "(Untitled)" appears as a placeholder.

Menu Bar
Below the title bar, the Menu Bar lists the Main     Menu     Options.   Each menu contains a list of 
commands or actions. You can open each of these lists by clicking the Main Menu Option on the Menu
Bar with the left mouse button, or by pressing the ALT key and then typing the letter that is underlined 
in the Main Menu Option.
You can then choose an option from that list by clicking it or by typing the letter that is underlined in the
menu item (without pressing the ALT key again!). The display field in the left half of the Status Bar will
often contain information describing the selected menu item.

Function Bar
Below the menu bar, the Function     Bar   contains icons which provide easy access to menu functions 
often used during experiments. Just click the icon representing that function. The online help text for 
each menu command refers to their corresponding icons on the function bar.
When the mouse pointer is pointing at a Function Bar icon, a tag with the name of that function will 
appear. (You will find QuickInfo in all of the module windows which provide a Function Bar.)
Click here for a list of the icons currently integrated and the menu commands they represent.

Module Bar
The Module     Bar,   at the left of the DASYLab window, displays a selection of frequently required 
modules in icon form. Use the left mouse button to click on the icon which symbolizes the module you 
want to add to your worksheet. The name of the module the mouse pointer is pointing at is displayed 
in a small window above the module icons. Select the Modules menu to choose from the complete list 
of all the modules available.
The Module Bar can be configured freely.

Work Area
The work area is where you create the virtual DASYLab experiment setup (the worksheet). The size of 
the worksheet segment which is actually displayed in that workspace on your screen varies depending
on your display adapter. In any case, the area available for a worksheet is much larger than can be 
displayed on screen at a time. You can use the scroll bars to pan horizontally and vertically around in 
the worksheet.
You can install modules in the work area either by choosing them from the Modules menu or by 
clicking the corresponding icons on the Module     Bar.   Then these modules must be connected by 
data     channels.   You can also drag any module symbol to any location in the worksheet by placing the 
mouse pointer on it and then pressing and holding down the left mouse button while moving the 
mouse. If you touch the window border while doing this, the work area display will automatically follow 
your movements across the worksheet until you release the mouse button, thus placing the module 
symbol to its new position.

Status Bar
The Status Bar at the bottom of the DASYLab window provides useful information:
· On the left of the display you will find an explanation of the menu function you have selected on the

menu bar.
· The control bar on the right displays the progress of operations, e.g. of the Autorouter function 

arranging data channels, or, during experiments, the driver buffer status. This control bar indicates 
the progress of the filling of the driver buffer. If the bar turns red, this indicates that the acquisition 



rate is too fast to be kept continuously. Left to the driver buffer indicator there is a small indicator for
lost samples. Many drivers acquire data under interrupt control. Some boards allow to check 
whether all interrupts have been processed by the program. A yellow flashing light indicates that 
some interrupts have been missed. For more detailed information see the hardware halp for our 
boards.    

· The current time is displayed on the far right.
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Creating Data Channels or Branches
... the quick way:

To connect a module, simply drag it against the other module to which it is to be connected until their 
output (O) and input symbols (I) touch. When you release the mouse button, DASYLab will 
automatically connect the two modules and auto-route the wires.
This prodecure even works when both modules are configured differently, i.e. when different channel 
numbers have been selected, and when some of their inputs/outputs are already connected to other 
(i.e., third) modules.
Thus you might, for example, activate four output channels of a Generator module, then connect two 
of them to Display modules and the remaining two to modules from the Signal Analysis group.

... with the Autorouter option on:
· Click the left mouse button once at the point where you wish the data channel to begin - the output 

symbol (O) of a module or - for a branch - any position on the data channel. The mouse pointer then 
changes into a plug symbol.

· Then place the tip of that plug symbol on the input symbol (I) of another module. (Note that the input 
of the second module must be free.) While you do this, a thin black line is being drawn from the 
starting point of the connection.

· Click the left mouse button again, on the input symbol at the end of the connection, to establish the 
connection.

· To cancel the process, click the left mouse button once anywhere outside the input symbol.

... with the Autorouter option off:
· Click the left mouse button once at the point where you wish the data channel to begin - the output 

symbol (O) of a module or - for a branch - any position on any data channel. The mouse pointer then 
changes into a branch symbol.

· Draw the new data channel by moving the mouse. While creating each segment, you can only 
lengthen or shorten each one either vertically or horizontally. (You need not move the mouse 
pointer exactly along the future track of the channel but you may move it sideways, too.)

· Click the left mouse button again you freeze the length of the data channel segment you have just 
created and switch over to the other axis (horizontal or vertical) for the next segment.

· When the data channel hits a module, you must guide it around it.
· When the tip of the new data channel is level with the input symbol of the module where you want it to 

terminate, just click that input symbol to complete the data channel connection.
· To undo the last segment, click the right mouse button once.
· To cancel the process, double-click the left mouse button anywhere.

To create a branch:
· If the output of a module is to provide data for more than one input and/or module, simply create a 

branch. Click the left mouse button once anywhere on the data channel where you want the 
additional channel to branch off. Create the additional connection to the other module input as 
described above.

Related topics:
Deleting data channels
Rearranging data channels
Autorouter



Rearranging Data Channels or Branches
To rearrange a data channel ...
· ... you must first delete the data channel (click the channel twice with the right mouse button) and 

then create it again on a different track.
Note that the deletion of a data channel segment may affect further segments and/or branches, which 
would then be deleted as well.

Related topics:
Creating data channels
Deleting data channels

To rearrange a junction point on a data channel ...
· Click the left mouse button once at the junction point which you want to move. The mouse pointer 

then changes into a branch symbol.
· Drag the small box which now represents the junction point to its new position on the data channel.
· Confirm the new position by clicking the left mouse button again. All the data channels concerned will

be rearranged automatically.
· Note that you can only drag the junction point either vertically or horizontally along a data channel. 

If you want to move it around a corner you must first position it right at that corner and then move it on 
in the other direction in a second step.

Autorouter



Deleting Data Channels or Segments
· The quick way: two separate clicks (not a double-click!) with the right mouse button on the data 

channel to be deleted:
· At the first click, the section which is to be deleted will change its color.
· At the second click it will be deleted.
· To cancel the process, click anywhere else on the screen but not on the same section for the 

second time. The data channel will then resume its previous color.
· or:

· Double-click the right mouse button on the end of the connection (i.e. the input symbol of the 
second module).

· Confirm the deletion in the dialog box which appears automatically, or choose Cancel.
· If you accidentally double-click the beginning of the connection (i.e. the output symbol of the 

first module), you will be asked to confirm the deletion of that module (instead of the data channel).
Click the Cancel button in the dialog box.

· To delete all the input and/or output channels of a module:
· Double-click the right mouse button on the module symbol. In the dialog box, click the desired 

option, or choose Cancel.
· Please note that any confirmed deletion will always be executed in compliance with the other 

elements of the worksheet. This means that if, for example, you delete a channel section which divides
up into branches in its further course, all those further branches will be deleted, too.

Related topics:
Creating data channels
Rearranging data channels
Autorouter



How to Start/Stop an Experiment
These Help pages contain
· some basic information on the options provided by DASYLab to control an experiment or data 

acquisition process;
· then, an overview of the manual control options;
· at last, a survey of the wide range of possibilities for how to control an experiment automatically.
Please click the underlined terms for further information on them.

With DASYLab, you can control your data acquisition procedures in various ways.
· Besides starting and completely stopping an experiment you can also interrupt it temporarily and 

later resume it at the same point.
· As soon as you pause an experiment, the acquisition of new data is stopped (for example, by 

Generator, A/D or Digital Input, PID or Manual Control modules). The data which have been acquired 
up to that moment will, however, be retained and processed completely.

· The acquisition of new data is resumed when the interrupted experiment is continued.
· There are four different methods of controlling an experiment. You can choose any of the first three 

methods according to your individual preferences:
· Choose the commands from the Experiment menu using your mouse or your keyboard: click the 

menu item, or press the ALT, X keys, then type the letter that is underlined in the item name.
· Click the icons on the function bar. All these icons symbolize menu commands, and clicking one 

of them has the same effect as choosing the corresponding menu command.
· Use keyboard shortcuts. If available, these shortcut-key combinations are listed to the right of the 

menu item. Instead of opening the menu and choosing that command, you simply press the key 
combination.

· You can also configure the experiment setup (the worksheet) and/or your computer so that the 
experiment will be started and stopped automatically.

The following table sums up the correspondences between the three manual control methods:

function
Experiment

menu command icon shortcut

start Start F5

stop Stop CTRL+F5

pause Pause CTRL+F6

resume Pause CTRL+F6

· Please click the underlined term to obtain a survey of the options provided by DASYLab to control an 
experiment or data acquisition process automatically.

Help Index
Main Menu Options



Function Bar Configuration
The following table lists all the icons provided on the function     bar   and the menu commands they 
represent. Click the menu command for further information.
Icon Command Menu Function

Start Experimentstart experiment

Ö    Pause Experimentpause experiment

        Pause Experiment resume experiment

Stop Experimentstop experiment

Experiment Setup Experimentset general experiment parameters (dialog box)

Hardware Setup Experimentset hardware-specific parameters (dialog box)

New File clear work area to create a new worksheet

Open... File open worksheet file

Save File save worksheet to file

File Info... File open File Info dialog box

Worksheet to Clipboard Edit copy worksheet to Windows clipboard

Hide View display control panel only, hide worksheet

Hide Display Windows View minimize all the display windows (reduce to icons)

Show Display Windows View activate all the display windows

To Preceding
Black     Box     Level  

Edit leave the current Black Box, return to preceding 
worksheet level (or to the Main Chart)

(To enter a Black Box, double-click the module on the 
worksheet.)

(list) Select Window
Arrangement

View re-arrange display windows in one of the ways you
have saved before

Save Window
Arrangement

View save current sizes and positions of all the display
windows



Delete current Window
Arrangement

View delete current arrangement from list
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Creating your First Worksheet
By following this tutorial, you will create a simple worksheet and find out about the basic elements and 
functions of DASYLab.
If you prefer to follow these instructions in written form, please refer to chapter 2 of your DASYLab 
Owner's Manual
To follow the steps described in these instructions on screen, we recommend clicking the question mark 
on the menu bar of this Help window to choose Always on Top. The instructions in the Help window will 
then remain visible on the screen while you perform the steps in the DASYLab window. Do not forget, 
however, that you must make the DASYLab window or the Help window active (by clicking anywhere in 
them) before you can perform any activity in them.
To avoid too many elements of the DASYLab window being hidden by the Help window, please maximize
the DASYLab window, resize the Help window to about a quarter of the screen size, and drag it to the 
lower right corner of the screen.

> To scroll through these instructions, use the scroll bars at the sides of the Help window, or press the , 
¯, PgUp and PgDn keys on your keyboard. (If you wish to use your keyboard, do not forget to select 
the Help window first.)

> Click on a term with a dotted underline to obtain further information on that term. To remove the 
information box and return to the tutorial, click anywhere, or press any button on your keyboard.

> Click on an underlined term to obtain further information on that item (usually a menu command). To 
return to the tutorial, click the Back button at the top of the Help window, or press the B key on your 
keyboard.

1. On the left-hand side of the DASYLab screen you can see the Module     Bar.   It displays a selection of 
icons which represent modules frequently used in worksheets.

Place the mouse pointer on the module bar icon 
shown here. It represents a Generator module.
Click this icon with the left mouse button.

(The name of the module the mouse pointer is pointing at is displayed in a small window above the 
module icons.)

2. In the same way, choose the Y/t Chart module by 
clicking its icon on the module bar with the left 
mouse button.

You have now integrated these two modules into your worksheet; their symbols appear on the 
worksheet.
The modules can be installed either by clicking the corresponding icons on the module bar, or by 
choosing them from the Modules menu. While the module bar can only offer a limited selection of 
icons, the Module menu provides the complete list of available modules.
When you install a module from the Display group (for example, a Y/t Chart module), an additional 
icon may appear at the bottom of the screen (see below, step 5).

3. The modules on the worksheet must now be connected by data     channels   so that data can be 
transferred between them.
To connect them most conveniently, move the mouse pointer to the Y/t Chart module symbol, press 
the left mouse button, and drag the module symbol against the Generator module symbol (mouse 
button still pressed down) until their output (O) and input symbols (I) touch. When you release the 
mouse button, DASYLab will automatically connect the two modules and auto-route the wires.
(Of course, you can also connect two modules without moving the module symbols - you'll do that in 
a few minutes.)
The data channel is completed now, the output of the first module is connected to the input of the 
second. The experiment can begin!

4. At the top of the DASYLab screen, below the main menu bar, you can see the function     bar.   It contains



icons which provide fast access to several functions which you will frequently use in your 
experiments. (When the mouse pointer is pointing at a Function Bar icon, a QuickInfo tag with the 
name of that function will appear.) Just click the icon representing that function.

With the left mouse button, click this icon on the 
function bar - the first one on the left.

This will start the experiment, and soon the Generator module will generate a signal. (Pressing F5 
has the same effect.)

5. The signals and results of measuring processes can be displayed graphically by means of the 
modules from the Display group. They consist of two elements each: the worksheet symbol, which 
is integrated into the worksheet and connected to the other modules by data channels, and the actual
Display     Window,   which appears minimized as an icon at the bottom of the computer screen, and 
which you must separately restore (or "open") whenever you wish to make use of that function 
during an experiment.
Open the Y/t Chart Display Window using the left mouse button:

· either by clicking this function bar icon (it 
represents the Show Display Windows command 
from the View menu),

· or by double-clicking the display window icon at 
the bottom of the desktop.

The Y/t Chart Display Window appears, and you can now observe the signal generated by the 
Generator module as it is shown on that display.
Before you perform the next steps, please drag the Y/t Chart Display Window to a position above this 
Help window, so that it does not hide any elements of your worksheet. It may be necessary to adjust 
its height first. (You can drag a window by clicking its title bar with the left mouse button and moving 
it to its new location with the mouse button pressed down.)

6. By alternately clicking these two function bar icons
with the left mouse button you pause the

running experiment and resume it at the same stage at which you interrupted it. (Pressing CTRL+F6 
on your keyboard has the same effects.)

7. If you click the right mouse button on the Y/t Chart Display Window screen, the Color dialog box 
appears. Select a new color for the display background by clicking any of the colors on the palette; 
then click OK.

8. Now stop the experiment. You can either click this icon 
on the function bar or press CTRL+F5 on your 
keyboard.

9. Perhaps you cannot see the Y/t Chart module symbol (on the worksheet) any more because it is 
hidden behind the display window. In that case, drag that window aside a little (see step 5), or 
reduce it to an icon by clicking the Minimize button (the down arrow in the upper right-hand corner of 
the display window).

10. Using the right mouse button, double-click on the Y/t Chart module symbol (on the worksheet). In 
the dialog box which opens then, select Delete Module and press OK: The Y/t Chart module will be 
deleted from your worksheet.

11. Now add the Bar Graph module to your worksheet 
by clicking its icon on the module bar with the left 
mouse button. The module symbol appears on the 

worksheet, and the icon representing the corresponding display window appears on the lower edge
of the desktop.

12. Connect the input of the Bar Graph module symbol with the output of the Generator module symbol 
as described above (see step 3).



Open the Bar Graph Display Window either by clicking 
this function bar icon or by double-clicking the display
window icon at the bottom of the desktop.
Start the experiment again now, and observe the 
Generator signal as it is displayed in the Bar Graph 
Display Window.

13. Stop the experiment then, and

click the module bar icon representing the Digital 
Meter module. The module symbol appears on the 
worksheet next to the Bar Graph module symbol,

and the corresponding display window icon appears at the bottom of the desktop.
14. Move the Digital Meter module symbol about on the worksheet by clicking it with the left mouse 

button and dragging it, with the mouse button pressed down, to various locations, for example below 
the Bar Graph module symbol. DASYLab will automatically arrange the blocks evenly according to 
the grid settings defined in the Window     Setup   dialog box from the Options menu.

15. The quickest way to connect the Digital Meter module to the Generator module is to "tap" the already 
existing data channel between the Generator module and the Bar Graph module. To create that 
branch, move the mouse pointer and click anywhere on the data channel between these two module 
symbols with the left mouse button. The mouse pointer now changes shape to a hand holding a plug.
Place the tip of the plug precisely onto the input symbol (I) of the Digital Meter module symbol, and 
click the left mouse button again. This establishes the connection, and DASYLab's integrated 
Autorouter function automatically finds the correct path for the new data channel segment.
You can now start, pause, and resume the experiment, open the Digital Meter Display Window by 
double-clicking its icon at the bottom of the screen, and you can change the color of that display as 
described above (see step 7).

16. The default wave form generated by channel 0 of the Generator module is a square wave signal. 
Double-click on the Generator module symbol with the left mouse button now. A dialog box 
appears, allowing you to define the signal to be generated. Chapter 5 of your DASYLab Owner's 
Manual will provide you with further information on these parameters.
For a start, try clicking on the Sine button in the Wave Form box, then choose the OK button. The 
Display modules will show the new signal type you have selected.

17. The Y/t Chart module would come in handy now. It gives a much better visualization of a sine wave 
than the digital meter. Unfortunately, we deleted it from the worksheet! To re-install it, just click the 
module bar icon again (see step 2). Does DASYLab refuse to react to your mouse clicks? Well, 
maybe your experiment is still running. You must always stop an experiment before making any 
changes in the experiment setup, such as adding modules or changing sample rates.
Create another data channel branch (see step 15) to connect the Y/t Chart module symbol,

then start the experiment again.

18. You should save your first worksheet now, so that you can use it to try out some more of DASYLab's 
options later on.

First, stop the current experiment,

then click this function bar icon with the left mouse 
button. It represents the Save command from the File 
menu.

A dialog box appears. In it, the File Name box displays a list of demo worksheet files that were 



copied to the DASYLab directory during the setup procedure. These ready-to-run worksheets may 
give you an idea of the wide range of measuring and data acquisition tasks that can be solved by 
DASYLab. You can open, run, modify and re-run them all later. Their File     Info   box contains a 
description.
Now type a file name of your choice (using no more than eight characters) in the File Name box 
above the mentioned list box; for example, type TUTOR1. Choose the OK button, and your first 
worksheet will be saved as TUTOR1.DSB in the DASYLab default directory. (DASYLab automatically 
adds its standard extension *.DSB.) The DASYLab window title bar now shows the new file name.

19. If you want to open this (or any other) worksheet file 
later, click this icon on the function bar with the left 

mouse button. This icon is a shortcut to the Open command from the File menu.
Congratulations! You have successfully finished the DASYLab Basics lesson and are now ready to 
begin working with DASYLab!
The next time you have a question or need help, you can
· repeat this tutorial;
· read these instructions, or part of them, in chapter 2 of the Owner's Manual;
· find the answers in other relevant chapters of the DASYLab documentation;
· use online Help. You will usually obtain online help by pressing the F1 function key whenever you 

need help; or use the Search function in the Help window.
20. Unless you prefer to keep on experimenting with DASYLab right away, exit the program now by 

double-clicking the Control-menu box in the upper-left corner of the DASYLab window, or by 
pressing ALT+F4 on your keyboard.
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Customizing the DASYLab Screen
While you are working on your DASYLab worksheet, it is displayed in its normal size on the screen. The
modules with their input and output symbols, the instruments and the data     channels   are easy to 
distinguish and can be arranged easily.
There is much more space at your disposal than is displayed on the screen:
· You can drag any module to any position on the entire worksheet. Click it once with the left mouse 

button, then move it with the mouse button pressed down. If you touch the window frame, the window 
will automatically move on across the worksheet in that direction.

· You can move the window all over the actual worksheet by using the scroll bars.

How to display more of your worksheet:
> Remove the function bar and/or the module bar from the DASYLab window. Choose these options 

from the View menu, or press ALT, V, F or ALT, V, M.
> To view the complete worksheet in a separate window, choose the Overview option from the View 

menu, or click the corresponding icon in the function bar. However, you cannot edit or change it 
there. The scale of the additional display is automatically adapted to the size of the worksheet to be 
presented.

> Enlarge the window to its maximum size:
Click the Maximize button in the upper right-hand corner of the DASYLab window, or choose Maximize 
from the Windows Control menu. The worksheet will be displayed so that it covers the full computer 
screen. Other Windows applications like the Program Manager will then run in the background.
After you enlarge the window, the Maximize button is replaced by the Restore button (which contains 
both an up arrow and a down arrow). Clicking the Restore button returns the window to its previous 
size.

How to change the appearance of the worksheet:
> To change the appearance of the DASYLab worksheet (grid, type of grid, spacing), choose the 

Window     Setup   option from the Options menu.
> To change the colors of the DASYLab worksheet, choose the Colors option from the Options menu.
> To change the colors of the DASYLab window frame, menu bar etc., choose the Color option from the 

Windows Control Panel.

How to reduce the screen to the elements most essential for an experiment:
> Choose the Hide function from the View menu, or click the corresponding icon on the function bar, to 

reduce the DASYLab window containing the worksheet to its minimum size (but not to an icon!).
In its place, a minimized control window appears which contains only the status bar (displaying the 
current time and the buffer status) and the control icons from the function bar, which allow you to start, 
stop, pause and continue the experiment.
In addition to the control window, only those display windows (analog/digital meters, Y/t Charts etc.) 
are displayed on screen which have been activated.
This option allows you to concentrate on those elements which are essential for the control and 
evaluation of the actual experiment.

> You can restore the previous window size by clicking the Restore Size arrow in the upper right-hand 
corner of the control panel.

> Please note that the effect of clicking this arrow may differ from the effect in many other Windows 
applications: The control window is not necessarily enlarged to full screen size, but only to the size the 
worksheet window was when the Hide function was chosen.

Help Index
Customizing the Display Windows
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Main Menu Options





Customizing the Display Windows
General Remarks

When installed into a worksheet, the modules from the Display group - unlike all other modules - 
consist of two elements each:

· the worksheet symbol, which is integrated into the worksheet and connected to the other modules by
data     channels,  

· and the actual display window, which appears minimized as an icon at the bottom of the screen first, 
and which you must restore (or "open") whenever you wish to make use of that function during an 
experiment.

Opening the Display Windows
· You can open each of the display windows contained in your worksheet individually by double-

clicking its icon at the bottom of the computer screen.
· You can open all the display windows contained in your worksheet simultaneously by choosing 

Show Display Windows from the View menu, or by clicking the corresponding function     bar   icon.

Minimizing the Display Windows
· You can minimize each of the display windows individually by clicking its Minimize button (in the 

upper right-hand corner of the display window).
· You can minimize all the display windows contained in your worksheet simultaneously by choosing 

Hide Display Windows from the View menu, or by clicking the corresponding function bar icon.

Hide     Display     Windows  

Arrangement of the Display Windows
While observing an experiment, with data being displayed on several instruments, you may find it 
useful to save certain arrangements of these display windows (i.e. their sizes and positions on the 
screen). You can then easily restore any of these arrangements when it seems most suitable, and you 
can even switch between various window setups to compare different display modes.
For these purposes, DASYLab provides the following menu commands and function bar icons:

      Save Window Arrangement  
Select Window Arrangement

      Delete current Window Arrangement  
Help Index



DASYLab by Keyboard
Although most Windows applications are designed with mouse operation in mind, using the keyboard 
may be more convenient under certain circumstances. Several operations in DASYLab can be carried 
out both ways, so that users can decide for themselves which way to choose. The following lines contain
a survey of possible keyboard operations in DASYLab.
· As usual, menu commands can of course be chosen by pressing ALT (to move to the menu bar), 

then typing the underlined letter in the menu name (to open the menu), and then typing the underlined 
letter in the menu command.

· For some menu commands which you will frequently use, keyboard shortcuts are provided. Instead 
of opening the menu and choosing the command, simply press the key combination. These keys are 
listed to the right of the corresponding menu item. The online help pages will refer to them as well.
For a list of these commands and their shortcut-key combinations, please press the TAB or the 
SHIFT+TAB keys now to highlight the underlined topics, and press the ENTER key to display a list.
Experiment menu commands:

How to Start/Stop an Experiment

View menu commands:

      Save Window Arrangement  
Select Window Arrangement

      Delete current Window Arrangement  
· Module Manipulation by Keyboard

The modules on the worksheet can be manipulated in various ways. The module     symbols   on the 
worksheet can be dragged about, connected by data     channels,   configured, or deleted. The last two of 
these manipulations can also be performed by means of the keyboard.
Before you can manipulate a module, you must select it.
Only one module on the worksheet is selected at a time and can be manipulated as described. It can 
be identified among the module symbols on the worksheet by the inverse coloring of its title bar, on 
which the module     name   is displayed.
· To select a module, either click it once with the left mouse button, or press the TAB key on your 

keyboard until that module is selected.
· When you press the ALT+ENTER keys, the module configuration dialog box appears.

Press the TAB or the SHIFT+TAB keys to move from one field or button to another; select items by 
pressing the arrow keys, the SPACE and the ENTER key.
(Note: Channel     Selection   is only possible by mouse operation.)

· To copy settings entered for the selected channel to the other activated channels, use the 
F7/F8     Function     Keys.   This procedure can only be performed by means of keyboard operation.

· To delete the selected module from the worksheet, or to delete all the input and/or output 
channels of that module, press the DEL key. In the dialog box appearing then, select the desired 
option, or choose Cancel, and press ENTER.
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File Menu Commands
The commands of the File menu enable you to save, open, and print worksheets, to manage your 
worksheet files, and to exit the program.

Some of these functions can also be chosen by clicking the corresponding icons in the function bar.

New

Open...

Save

Save As...

File Info...

Print...

Printer Setup...

Page Format...

Exit
Main Menu Options



New

File menu command: New

Choose this command to create a new worksheet. The DASYLab work area will be cleared completely.

If there is already a worksheet on the screen which you have changed since you last saved it, you will 
be asked to
· save that worksheet before beginning work on the new one,
· or to reject those changes,
· or to recall the New command.

After creating the new worksheet you can save it to a file by selecting the Save or the Save     As...   
commands from the File menu.
Click on the Save icon in the function bar to save the current file.

> To open a worksheet that has been previously saved to a file, select the Open... command from the 
File menu, or click the Open icon in the function bar.

File Menu Commands



Open...

File menu command: Open...

Choose the Open command, or click the function bar icon, to open a worksheet that has been previously
saved. The DASYLab work area will be cleared completely.

If there is already a worksheet on the screen which you have changed since you last saved it, you will 
be asked to
· save that worksheet before beginning work on the new one,
· or to reject those changes,
· or to recall the Open Worksheet command.

After choosing the Open command you can select the file on which you want to resume work from a list 
of files.

You can ...
· open one of the files from the list directly by double-clicking the file name),
· select a different directory by double-clicking the directory name,
· select a different file format for the file display, or
· select a different drive.
(To use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; 
select items from the lists by pressing , ¯, SPACE and the ENTER key.)

In the File Name box you can define the filter for the file list. The default setting for the filter (*.DSB) will 
create a list of DASYLab worksheet files, which usually have the extension *.DSB.
Type a different extension, or use wildcards (like *.*), to get lists of different groups of files. For example,
if you have saved DASYLab worksheets with extensions other than *.DSB (using the Save     As...   
command from the File menu).
However, DASYLab can only open files in its own DSB format, no matter what extension the files have.
Note: If password protection is active, you will first be asked to enter the password before the file is 

actually opened (unless you have already entered it before). Without the correct password, the 
file cannot be opened.

When you save a worksheet, the current module     bar   configuration is saved with it. This implies that 
when you open a worksheet file, its module bar configuration will replace the current one on your screen.
If you prefer to retain the current configuration, disable the Replace     Module     Bar   option (Options menu).

> You can specify a default directory for DASYLab worksheet files (Options menu command).
> To create a new worksheet, select the New command from the File menu, or click the New icon in the 

function bar.

File Menu Commands



Save...

File menu command: Save...

Choose the Save command, or click the function bar icon, to save a worksheet.
> Click here for a list of the settings     and     parameters   that will be saved together with the worksheet.

1. If you have created a new worksheet (command New from the File menu) without saving it to a file 
(untitled is displayed in the DASYLab window title bar), you can select the file name, the directory and 
the disk drive where the file is to be stored:
· Type the file name in the File Name box. (Note that the file name must be chosen in accordance 

with MS DOS conventions.)
· If you do not type an extension, DASYLab will automatically add the standard extension (*.DSB).

DASYLab always saves worksheet files in its own format, even if you select an extension other 
than *.DSB.

· You can ...
· select one of the file names in the list by double-clicking the file name. The file which was 

originally saved under that name will then be replaced with the new worksheet. A warning 
message will first appear, asking you to either confirm the procedure or to cancel it.

· select a different directory by double-clicking the directory name, or
· select a different drive for the new file.
· In the List Files of Type box you can select the type of files (defined by their extension) to be 

listed.
(To use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; 
select items from the lists by pressing , ¯, SPACE and the ENTER key.)

2. If you have previously saved the new worksheet to a file (using the Save     As...   or Save commands 
from the File menu), or if you have opened an existing file (command Open... from the File menu), its
name is displayed in the DASYLab window title bar.
Selecting the Save command, or click the function bar icon, to save the current worksheet. The existing
file will be replaced without further messages.

> You can specify a default directory for DASYLab worksheet files (Options menu command).
> To save the worksheet with a new file name, select the Save     As...   command from the File menu.
> If password protection is active (from the Options menu), the worksheet will be protected by a specified

password. If the password has not yet been defined , the user is prompted for its definition when the 
worksheet is saved.

File Menu Commands



Save As...
File menu command: Save As...

Choose the Save As command to save a worksheet with a new file name, in a different directory, or on a
different drive.

> Click here for a list of the settings     and     parameters   that will be saved together with the worksheet.

After you have chosen the Save As... command from the File menu you can select the file name, the 
directory and the disk drive where the file is to be stored.
· Type the file name in the File Name box. (Note that the file name must be chosen in accordance with 

MS DOS conventions.)
· If you do not type an extension, DASYLab will automatically add the standard extension (*.DSB). 

(DASYLab always saves worksheet files in its own format, even if you select an extension other than 
*.DSB.)

· You can ...
· select one of the file names in the list by double-clicking the file name. The file which was 

originally saved under that name will then be replaced with the new worksheet. A warning 
message will first appear, asking you to either confirm the procedure or to cancel it.

· select a different directory by double-clicking the directory name, or
· select a different drive for the new file.
· In the List Files of Type box you can select the type of files (defined by their extension) to be listed.
(To use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to another; 
select items from the lists by pressing , ¯, SPACE and the ENTER key.)

> You can specify a default directory for DASYLab worksheet files (Options menu command).
> To save the worksheet under its current file name, use the Save command from the File menu.

To quickly save the current file, click the Save icon on the function bar .
> If password protection is active (from the Options menu), the worksheet will be protected by a specified

password. If the password has not yet been defined, the user is prompted for its definition when the 
worksheet is saved.

File Menu Commands



Settings Saved in Worksheet Files
The following settings will be saved together with the worksheet when you choose the Save or the 
Save     As...   commands from the File menu:
· the current Module Bar configuration;
· all of the entries in the File Info... dialog box;
· all of the entries in the Page Format... dialog box;
· the settings concerning the Display Save Window Arrangement.

The following settings will not be saved together with the worksheet:
· the settings regarding the Start/Stop at Time functions;
· the settings regarding the Auto Start function;
· the View menu settings concerning the display of the Module Bar and the Function Bar and the 

Animation function;
· the Options menu settings (Window Setup, Colors, the Autorouter function).

File Menu Commands



File Info...

File menu command: File Info...

Choose the File Info command, or click the function bar icon, to display, enter, or modify information 
about the current worksheet .
· DASYLab provides the following information automatically. (These fields cannot be modified by the 

user.)
field information
Worksheet the file name of the current worksheet (extension *.DSB)
Created the date and time when the worksheet was created
Modified the date and time when the worksheet was last saved to file

· You can add the following information:
field information (and maximum number of characters)
Author, Company, your name, company, and department
Department (up to 50 characters each)
Title a descriptive title of the worksheet (80)
Worksheet Info Text additional informative text (4000)

To begin a new line in the Worksheet Info Text field, press CTRL+ENTER.
To move from one field to the other, use the mouse, or press the TAB or SHIFT+TAB keys.

· Click on the Clipboard button to copy all of the information displayed to the Windows Clipboard.

All the File Info entries are saved with the worksheet when you choose Save or Save     as...   from the File 
menu.

The Author, Company, and Department information will also be stored in the DASYLAB.INI file. When 
you create a new worksheet DASYLab will provide this information as the default.

When you print a worksheet or the display of a module from the Display module group, you can include 
the information about Author, Company, Department, Title, and the Worksheet file name. Choose Page 
Format from the File menu to select the information you wish to include.

File Menu Commands



Print...
File menu command: Print...

Choose the Print command, or click the icon in the function bar, to print a worksheet.
> Choose Page Format from the File menu to select additional information about the worksheet that can 

be included in the printing, and to specify the page layout and page frames.
> Choose Printer Setup from the File menu to select paper size and paper source, orientation, printer 

resolution, and other specific settings for your active printer model.
> To activate a different printer model connected to your system, or to install and configure a new printer,

choose the Printers option in the Windows Control Panel. Please refer to your Windows documentation
for further information.

File Menu Commands



Printer Setup...
File menu command: Printer Setup...

Choose the Printer Setup command to select paper size and paper source, orientation, printer resolution,
and other specific settings for your active printer model.

The options vary, depending on the printer you are using.
· Change the specifications as needed.
· To set options specific to your printer driver, choose the Options button, set the options as needed, 

and then choose the OK button.
· For information about the printer-driver options, choose the Help button or press F1 while using the 

dialog box.
· Choose the OK button.

> Choose Page Format from the File menu to select additional information about the worksheet that can 
be included in the printing, and to specify the page layout and page frames.

> To activate a different printer model connected to your system, or to install and configure a new printer,
choose the Printers option in the Windows Control Panel. Please refer to your Windows 
documentation for further information.

File Menu Commands



Page Format...
File menu command: Page Format...

Choose the Page Format command to format your printing from DASYLab.
The settings selected affect the following print commands:

what is to be printed? source module
Print command from

module menu ...

worksheet (work area) File (Main Menu Option)
Y/t chart Y/t Chart Display
X/Y chart X/Y Chart Display
diagram Chart Recorder Display

list of values List Display Edit
You can select additional information to include in the printout, and you can specify the page layout 
and page frames.
The upper part of this dialog box mirrors the basic layout of the printed page.
· Viewport

The actual information or display which is to be printed is indicated in the center of this area. 
Depending on the source module from which the printing will be activated, the worksheet, the graphic 
display, or the list of values will be positioned here.
The final size of this area on the printed page is defined by the paper size minus the paper frames 
selected minus the space required for the additional information selected.
The actual display will occupy the complete page if you select no additional information; the more 
information you select, the smaller the space remaining for the actual display.

· Additional Information
· In the text box and the check boxes above the Viewport area you can select the information which 

will be printed above the actual display at the top of the page.
· In the text box and the check boxes below the Viewport area you can select the information which 

will be printed below the actual display at the bottom of the page.
You can enter one text line of up to 80 characters in each of the two text boxes.
Select information already entered and saved elsewhere:
· The Experiment Title, Author, Company, and Department will be printed as entered in the 

corresponding text boxes of the File Info dialog box from the File menu. (In the printout, the 
information about Author, Company, and Department will be separated by commas.)

· The date and the time of the printing will be printed at the position indicated by the Date/Time 
check box.

· The Worksheet Name to be printed is the file name of the current worksheet.
· When you select Description, ...

· the worksheet file name will be printed again when you print the worksheet itself. The 
Worksheet Info Text from the File Info dialog box will not be included in the printout.

· When you wish to print a graphic display or a list of values, the module description printed will
be the Description text box of the source module's configuration dialog box. This dialog box 
appears when you double-click that module symbol on the worksheet.

· Page Frame
Set the margins for the printed page. These are the distances between the paper edge and the printed
area of the paper. The measurement system is always centimeters. The default settings are 2.54 cm 
(one inch) or the values last saved with a worksheet.

· Printer...
Click this button to select paper size and paper source, orientation, printer resolution, and other 
specific settings for your active printer model. (This function is the same as the Printer Setup 
command from the File menu.)

To move from one field to the other, either use your mouse, or press the TAB or SHIFT+TAB keys.

Choose OK to confirm all your selections and to close the dialog box.



> All the Page Format entries will be saved with the worksheet when you choose Save or Save     as...   from 
the File menu.

> To start printing, choose one of the commands listed in the table at the beginning of this Help window.
> Choose Printer     Setup   from the File menu to select paper size and paper source, orientation, printer 

resolution, and similar specific settings for your active printer model.
> To activate a different printer model connected to your system, or to install and configure a new printer,

choose the Printers option in the Windows Control Panel. Please refer to your Windows 
documentation for further information.
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Exit
File menu command: Exit

The Exit command closes DASYLab.
The following session settings are saved when your DASYLab session ends.
· Size and position of the DASYLab window on your screen;
· the Module     Bar   configuration;
· the Author, Company, and Department information from the File     Info   dialog box (File menu);
· the Autostart option (Experiment menu);
· the Animation option (View menu);
· the display settings of the Module     Bar   and the Function     Bar   (View menu);
· the Window     Setup   (Options menu);
· the Color settings (Options menu);
· the Autorouter option (Options menu);
· the Password     Protection   option (Options menu).

If there is a worksheet on the screen which you have changed since you last saved it, you will be asked:
· to either save that worksheet now before exiting DASYLab,
· or to reject those changes,
· or to recall the Exit command.

You can also exit DASYLab by double-clicking the system control button in the upper left hand corner of 
the DASYLab window, or by pressing ALT+F4.

File Menu Commands
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Edit Menu Commands
The commands of the Edit menu allow you to copy the DASYLab worksheet displayed on the screen to 
the Windows Clipboard and to configure the Module Bar according to your specific requirements. It also 
provides the functions necessary to organize Black Box files.

Worksheet to Clipboard

Black Box Module

Module Bar
Main Menu Options



Worksheet to Clipboard

Edit Menu Command: Worksheet to Clipboard

Select this command, or click the icon in the Function Bar, to create a Windows Metafile image 
(WMF/CLP) of the DASYLab worksheet on the Windows Clipboard.

The worksheet is always copied to the Clipboard as displayed on screen, including all the changes made
since last saving it.
The worksheet background is not copied, however, even if you have selected a color and a grid. For 
further information on these options, see Customizing     the     DASY  Lab     Screen.  
The worksheet itself remains unchanged if you copy it to the Clipboard.

The image on the Clipboard is automatically scaled to the size of the worksheet on the DASYLab 
worksheet. If the worksheet consists of only a few modules these will appear larger on the Clipboard 
than if you have arranged a large number of modules all over the virtual worksheet.

Use the Paste function provided in any Windows application (usually in the Edit menu), to transfer the 
metafile from the Clipboard to applications such as PaintBrush or Word for Windows for further use.

Edit Menu Commands



Module Bar
Edit Menu Command: Module Bar

The Module Bar, on the left hand side of the DASYLab window, displays a selection of frequently used 
modules. The menu commands provide the functions to modify the module bar for your requirements:

New: provides a blank module bar to be configured.

Open...: opens a saved module bar.

Save     As...:  saves the current module bar configuration to a file with the name of your choice.

Default: opens the default module bar.

Edit Menu Commands
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New Module Bar
Edit Menu Command: Module Bar, New

Choose this command to create a completely new Module Bar. The current module bar will be cleared 
completely. Then you can assign the module of your choice to each button.

Click on a button in the module bar with the right mouse button to assign any module to that button. A 
dialog box presents a list of all the modules available in DASYLab. Scroll through the list using the scroll 
bar, choose a module by clicking it with the left mouse button, and choose OK to confirm your choice. 
The module bar button now displays the icon of the module assigned to it.
When you have customized your module bar, all you have to do to add one of those modules to your 
worksheet is to click the icon which symbolizes that module with the left mouse button.

The modified module bar settings will be automatically saved when you exit the program. The next time 
you start DASYLab, you will find the same module bar.
To save a configuration permanently, or to configure several module bars specially adapted for individual
experiment tasks, you must save them to files and open them again later.

Choose these commands from the Edit / Module Bar menu:
> Open... to open a saved module bar configuration.
> Default to open the default module bar configuration.

Edit / Module Bar Menu Commands
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Open Module Bar...
Edit Menu Command: Module Bar, Open

Choose this command to open a Module Bar that has been saved to a file.

You can select the module bar file from a list of files presented in a dialog box.

You can ...
· open one of the files from the list directly (double-click the file name),
· select a different directory (double-click the directory name),
· select a different file format for the file display, or
· select a different drive.
(If you wish to use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to 
another, select items from the lists by pressing , ¯, SPACE and the ENTER key.)

In the File Name box you can define the filter for the file list to be presented in the box below. The default 
setting for this filter (*.DML) will create a list of DASYLab module bar files, which usually have the 
extension *.DML.
By typing a different extension here, or by using wildcards (like *.*), confirmed by pressing the ENTER 
key, you can get lists of different groups of files - for example, if you have saved DASYLab module bars 
with different extensions than *.DML (Save     As...   command from the Edit / Module Bar menu).
However, DASYLab can only open module bar files in its own DML format, no matter what extension the 
files have.

When you open a module bar file, any modifications of the current module bar on the screen are lost, 
unless you have saved them (Save     As...   command from the Edit / Module Bar menu).

Whenever you exit the program, the current module bar configuration is automatically saved to the 
DASYLab.DML file.

> You can specify a default directory for Module Bar files (Options menu command).

Choose these commands from the Edit / Module Bar menu:
> New to provide a blank module bar to be configured individually.
> Save     As...   to save the current module bar configuration to a file under a name of your choice.
> Default to open the default module bar configuration onto the DASYLab screen.

Edit / Module Bar Menu Commands
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Save Module Bar As...
Edit Menu Command: Module Bar, Save As...

Choose this command to save the current Module Bar configuration on the DASYLab screen to a 
separate file name.
You can select the file name, the directory and the disk drive where the file is to be stored.
· Type the file name in the File Name box. (Note that the file name must be chosen in accordance with 

MS DOS conventions.)
· If you do not type an extension, DASYLab automatically adds its standard extension for module bar 

file names (*.DML). (DASYLab always saves module bar files in a specific format, even if you select an
extension other than *.DML.)

· You can ...
· select one of the file names presented in the list directly (double-click the file name). The file will 

then be replaced with the new module bar setup;
· select a different directory (double-click the directory name), or
· select a different drive for the new file.
· In the List Files of Type box you can select the type of files (defined by their extension) to be listed 

in the box above.
(If you wish to use your keyboard, press the TAB or the SHIFT+TAB keys to move from one field to 
another; select items from the lists by pressing , ¯, SPACE and the ENTER key.)

Whenever you exit the program, the current module bar configuration is automatically saved to the 
DASYLab.DML file.

> You can specify a default directory for Module Bar files (Options menu command).

Choose these commands from the Edit / Module Bar menu:
> New to provide a blank module bar to be configured.
> Open... to open a saved module bar configuration.
> Default to open the default module bar configuration.

Edit / Module Bar Menu Commands
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Default Module Bar
Edit Menu Command: Module Bar, Default

Choose this command to open the default Module Bar configuration.

The module bar will be opened immediately. Any modifications of the current module bar on the screen 
will be lost, unless you have saved them (Save     As...   command from the Edit / Module Bar menu).

The default module bar is not saved in the DASYLab.DML file but is stored internally. Therefore you 
cannot change its setup.

The DASYLab.DML file always contains the module bar configuration which was active when you last 
exited the program.

Choose these commands from the Edit / Module Bar menu:
> New to provide a blank module bar to be configured.
> Open... to open a saved module bar configuration.
> Save     As...   to save the current module bar configuration to a file.

Edit / Module Bar Menu Commands
Edit Menu Commands
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Module Menu
Use this menu to select a module group. A module group is made up of a number of different modules 
providing similar functions. Select a module group to open a submenu with a list of the modules which 
belong to that group. You can select any of the listed modules by clicking on it. It is immediately placed 
on the worksheet as a module     symbol.  
Some of these modules may be installed on the module     bar.   They may be placed on the worksheet by a 
single mouse click on the corresponding icon.

The Module menu provides the following module groups:

Input/Output
Trigger Functions
Mathematics
Statistics
Signal Analysis
Control
Display
Files
Data Reduction
Special

Module Installation and Configuration
Special Module Functions and Options

Main Menu Options



Module Group
A module group consists of a number of related modules. The Module menu provides all the module 
groups. Choose a module group from the Module menu to open a submenu with a list of the modules 
which belong to that group. You can select any of the modules listed by clicking on it. It is then 
immediately placed on the worksheet as a module symbol.
______________________



Module
A module represents a functional element in the virtual DASYLab experiment setup (worksheet). A 
worksheet can contain up to 256 modules. (Additionally, the Black     Box   concept allows you to exceed 
that number by as many modules as you want.)
The functions symbolized by the modules comprise all the operations required for an experiment,
· from data acquisition (by a data acquisition board) or signal generation (simulated by a virtual 

generator)
· to data analysis, evaluation and processing (mathematics, statistics, control, trigger and other 

functions)
· up to their presentation on screen (display instruments) or export for documentation purposes 

(printer, metafile, etc.).
The modules can be installed on the worksheet either by choosing them from the Module menu or by 
clicking the corresponding icons on the Module     Bar.  
Modules can appear in various forms.
Click here for further information on how     to     install     and     configure     modules.  
______________________



Module Installation and Configuration
Installing Modules

A module can be installed on the worksheet  by choosing it from the Module menu or by clicking the 
corresponding icon on the Module     Bar.   Either way, it will immediately be placed on the worksheet as a 
module     symbol.  
For modules which provide more than one basic operation you must also select the function     type.  

· Choose a Module     Group   from the Modules menu to display a submenu with the individual modules 
which belong to that group. The submenus provide all the modules currently available. You can select 
any of the modules by clicking on its name.
Click here to display an alphabetical     list   of all the available modules.

· Any module can also be installed on the Module Bar. It may then be placed in the worksheet by a 
single mouse click on the corresponding Module Bar icon.

Configuring Modules
Use the left mouse button to double-click on a module's worksheet symbol to open the dialog box 
to configure the module. The following parameters can generally be specified in the dialog box:

· the module     name,  
· the module     description,  
· and the number     of     input/output     channels   (up to 16 for most modules).

Once you have activated more than one channel, you can select each of them to display and define 
channel-specific parameters.
Configuring several channels for one module is easy when you use the F7     /     F8   function keys.
For module-specific settings please refer to the module descriptions.

Connecting Modules
Data     channels   represent the connections between the output of a module and the input of another 
module. By creating branches, each module output can be connected to up to 16 inputs of other 
modules.
Click here for further details about creating, deleting and rearranging data channels.

Moving Modules
The modules can be moved to any position on the worksheet by dragging and dropping the 
worksheet symbol. Click on the worksheet symbol with the left mouse button and, while holding the 
mouse button down, drag it to any position. It will automatically be aligned depending on the spacing 
value entered in the Window     Setup   box of the Options menu.

Deleting Modules
The modules can be deleted by double-clicking on the worksheet symbol with the right mouse 
button. A dialog box appears where you can specify whether the module itself is to be deleted from 
the worksheet or only its input/output data     channels.  

> Some of the operations described here can also be performed using the keyboard. Click here for 
further information on keyboard operations.

Help Index



Module Name
Each module can be tagged with an identifying name of your choice. It is displayed in the Module Name
box of the module configuration dialog box and can be modified there. It may consist of up to 12 
alphanumeric characters.
The module name helps to identify the individual module in the worksheet:

· With all modules, this name appears in the title bar of the module     symbol   in the worksheet.
· With modules which provide an additional display or control window, like the Display modules, the 

module name is also displayed:
· below the icon which represents the minimized additional window, and
· in the title bar of that window when it is activated.

Modules which influence the functions of other modules (such as the Action module) identify their 
target module through its module name (not through data     channels   as it might appear). For that 
reason, module names must always be unique.
Whenever you install a new module, DASYLab suggests a default name in this box. This name is 
always unique. It indicates the module function followed by the consecutive number of this module 
type (for example, Generator00 for the first Generator module, Generator01 for the second Generator 
module, Generator02 for the third, and so forth). (The description of the module function may be 
abbreviated because of the limited number of characters.)
The default name can be changed by the user.
______________________



Description Module

You can describe the function of the module in the worksheet.
The description may consist of up to 40 alphanumeric characters. It will be stored with the worksheet.
By default this field is empty.

Module Selection Menu
______________________



Selecting the Number of Input/Output Channels

Selection Bar Example

Use this bar to specify the number of signal inputs and outputs for a module in your worksheet.

This is an essential part of the module configuration. The corresponding module     symbol   in the work area
will display the required number of input (I) and output (O) symbols; these serve as the starting points 
and termination points for the data     channels   through which data will be transferred between the 
modules.
Once you have activated more than one channel, you can select each of them to display and define 
channel-specific parameters.

The buttons described below allow you to configure a module easily and conveniently:

You can only increase or reduce the total number of input/output channels of a module using the buttons
on the left and the right:

Add One Channel
Click this button to activate one more channel and thus add another input or output to the module.
If the maximum number of channels has been activated, the Add Channel button remains grey.
If the newly activated channel had been used before in the same worksheet, its settings will still be valid 
as last selected, as long as the experiment setup has not been saved to a file in the meantime. 
Otherwise the default values of that module will be used.

Remove One Channel
Click on this symbol (when more than one channel has been activated) to reduce the number of 
channels by one.
If only one channel has been activated, the Remove Channel button remains grey.
If the channel that is to be removed is presently selected, the next channel on the left will be 
automatically selected.
The settings of the removed channel are retained until the worksheet is saved to a file.

The state of each channel is indicated by one of the following symbols:

channel inactive
This symbol indicates an inactive channel.
It cannot be selected; it must be activated by clicking the Add Channel button as described above.

channel active
This symbol indicates an active channel.
Click the icon with the left mouse button to select the channel to define specific parameters.
Active channels can only be removed by clicking the Remove Channel button as described above.

channel active and selected
This symbol indicates the currently selected active channel.
The settings displayed in the text boxes, list boxes and check boxes all refer to that channel, and it is 



the only one that can have parameters defined.
You can only deselect this channel by selecting (clicking) another activated channel, or by removing it 
as described above.

Note: Other channels which are activated though not selected and displayed may be configured 
differently. To display the settings of any channel, you must select it first.

Hint: Configuring several channels for one module is easy when you use the F7     /     F8   function keys.

Module Selection Menu
Main Menu Options



Input Channel Selection Bar Analog / Digital / Counter Input

Selection Bar Example

Use this bar to activate or deactivate the individual input channels of your Analog     Input, Digital     Input,   or
Counter     Input   module.
The numbered connector symbols displayed in the horizontal bar represent the physical 
input channels on your data     acquisition     hardware.  
Once you have activated more than one channel, you can select each of them to display and define 
channel-specific parameters.
The channel     name   and the other settings displayed in the text boxes, list boxes and check boxes all 
describe the currently selected channel.
Other channels which are activated though not selected and displayed may be configured differently. To 
display the settings of any channel, you must select it first.

The state of each channel is indicated by one of the following symbols:

channel not available
These channels are not available on the data acquisition board installed in your system. Therefore, they 
cannot be activated or selected.

channel not activated
This channel is available on the data acquisition board, but it is inactive and it will not acquire data.
Double-click the icon with the left mouse button to activate and select the channel.

channel activated
This channel is active. Data will be acquired by the hardware when measurement begins.
The corresponding module     symbol   on the worksheet supplies an output symbol for this channel.
Click the icon with the left mouse button to select the channel to define specific parameters.
Double-click the icon with the right mouse button to deactivate the channel.

channel selected
This symbol indicates the active channel which is currently selected.
The settings displayed in the boxes (for example, the channel     name,   etc.) all refer to that channel, and 
it is the only one that can have parameters defined.
You can only deselect this channel by selecting (clicking) another activated channel, or by removing it 
as described above.

Note: Other channels which are activated though not selected and displayed may be configured 
differently. To display the settings of any channel, you must select it first.

Hint: Configuring several channels for one module is easy when you use the F7     /     F8   function keys.

Input / Output Modules
Module Selection Menu



Output Channel Selection Bar Analog / Digital Output

Selection Bar Example

Use this bar to activate or deactivate the individual output channels of your Analog     Output   or 
Digital     Output   module.
The numbered connector symbols displayed on the horizontal bar represent the physical output 
channels on your data     acquisition     hardware.  
Once you have activated more than one channel, you can select each of them to display and define 
channel-specific parameters.
The channel     name   and the other settings displayed in the text boxes, list boxes and check boxes all 
describe the currently selected channel.
Other channels which are activated though not selected and displayed may be configured differently. To 
display the settings of any channel, you must select it first.

The state of each channel is indicated by one of the following symbols:

channel not available
These channels are not available on the data acquisition board installed in your system. Therefore, they 
cannot be activated or selected.

channel not activated
This channel is available on the data acquisition board, but it is inactive and it will not output data.
Double-click the icon with the left mouse button to activate and select the channel.

channel activated
This channel is active. Data will be output to the hardware when measurement begins.
The corresponding module     symbol   on the DAP Box worksheet supplies an input symbol for this channel.
Click the icon with the left mouse button to select the channel to define specific parameters.
Double-click the icon with the right mouse button to deactivate the channel.

channel selected
This symbol indicates the active channel which is currently selected.
The settings displayed in the boxes (for example, the channel     name,   etc.) all refer to that channel, and 
it is the only one that can have parameters defined.
You can only deselect this channel by selecting (clicking) another activated channel, or by removing it 
as described above.

Note: Other channels which are activated though not selected and displayed may be configured 
differently. To display the settings of any channel, you must select it first.

Hint: Configuring several channels for one module is easy when you use the F7     /     F8   function keys.

Input / Output Modules
Module Selection Menu



Channel Name
Each activated channel can be tagged with an identifying name of your choice. The name of the 
currently selected channel is displayed in the Channel Name box of the module configuration dialog 
box and can be modified there. It may consist of up to 20 alphanumeric characters. Spaces may be 
included (each space is one character).
Whenever you install a new module or activate another channel, DASYLab suggests a default 
channel name in this box. It indicates the module function followed by the consecutive number of this
channel (for example: Generator 1, Generator 2, Arithmetic 11, Arithmetic 12 and so forth). (The 
description of the module function may be abbreviated because of the limited number of characters.)
The default name can be changed by the user.
Click here to read further hints.
______________________



Channel Name: Further Hints
· DASYLab can only number the channel     names   within one module. Hence, these default suggestions

are not always unambiguous, but can occur repeatedly, especially within more complex worksheets.
· The channel name which is displayed (or modified) in the module configuration dialog box only refers 

to the currently selected channel.
· If you press the F7     /     F8   function keys to copy parameters, the channel name of the selected channel 

will be copied to all of the other activated channels. It will thus lose its identifying quality.
· Modules which influence the functions of other modules (such as the Action module) do not identify 

their target channel through its channel name but through its number. For that reason, channel names 
need not always be unique.
______________________



F7 / F8 Function Keys
With most modules, up to 16 input/output channels can be activated. It can be quite tedious to set all 
of their parameters individually. To simplify that task, press the F7 or F8 function keys to copy 
parameters from the selected channel to all the other activated channels:

· F7 to copy only the selected parameter (the currently highlighted one).
· F8 to copy all the parameters of the selected channel - including the channel     name.  

While an experiment is running, these function keys have no effect.
______________________



Special Module Functions and Options
Module Installation and Configuration
Modules with multiple Function Types
Copy Inputs to Outputs
Peculiarities of the Display Modules
DASY  Lab   by Keyboard  
F7 / F8 Function Keys

Module Menu
______________________



Modules with multiple Function Types
Several modules can be operated using different functions.

· In the Module menu such a module is listed only showing its basic function (also the Module     Bar   
symbol presents only this function).

· In the worksheet only a special type of this module is shown, which can only execute one of the 
various functions.
If you select such a module for insertion into a worksheet you must first specify the function type.
Since the function types often differ with regard to the required number of the inputs and outputs and 
their assignments, the selection will also determine the basic channel configuration of the module. 
Also, the function types may feature various setting possibilities and options.
If the module has been inserted into the worksheet, double-clicking on the module     symbol   will show 
the appropriate module configuration dialog box.
You cannot change the function type of a module once it has been inserted onto the worksheet. To 
change the present configuration first delete all data     channel   connections to this module. Then delete 
the module itself. Following the deletion the module can be re-inserted with another specified 
function type.
______________________



Copy Inputs to Outputs
The modules of the Display group as well as the modules Write     Data   and DDE     Output   feature the 
Copy Inputs to Outputs option. This option provides an output for each input of the module, and the 
input data is passed unchanged to the output for further processing on the worksheet.

· If the output signals of one module are to be used by several other modules, without this function all 
downstream modules must be connected individually to the source outputs. For this, data channel 
branches  must be created, complicating the worksheet significantly.

· With this function, the data can be used in one module (e.g. displayed), and then the data can also be 
passed through to downstream modules without any alterations. Since data channel branches are 
not required, a linear worksheet layout can be kept and thus the worksheet remains legible.

This option is useful for connecting several modules with multiple inputs and outputs. On the other 
hand the option should not be used too frequently, since it will affect performance.
______________________
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Input/Output
 Module Group

This group consists of the modules for analog and digital input and output.

Analog Input

Analog Output

Digital Input

Digital Output

Counter Input

DDE Input 

DDE Output

RS232 Interface
IEEE488 Interface:
· INES or
· IOtech or
· National     Instruments  

Module Selection Menu



 Analog Input
 Module

This module inserts the connection between DASYLab and the analog input channels of the installed 
data     acquisition     hardware   onto the worksheet.
It uses the installed data acquisition driver to access the hardware. Data will be acquired by the data 
acquisition device. The measured values will then be sent to the program using the module outputs of 
the module.
Double-click on this module     symbol   in the worksheet to open the module configuration dialog box, where
you can enter the number of input channels available on your hardware using the channel     bar.   Each 
activated analog input channel increases the number of module outputs, so that each channel can send 
its data to another module through a separate line.

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16 (depending on the data acquisition hardware)
Output Block Size: same as global block size
Max. Number of Modules: 32 (basic version: 1)

DASYLab supports up to 512 analog input channels in its full version and up to 8 in the basic version.

Use the channel     bar   to activate as many channels as are available. However, you can only select     one of
them at a time to define the input     range   and to enter a channel     information   string.

Click on this function     bar   icon (or choose the Experiment     Setup   command from the Experiment menu) to
open a dialog box where you can define the global sampling     rate,   the block     size,   and other important 
data acquisition parameters.

Click on this function bar icon to open the Hardware     Setup   dialog box. The settings are specific to the 
data acquisition device you specified when installing your DASYLab version.
· Channel Setup

If your hardware provides additional channel-dependent features, these can be specified in a separate 
dialog box which opens when you click on the Channel Setup button. You will find help on these 
settings when you choose Hardware from the Help menu.
The Channel Setup button remains grey and cannot be activated if the hardware driver does not 
provide such settings.

Module Installation and Configuration (General Hints)

Input / Output Modules
Module Selection Menu



Channel Information
For each channel, you can enter up to 100 alphanumeric characters into this field. For example, you 
might wish to describe the function of each channel.
The channel information will be saved with the worksheet configuration.
There is no default setting for this box.

Analog Input Module
______________________



Input Range A/D Module

Many data acquisition devices provide selectable input ranges and an integrated programmable gain.
· The selectable Input Range usually defines the input range of all the activated channels of the device. 

If the hardware supports this option, the range can be selected in the Hardware     Setup   dialog box.
· If the data acquisition hardware installed in your system is equipped with a programmable gain, you 

can select the input range for each channel in the Analog     Input   module.

Attention: If required by your hardware, the Input Range entered in the DASYLab dialog box must 
correspond exactly to the hardware configuration to ensure correct data processing by 
DASYLab. For information on jumper and DIP switch settings on your hardware please 
choose Hardware from the Help menu.

· If your data acquisition hardware does not provide amplification, this box displays the range 
selected in the Hardware     Setup   dialog box. This value cannot be changed.

Analog Input Module
______________________



 Analog Output
 Module

This module represents analog output channels if they are available on the installed 
data     acquisition     hardware.  

In the worksheet, this module can take up to 16 signal lines and connect them to the analog output 
channels of the installed hardware. The number of channels that can be activated is limited by the 
installed hardware.
Individual output channels can be activated using the channel     bar.  

Input and Output Characteristics
Number of Inputs: up to 16 (depending on the data acquisition hardware)
Input Block Size: same as global block size
Number of Outputs: ---
Output Block Size: ---
Max. Number of Modules: 2 (basic version: 1)

DASYLab supports up to 32 analog output channels in its full version and up to 16 in the basic version.

This module is useful if your application requires experiment control or the output of analog data for 
stimulation.

The parameters necessary to define the Output     Mode   can be set in the Experiment     Setup   dialog box of 
the Experiment menu.

Module Installation and Configuration (General Hints)

Input / Output Modules
Module Selection Menu



 Digital Input
 Module

This module is used to acquire digital input signals using the digital I/O of the installed 
data     acquisition     hardware.   Up to 16 digital signals can be acquired and provided to the worksheet 
through separate signal     channels.  
The digital I/O of the board can be activated using the channel     bar.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16 (depending on the data acquisition hardware)
Output Block Size: any
Max. Number of Modules: 32 (basic version: 1)

DASYLab supports up to 512 digital input channels in its full version and up to 16 in the basic version.

Usually each activated digital input channel will acquire data at the global sampling     rate,   and its values 
in DASYLab are set according to the TTL definition (0 for low and 5 for high).
Some drivers allow digital and counter input only in asynchronous mode. This is due to the transfer 
method used. With those drivers typically one digital or counter value is read for one complete block of 
analog data. The digital and counter input rate thus differs by a factor equal to the global block     size.   
Also, the timing of digital and counter input is not exactly equidistant, which may cause jitter errors.

Module Installation and Configuration (General Hints)

Input / Output Modules
Module Selection Menu



 Digital Output
 Module

This module is used to set digital I/O on the installed data     acquisition     hardware.   It can take up to 16 
digital signals from the worksheet and connect them to the corresponding hardware I/O.
The number of I/O channels can be specified using the channel     bar.  

Input and Output Characteristics
Number of Inputs: up to 16 (depending on the data acquisition hardware)
Input Block Size: same as global block size
Number of Outputs: ---
Output Block Size: ---
Max. Number of Modules: 32 (basic version: 1)

DASYLab supports up to 512 digital output channels in its full version and up to 16 in the basic version.

This module is useful if your application requires experiment control or the output of digital data for 
stimulation.

The parameters necessary to define the Output     Mode   can be set in the Experiment     Setup   dialog box of 
the Experiment menu.

Module Installation and Configuration (General Hints)

Input / Output Modules
Module Selection Menu



 Counter Input
 Module

This module is used to acquire and count impulses or frequencies. It is available if your 
data     acquisition     hardware   supports counter measurement.
This module is not included in the basic version.
Up to 16 digital signals can be acquired and provided to the worksheet through different signal     channels.  
The counters of the board can be activated using the channel     bar.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16 (depending on the data acquisition hardware)
Output Block Size: same as global block size
Max. Number of Modules: 2 (depending on the data acquisition hardware)

DASYLab supports up to 32 counter input channels.

This module can be used to acquire and count digital pulses. The resolution of the timer is 16 bit, with an
upper limit of 65,535. In DASYLab these values are treated as float values (range up to 10^38).

Usually each activated counter channel will acquire data at the global sampling     rate.  
Some drivers allow digital and counter input only in asynchronous mode. This is due to the transfer 
method used. With those drivers typically one digital or counter value is read for one complete block of 
analog data. The digital and counter input rate thus differs by a factor equal to the global block     size.   
Also, the timing of digital and counter input is not exactly equidistant, which may cause jitter errors.

DASYLab provides three different counter modes:
· Single

Every acquired sample will represent the counter difference from the preceding value, that is the 
number of pulses since the last reading. If a counter is read once per second, the values will directly 
represent the pulse frequency in Hertz.

· Running
The values are read as in the Single mode, but the driver directly calculates the sum of all the acquired
samples. Since DASYLab uses float values for the result of summation, the accuracy will be about 6 to
7 digits, and the range will be up to 10^38.

· Frequency
The values are read as in the Single mode, but the driver directly converts them into frequency values.

You can switch between these modes while the measurement is running. Since all the values are 
calculated by the driver, the active Running Mode always represents the number of pulses since the 
beginning of the measurement, even if the mode has been changed in the meantime.

Module Installation and Configuration (General Hints)

Input / Output Modules
Module Selection Menu



 DDE Input
 Module

This module is used to receive data from other Windows applications (for example, Microsoft EXCEL). It
uses the standard Windows DDE interface (Dynamic Data Exchange).

Inserted into a worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16
Output Block Size: 1 or same as global block size
Max. Number of Modules: up to 16 DDE Input and DDE Output modules altogether

How it works
The DDE Input module is used to receive data from other Windows applications through up to 16 
different channels.
· DASYLab acts as DDE Server or as DDE Client with a Hot Link to a DDE Server.

· If you use DASYLab as DDE Server, start DASYLab first, before the application providing the data 
is started.

· If DASYLab acts as DDE Client, configure the DDE Server first, and then start DASYLab.
· Data is expected to be received in ASCII format.

Hint: DDE communication is only useful for slow applications (typically only up to 100 Hz).

Establishing the DDE Communication
The topic DDE Connection specifies whether DASYLab acts as Server or Client.
· If DASYLab acts as Server, the DDE Connection has to be defined by the Sender. The following DDE 

parameters must be defined in the sending task:
· Application: DASYLab
· Topic: DdeData
· Item: the Module Name of the DDE Input module.
If the program you use for communication with DASYLab is able to list all DDE servers, you can 
choose from this list.

· If DASYLab acts as a Client, the communication must be set up in DASYLab in exactly the same way 
as in the DDE     Output   module. DDE Connection specifies the receiver of the transferred data. Up to 80 
characters can be entered in the Application, Topic and Item boxes.

Data Transfer
The DDE Input module receives one sample in each DDE block for each defined channel. The DDE 
format used is CF_TEXT; the channels must be separated by space characters and the block should 
end with a CR/LF character.
If a DDE block contains less than the expected number of channels, the values for all the remaining 
channels is set to 0.

The Synchronization entry specifies the mode for the DDE Input module:
· One Sample per DDE Transfer

This mode specifies that the DDE Input module generates one DASYLab block of size 1 for each DDE 
block received.

· Use Global Settings
This mode specifies that the DDE Input module generates a stream of data corresponding to the 



globally defined sampling rate and block size. The last DDE block received determines the value of the 
signal.
DASYLab continuously polls the DDE buffer.
· If data is sent faster than DASYLab polls, intermediate values are ignored.
· If data is sent slower, some values will be repeated.

· Master DDE Sync
If this switch is set, DASYLab tries to synchronize the DDE communication by sending an 
ACKNOWLEDGE message to the sending program after the received block has been processed. 
Otherwise, a BUSY message is sent. Not all programs react to these messages.

Hint: The DDE module always generates constant blocks of data. The sampling rate and block size in 
DASYLab should be set according to the expected rate of DDE data.

Hint: Since the functionality of the DDE module is continuously increased, please review the README
file for recent enhancements.

Data Format
Decimal Format specifies whether a Dot or a Comma is used as a decimal delimiter.

Input / Output Modules
Module Selection Menu



 DDE Output
 Module

This module is used to transfer acquired or calculated data to any other Windows application (such as 
EXCEL) which supports the standard Windows DDE protocol (Dynamic Data Exchange).

Inserted into a worksheet, this module can take data from up to 16 signal     channels   and transfer it to 
another Windows application.

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any, but the same for all the activated channels
Number of Outputs: same as number of inputs (if option is activated)
Output Block Size: same as input block size (if option is activated)
Max. Number of Modules: up to 16 DDE Input modules and DDE Output modules altogether

How it works
The incoming samples are transferred to the other Windows application using the DDE protocol.
· DASYLab acts as a DDE client, which means that the receiving program has to be started first and 

then the DASYLab worksheet can be run. DASYLab maintains the DDE link, initiates all data transfers 
and finishes the communication at the end.

· All input channels of the DDE Output module have be of the same type, the same sampling rate and the
same block size. If this condition is not fulfilled, DASYLab displays an error message and the 
experiment is stopped. The same conditions apply as for the Write Data module in ASCII format.

· DASYLab will not start to send data before a complete block of data is present at the module input.
· Data is sent in ASCII format. Details are described below.
· The option Copy     Inputs     to     Outputs   provides the module with one output for each activated entry. 

Incoming data is provided unchanged at the output.

Hint: DDE in ASCII mode is a slow connection between different applications. It is limited to 100 Hz.

Definition of the Communication Channel
The entries under DDE Connection specify where to send the data. The Application name, the Topic and 
the Item must be entered. For details which topics are provided by an application, please check the 
corresponding documentation.

Data Transfer
Decimal Format defines the format of the data sent by the DDE Output module. The Decimal Delimiter and
Number of Decimals can be defined.
DASYLab sends data in the DDE format CF_TEXT, which means all samples are converted into a block 
of strings. The maximum size of this string is 65,500 characters. This string contains all data of all input 
channels for one block of data (on each channel); we call it data matrix.
· If the module has more than one input channel, data can be ordered by Row and by Column.

· If Column is chosen, data are ordered in a way that the samples of one channel form a column in 
the data matrix. The corresponding samples of the connected channels form one row in the data 
matrix. So for a DDE output module with 2 channels and a block size of 3, DASYLab will generate 
a data matrix of 2 columns to 3 rows.
Tip: An example worksheet for column-ordered DDE connection with EXCEL is contained in the 

DASYLab directory.
· If Row is chosen, data are ordered in a way that the samples of one channel form one row in the 

data matrix.. 



· Choosing order by Row or Column does not necessarily mean, that data are arranged in Rows or 
Columns in Excel. Ecxel needs specific delimiters in order to arrange data in the desired way.

Example Two channels of data with a block size of 3 are sent by DDE. The Samples of the first 
channel are named A1, A2, A3 and those of the second channel are B1,B2,B3. Ordering by Row 
means that the DDE block contains the values in the sequence A1,A2,A3,B1,B2,B3. Ordering by 
Column results in a sequence A1,B1,A2,B2,A3,B3. All samples are separated by the specified 
separator.The optional Final Character is inserted after A3 and B3 in the first case and after B1,B2,B3
in the second case.

· Each row or column can be ended with a CR/LF character.
· In addition to the data, a Time Channel in Microsoft standard format can be sent. Depending on the 

order, the Time Channel forms the first row or first column of the complete block. You can choose 
between Time of Day and elapsed Time since Start of the experiment.

Data Format
· Separators

The samples in one string are separated by delimiters. You can choose between Blank, Tab, Semicolon
or CR/LF. These separators are only used within one string and are not appended to the end of the 
string.
There is an additional option for appending a CR/LF character at the end of each string.

· Decimal Format
The Decimal Format defines the Decimal Delimiter and the Number of Decimals. The actual number of 
characters depends on the value of the samples and may be different each time.

Input / Output Modules
Module Selection Menu



 Serial Interface
 Module

Use this module to scan data coming from the PC's serial ports.

In the worksheet, this module can read data of up to 16 different channels and transfer them to other 
modules using its signal     channels.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16
Output Block Size: 1 or global block size
Max. Number of Modules: number of available serial ports

For documentation purposes the module can be provided with a description . The module name and the 
channel name are presetted automatically by DASYLab. These defaults can be changed by the user.
The serial interface module is able to acquire data in up to 16 channels from any serial interface of the 
PC that is recognized by Windows. All blocks of data are provided with block size and timing information 
that is necessary to process data in DASYLab.
This module reads strings of data that may contain one or more channels of data. The resulting signal 
released to DASYLab consists of a number of blocks with different time intervalls, with only    one data 
point in each block, and with different starting times. As an alternative, the data can be stored in a 
separate buffer and can be released to DASYLab with the global acquisition rate and block size. This 
approach allows an easy synchronization of serial and other data. It mainly consists of two steps: each 
time data are received by the module, the internal buffer is updated with the most recent values and 
each time DASYLab requires a new block of data, the buffer is read for each sample. In general each 
resulting block of data will be constant.
In addition the acquisition process may be synchronized by DASYLab. In this case the module sends a 
data request string to the serial device each time new values are needed. The acquisition frequency can 
be defined independently from the general acquisition rate within this module
These setting are defined in the options dialog box. In the ComPort dialog box the communication 
parameters for the serial port can be changed.
The com port is held open by DASYLab for the whole time a worksheet with a serial module is loaded. 
When the experiment is started, the serial interface will be closed and opened again in order to reset the
port parameters and in order to use the actual parameter settings. In addition this causes the serial 
buffer provided by Windows to be flushed, so that data from a previous experiment are deleted.

Hint: This approach has been chosen in order to enable the user to prepare worksheets on one
computer that has different serial port settings than the target computer that will run the 
application.

Tip: If you want to check the settings without starting the measurement you can use the Send Reset 
button. This causes the serial port to be closed and opened again. In addition the defined reset 
string is sent.

Data Request Command
If the external device needs a data request command, the command string can be defined in this 
control box. The defined string is sent to the serial device each time DASYLab wants to read new 
samples. If data request is not necessary ( can be defined in the options dialog), this control box is 
grayed out. If the external device needs only one data request command in order to send a complete
scan of all channels, specify this as the data request string of the first channel and define all other 
strings as empty strings. If the external device needs separate data requests for different channels, 
you can specify them independently.



Data Format
The serial interface can only receive data in ASCII format. Please click here for more information on 
the data     format   of the interface modules.

Options
Please click here, if you need information about the Options dialog for the serial module. It contains 
the configuration setup for an external device like optional reset, start and stop commands, 
synchronization and time out conditions

ComPort
Please click here, if you need information about the configuration of the serial port . These settings are
used for the setup of the communication.

Additional Controls
· Load

This option allows to store the complete setup of the module in a separate file for later use. The file 
extension is SER.

· Save
This option allows to load previously saved setups. It reads files with the extension SER

· Send Reset
Pressing this button causes DASYLab to close and reopen the serial port and to send the defined 
reset command.

String format for Reset-, Start, Stop commands and data request
The string may contain control characters. Control characters must start with \x followed by a 
hexadecimal value (\x0d = return), or \0 (backslash zero) followed by an octal value (\0015 = return), 
or \ followed by one of the following abbreviations for controls:

'r' Return
't' Tabulator (HT)
'a' Signal (BEL)
'n' Line Feed (LF)
'b' Backspace (BS)
'f' Formfeed (FF)
'v' Vertical Tabulator (VT)

Example of a valid reset string:        \x1bRS\r      sends the escape character followed by the ASCII 
characters RS followed by a return character.

> The Default Path for configuration files can be defined in the Options-Menu.

A/D-Input/Output modules
Module selection



Options Serial Module
 This dialog box allows    the configuration of the communication with the external device, as well as the 
selection synchronization modes.

Configuration commands
· Reset Command

This string is sent to the external device each time the worksheet is loaded. It can be sent too by 
pressing the Send Reset button in the main dialog box. This string is not sent automatically when the 
dialog box is closed.

· Start Command
This string is sent to the external device each time the experiment is started. It may be used to 
configure the external device for each individual experiment.

· Stop Command
This string is sent each time the measurement is stopped.

Data Request necessary
· If you have chosen Yes, DASYLab will send the data request string to the external device in intervals 

defined by the Sample Interval. If you have selected No, the external device has to send its data 
without any request and the sampling interval can not be defined by the user..

· Sample Interval
This option allows to define the sampling rate independently from the global sampling rate in 
DASYLab. Since it uses the PC clock, its resolution is limited to multiples of 55 ms.
The sampling interval is defined as an interval per channel. If the defined sampling interval is too small
for DASYLab to process the complete worksheet, the sampling rate is automatically slowed down.
Useful values for the sampling interval are 0.5 seconds or larger.

Resend Request if Time-out
If this option is enabled the last data request is repeated if the required samples are not received after 
twice the sampling interval. The timing of the received data is corrected according to the real 
acquisition time.

One Sample per
· In the modes data point and line of data for each received data block a DASYLab block of blocksize 

1 is generated. In the first case this block is released for each channel< individually. In the second 
case all samples of the different channels are collected and released together. In this second case the 
timing information of all channels is the same, whereas in the first case each channel may have its 
independent time stamp.

· If the mode Global sample is used, data are generated according to the global settings for blocksize 
and acquisition rate. The value received from the serial interface is used to generate the signal for 
DASYLab for each channel. This mode allows to synchronize slow serial inputs directly with faster 
inputs from DAQ boards

Header Size
This option allows to skip a defined amount of data at the beginning of each measurement.
It is useful if the external device after a reset or start command first send an identification or ready 
string that does not contain data.

Serial Interface



ComPort Serial Module
This dialog box allows to define the parameters for the com port used by DASYLab. The default settings 
are    COM2, 9600 baud, 8 data bits, 2 stop bits and a buffer size of 4 K.

Hardware Settings
· Port

This entry defines the used com port. Valid choices are COM1 to COM 4.
· Baud rate

This box allows to define the used baud rate. 300 Baud to 19200 Baud is possible.
· Data bits

This entry defines the number of data bits (5 to 8).
· Stop bits

This entry defines the number of stop bits (1, 1,5 or 2)
· Parity

This entry defines whether an additional parity bit per character is used. Possible choices are even, 
odd or no parity.

Buffer Settings
·  The receive buffer is the buffer Windows uses to buffer characters received by the serial port. Its 
size can be defined using this control. This buffer allows to receive data in the background even if a 
foreground task is active or the user is dealing with windows. The size may vary between 4 kb and 32 
kb.
The send buffer for sending request strings is limited to 512 characters.

Please use the hardware manual of your external device in order to chose the right settings for the 
communication..

The defined parameters are shown in the main dialog box as a string..

Serial Interface



Data Format RS232 and IEEE488 Interfaces

DASYLab uses the Data Format input field of the interface modules to determine how the values supplied
by the measurement instrument should be interpreted. The settings always refer to the currently selected
channel of the module.
Use the Format String to specify the data format:

Data Type Number of
Bytes

Format
Designator

ASCII text any a
Integer with sign 2 i
Integer without sign 2 w
Long Integer with sign 4 l
Long Integer without sign 4 u
Floating Point IEEE Float 4 f
Floating Point IEEE Double 8 d
The data is automatically interpreted in text format if the ASCII switch has been selected.

The serial module only allows ASCII reading of data.
With the Binary setting, the data is interpreted in one of the other formats. the Format Designator must 
then be included in the Format string.

Additional parameters can be specified if Binary has been selected:
· Using the nx parameter any number of characters can be suppressed. n specifies the number of 

characters to be suppressed.
· Additionally, for binary values certain bits of the measurement value (such as status information) can 

be suppressed. Specify a mask value (in hexadecimal notation) following the Format Designator.

Spaces must be inserted into the Format string between the individual parameters.

Use the formatting commands to define each channel. For example, if there are two channels of data 
seperated by a comma and terminated by a return character, the data format for the first channel would 
be a, and the data format for the second channel would be a\r.
Examples    of Format strings:
2x a 5x The characters are interpreted as ASCII characters.

The first 2 and the last 5 characters received are ignored.
u The received value is interpreted as Long Integer number.

All characters are included.
i fff0 2x The received value is interpreted as Integer number.

The following 2 bytes are ignored.
From the Integer value, only the 12 significant bits are masked out and interpreted as a 
value.

RS232 Interface
IEEE488 Interface

Input / Output Modules
Module Selection Menu



 IEEE488 Interface
 Module

This module is used to acquire data with an IEEE488 device.
DASYLab supports boards from several vendors. During the installation procedure you can choose 
between the different boards.
The following hints are valid for all board types. For specific help, click on one of the card types.
· INES
· IOtech
· National     Instruments  

General Hints
In a worksheet, this module can read data of up to 16 different channels and transfer them to other 
modules using its signal     channels.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16
Output Block Size: 1
Max. Number of Modules: up to 15

· Communication Errors
If a communication error occurs, DASYLab displays a message and stops the experiment.

· Data Acquisition with more than one Device
If data is to be acquired from several IEEE devices, a separate IEEE module must be placed into the 
worksheet for each device. Each device must have a unique IEEE address.

· Data Format
Please click here for more information on the data     format   of the interface modules.

Hint: You can specify a default directory for the configuration file of the IEEE device (Options menu 
command).

Module Installation and Configuration (General Hints)

Input / Output Modules
Module Selection Menu



 IEEE488 Interface: INES
 Module

This module is used for the measurement acquisition of units with IEEE488 interface (IEC bus).
Prerequisites for this function are:
· an IEEE488 interface card from the INES company installed in your computer,
· the correct Windows drivers (*.DLL in the WINDOWS\SYSTEM directory; see the INES manual),
· and the DASYLab INES driver (which must be selected during DASYLab installation).

The commands used with this module must conform to the syntax definitions of the INES card. For 
details concerning the syntax, please refer to the INES manual.
Depending on the installed hardware, this module can gather data of up to 16 inputs in the worksheet 
and supply this data to other modules via data     channels.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16 (depending on the hardware)
Output Block Size: same as global block size
Max. Number of Modules: up to 15

Most of the commands used to communicate with the IEEE card need a device handle (synonym for 
the address specified at Hardware     Setup  ) to talk to the device. Default handles are user for the 
measurement instrument and ieee for the card. One of these handles is specified as command 
parameter (in parenthesis) defining the target of the command.

General Module Configuration
· Start commands

This entry field is used to specify commands for the initialization of the IEEE board and the connected 
acquisition devices. The commands entered here are executed once when the measurement is 
started.
Example:

ABORTIO 7 stop previous communication processes
CLEAR 709 reset interface
SET 709,1000,9013,9013 set terminators and delays
OUTPUT 709, 'xyz' initialize devices

· Stop commands
The commands entered here are executed once when the measurement is stopped.

· Sampling Rate
The acquisition rate is taken from the Windows system clock. The maximum rate is 10 Hz or 
0.1 seconds delay. If the connected device does not send data at the desired rate, no warning or error 
message will occur, but the next value will be accepted after the next delay. Every sample is provided 
with the current system time. The bus delays for the IEEE board must be adjusted using the INIT 
command in accordance with the acquisition rate.

· Data Format
Please click here for more information on the data     format   of the interface modules.

· Data Request
This command will be sent out whenever a value is requested by a device. The last line must always 
be ENTER 7xx,%5, which is necessary for the communication between DASYLab and the IEEE 
board.
Example:

OUTPUT 709,´xxyyzz´ device-dependent request command



ENTER 709,%5 read value

In addition, a delay command WAIT n may be entered in these input fields, where n denotes the delay 
time in milliseconds. Any value may be entered, but these values are always rounded to multiples of 
55 ms according to the cycle time of the system clock.
If a communication error occurs during communication with a device or with an IEEE card, an error 
message will be displayed, and the acquisition of data will be stopped.
To acquire data from several devices you must insert an individual IEEE module into the worksheet for
each device. Prerequisite for this is that all devices are operated via one IEEE board and set to different 
device addresses. A maximum of 15 devices can be connected to one IEEE board.

Hint: You can specify a default directory for the configuration file of the IEEE device (Options menu 
command).

Module Installation and Configuration (General Hints)

Input / Output Modules
Module Selection Menu



 IEEE488 Interface: IOtech
 Module

This module is used for the measurement acquisition of with IEEE488 interface (IEC bus).
Prerequisites for this function are:
· an IEEE488 interface card from the IOtech company installed in your computer,
· the correct Windows drivers (*.DLL in the WINDOWS\SYSTEM directory; see the IOtech manual)
· and the DASYLab IOtech driver (which must be selected during DASYLab installation).

The commands used with this module must conform to the syntax definitions of the IOtech card. For 
details concerning the syntax, please refer to the IOtech manual.
Depending on the installed hardware, this module can gather data of up to 16 inputs in the worksheet 
and supply this data to other modules via data     channels.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16 (depending on the hardware)
Output Block Size: same as global block size
Max. Number of Modules: up to 15

Most of the commands used to communicate with the IEEE card need a device handle (synonym for 
the address specified at Hardware     Setup  ) to talk to the device. Default handles are user for the 
measurement instrument and ieee for the card. One of these handles is specified as command 
parameter (in parenthesis) defining the target of the command.

General Module Configuration
· Start commands

This entry field is used to specify commands for the initialization of the IEEE board and the connected 
acquisition devices. The commands entered here are executed once when the measurement is 
started. A maximum of 50 command lines can be entered.

· Stop commands
The commands entered here are executed when the measurement is stopped. This sequence can be 
used, for example, to deactivate the remote control (data acquisition via a computer) of a connected 
device. A maximum of 50 command lines can be entered.

· Data Format
Please click here for more information on the data     format   of the interface modules.

· Data Request
The commands specified here are executed once for each channel before data acquisition takes 
place. Use this sequence to trigger the data acquisition and transfer of data.

Additional Switches
· By clicking onto the Hardware button a separate dialog box is opened. Use this window to enter the 

various settings for the actual measurement device.
· The Options button allows other settings to be entered for the Acquisition Rate and the Transfer Mode.

Notes
· If a communication error occurs during communication with a device or with an IEEE card, an error 

message will be shown in a separate window, and the entire measurement will be stopped.
· To acquire data from several devices you must insert an individual IEEE module into the worksheet 

for each device. Prerequisite for this is that all devices are operated via one IEEE board and set to 
different device addresses. A maximum of 15 devices can be connected to one IEEE board.

Hint: You can specify a default directory for the configuration file of the IEEE device (Options menu 



command).

Module Installation and Configuration (General Hints)

Input / Output Modules
Module Selection Menu



Command Overview IOtech IEEE Board

The following commands are supported for this card:
ABORT output an Interface Clear message
CLEAR reset one or all devices
ENTER read in data of one device
LISTEN interface in Listener mode, data can be read from the bus
LOCAL send a Go To Local message to all devices
OUTPUT send data to one device
REMOTE set the Remote Enable line
SPOLL serial Poll scanning
TALK interface is in Talker mode, data can be output onto the bus
TRIGGER output a trigger to one device
UNLISTEN reset the Listener mode
UNTALK reset the Talker mode

The following commands are interface card independent:
IF Conditional execution, currently only possible with SPOLL
ELSE The following condition is executed if the IF condition is not satisfied.
WHILE Loop until the status is satisfied, otherwise the same as IF but without 

BEGIN...END.
BEGIN...END All commands enclosed by these statements are conditionally executed.
WAIT Following this command the waiting time can be specified in milliseconds. Execution of

commands is delayed by the specified time.
Examples:

Command sequences Explanation
IF (spoll (user) & 16 == 0)
BEGIN
   ...
END
ELSE
BEGIN
   ...
END

The IF command must be followed by a 
SPOLL command (operator &, comparison
with == , > , < , >= , <= possible).

You cannot nest IF statements.

WHILE (SPOLL (user) & 16)
   ... command

The WHILE loop is executed until the 
condition is satisfied.

IOtech



Hardware IEEE488

In this dialog box for the IOtech or National Instruments IEEE488 interfaces, various settings can be 
made for the actual measurement:

· The Device Address specifies the IEEE bus address set at the measurement instrument.
· The Secondary Address is used to specify the second address of the measurement instrument.
· The Timeout parameter specifies the time in milliseconds DASYLab waits for this data from the 

measurement instrument. If this time is exceeded, DASYLab aborts the measurement.

IOtech
National     Instruments  
______________________



Options IEEE488

 In this dialog box for the IOtech or National Instruments IEEE488 interfaces, settings can be made 
relating to the Acquisition Rate, the Transfer Type and the Scan Mode.
All these settings relate to the interpretation of the data received by DASYLab but not to the 
programming of the connected measurement instrument.
· Storage Settings

The settings made here are relevant if the connected IEEE measurement instrument acquires the data
independently and sends them to DASYLab.
· Storage Rate

The desired acquisition rate for the device can be set in seconds.
· Storage Mode

Several settings are available:
· Single Values

One data value is requested for every active channel.
Set the Transfer Block Length and the Output Block Length to 1.

· Block mode
AAA

One data block is requested for every active channel.
The value set for Transfer Block Length specifies the block length.

AAABBBCCC
All data values are stored block by block in channel 0. The data of all other channels of the 
measurement instrument are available at channel 0 of the IEEE-module.
The Transfer Block Length represents the number of values of a channel.
With a Transfer Block Length of n the data is present n times in channel 0, n times 
in channel 1, ... etc., in the output data block.

ABCABCABC
All data values are only requested with the command for channel 0, read in by a Read 
operation and assigned to the activated output channels.
The number of output channels are specified under Transfer Settings.

· Transfer Settings
The settings made here are in direct relationship with the Storage Mode selected in Storage Settings. 
The Transfer Block Length per Channel specifies the block length the IEEE device uses to transfer 
data.
The Transfer Buffer specifies the size DASYLab reserves for receiving the data block. The buffer size 
must be sufficiently large to allow for the storage of an entire data block. If the size is below the 
required amount, the remaining data is read in with the next Read-In command and thus falsely 
interpreted.

· Module Settings
These settings refer to the DASYLab module itself.
If Dispatcher Mode is active, the measurement request commands are sent in intervals specified in 
seconds under Acquisition Rate. The incoming data is then processed. The highest Acquisition Rate is 
0.1 seconds.
The Output Block Length specifies the block length DASYLab uses to transmit the data to other 
modules. The value specified must be the same or smaller than the Transfer Block Length set for the 
IEEE device.

· Data Value Acquisition
The operating mode of the module is set here.
When the Dispatcher Mode is selected and the measurement is started, DASYLab automatically sends 
the data value Request command in the time intervals set for Acquisition Rate.
When the Status Request mode is active, the IEEE device is responsible for the time base 
(Acquisition Rate). In this mode the status of the device must be determined with the measurement 
request command (SPOLL command).
Example: IF (spoll (user) & 16 == 1)



ENTER (user)
The data is read in if they are ready for transfer (corresponding status).

IOtech
National Instruments



 IEEE488 Interface: National Instruments
 Module

This module is used for the measurement acquisition of with IEEE488 interface (IEC bus).
Prerequisites for this function are:
· an IEEE488 interface card from the National Instruments company installed in your computer,
· the correct Windows drivers (*.DLL in the WINDOWS\SYSTEM directory; see the 

National Instruments manual)
· and the DASYLab NI driver (which must be selected during DASYLab installation).

The commands used with this module must conform to the syntax definitions of the NI card. For details 
concerning the syntax, please refer to the National Instruments manual.
Depending on the installed hardware, this module can gather data of up to 16 inputs in the worksheet 
and supply this data to other modules via data     channels.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16 (depending on the hardware)
Output Block Size: same as global block size
Max. Number of Modules: up to 15

Most of the commands used to communicate with the IEEE card need a device handle (synonym for 
the address specified at Hardware     Setup  ) to talk to the device. Default handles are user for the 
measurement instrument and ieee for the card. One of these handles is specified as command 
parameter (in parenthesis) defining the target of the command.

General Module Configuration
· Start commands

This entry field is used to specify commands for the initialization of the IEEE board and the connected 
acquisition devices. The commands entered here are executed once when the measurement is 
started. A maximum of 50 command lines can be entered.

· Stop commands
The commands entered here are executed when the measurement is stopped. This sequence can be 
used, for example, to deactivate the remote control (data acquisition via a computer) of a connected 
device. A maximum of 50 command lines can be entered.

· Data Format
Please click here for more information on the data     format   of the interface modules.

· Data Request
The commands specified here are executed once for each channel before data acquisition takes 
place. Use this sequence to trigger the data acquisition and transfer of data.

Additional Switches
· By clicking onto the Hardware button a separate dialog box is opened. Use this window to enter the 

various settings for the actual measurement device.
· The Options button allows other settings to be entered for the Acquisition Rate and the Transfer Mode.

Notes
· If a communication error occurs during communication with a device or with an IEEE card, an error 

message will be shown in a separate window, and the entire measurement will be stopped.
· To acquire data from several devices you must insert an individual IEEE module into the worksheet 

for each device. Prerequisite for this is that all devices are operated via one IEEE board and set to 
different device addresses. A maximum of 15 devices can be connected to one IEEE board.



Hint: You can specify a default directory for the configuration file of the IEEE device (Options menu 
command).

Module Installation and Configuration (General Hints)

Input / Output Modules
Module Selection Menu



Command Overview National Instruments IEEE Board

 The following commands are supported for this board:
IBCLR output an Interface Clear message
IBCMD send interface commands
IBCONFIG change interface parameters
IBDMA set or reset of the DMA mode
IBEOS change or reset End of String transfer mode
IBEOT set or reset the End of Transition transfer mode
IBLOC switch device to Local mode
IBPAD change the primary address
IBRD read in of data into string
IBRPP parallel Poll scan
IBRSC set or reset the interface features to output the Interface Clear and Remote Enable 

message
IBRSP serial Poll
IBSAD change the secondary address
IBSIC send Interface Clear message for 100µs
IBSRE set or reset the Remote Enable line
IBSTOP terminate the asynchronous operation
IBTMO change the Time Out value
IBTRG trigger a device
IBWRT send string to a device

The following commands are interface card independent:
IF Conditional execution, currently only possible with IBRSP
ELSE The following condition is executed if the IF condition is not satisfied.
WHILE Loop until the status is satisfied, otherwise the same as IF but without 

BEGIN...END.
BEGIN...END All commands enclosed by these statements are conditionally executed.
WAIT Following this command the waiting time can be specified in milliseconds. Execution of

commands is delayed by the specified time.
Examples:

Command sequences Explanation
IF (ibrsp (user) & 16 == 0)
BEGIN
   ...
END
ELSE
BEGIN
   ...
END

The IF command must be followed by a 
IBRSP command (operator &, comparison
with == , > , < , >= , <= possible).

You cannot nest IF statements.

WHILE (ibrsp (user) & 16)
   ... command

The WHILE loop is executed until the 
condition is satisfied.

National Instruments
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Trigger Functions
 Module Group

This group consists of the modules for software triggers.

Pre/Post Trigger

Start/Stop Trigger

Relay
Module Selection Menu



 Pre/Post Trigger
 Module

This module is used to generate a trigger signal at its output depending on the input signal conditions.

In the worksheet, this module can have up to 16 signal     inputs.   For each of them, different range 
conditions regarding the amplitude or the slope may be defined. To avoid multiple triggering a hysteresis 
can be defined, too.

Input and Output Characteristics
Number of Inputs: up to 16 (data signals)
Input Block Size: any
Number of Outputs: same as number of inputs (TTL signals)
Output Block Size: same as input block size
Max. Number of Modules: any

This module generates a TTL compatible signal at each module output. The output signal is dependent 
on the trigger conditions defined for the corresponding module entry. Its value is set to high (amplitude 
5) if the trigger condition is fulfilled, and it is set to low (amplitude 0) if the trigger condition fails.

The output signals can be used to control a Relay module which may gate the signal flow.
· The trigger     range   defines the range of amplitude values which will cause the trigger to be set.
· The trigger hysteresis defines the condition which has to be fulfilled before a second trigger event will 

be accepted. Both conditions consist of two parts: the definition of an amplitude or slope range, and a
flag whether a trigger should be set when the signal is inside or outside the defined range.

· The Pre and Post Trigger Values define how many high values will be set at the corresponding module 
output and in which way these values are related to the actual position of the trigger event itself.
· The Pre Trigger Value defines how many samples of the output will be set to high directly before 

the trigger event.
· The Post Trigger Value defines the number of high samples after the trigger event. The duration of 

the trigger high phase is simply the sum of the Pre and Post Trigger Values.
Admitted values are between 0 and 8,192 for the pre trigger and between 1 and 65,535 for the post
trigger.

Unlike the Start/Stop     Trigger   module, this module allows you to control the signal flow continuously.

Module Installation and Configuration (General Hints)

Trigger Modules
Module Selection Menu



Trigger Range Pre/Post Trigger

The Trigger Range defines the trigger mode and the upper and lower limits.

If an amplitude trigger is used, the incoming data samples will be checked against the specified upper 
and lower trigger value levels.
· Inside will generate a high level output if the signal amplitude enters or is within the specified upper 

and lower limits, or is equal to these limit values themselves.
· Outside will generate a high level output if the signal amplitude leaves or is outside the specified value 

range.

If a slope trigger is used, the slope of the incoming data samples is used instead of the amplitude itself. 
The slope is calculated as the difference between two successive samples divided by their time 
difference.
Example: value 1: 3.5, value 2: 3.6, sampling rate: 100 Hz = 0.01 sec.

Slope: 
After the measurement has been started, a trigger event will only be detected and evaluated if the 
following conditions are fulfilled:
· the defined number of pre trigger values must be available,
· for the second and all further trigger events the conditions concerning the hysteresis must be fulfilled.

Pre/Post Trigger



Hysteresis Pre/Post Trigger

This option defines the trigger module's reaction after a trigger event has occurred.
· If Hysteresis is switched off, the trigger will be activated directly after the defined number of post 

trigger values has passed the module.
· If Hysteresis is switched on, the hysteresis condition must be fulfilled, too, before the trigger will be 

activated again. The same options as for the trigger     range   apply for the definition of the hysteresis.

This function prevents undesired multiple triggers.

Pre/Post Trigger
______________________



 Start/Stop Trigger
 Module

This module controls the entire measurement by outputting a continuous high or low signal which is 
dependent on the input signal conditions (amplitude or slope). Since it switches the output signal only 
once (from high to low, or from low to high) it may be used to start or stop further analysis of the signal.

In the worksheet, this module can have up to 16 signal     inputs.   Different trigger conditions and 
trigger     ranges   may be specified for each of them.

Input and Output Characteristics
Number of Inputs: up to 16 (data signals)
Input Block Size: any
Number of Outputs: same as number of inputs (TTL signals)
Output Block Size: same as input block size
Max. Number of Modules: any

After the measurement has been started, the signals at the module entries are checked against the 
specified trigger conditions. If the according condition is fulfilled, the output signal will be switched. Every
input sample will then cause a TTL compatible output sample.
· In the case of a start trigger, this value will be low (amplitude 0) before the condition is fulfilled, and 

high (amplitude 5) afterwards.
· In the case of a stop trigger, the output signal will be high (amplitude 5) before the condition is 

fulfilled, and low (amplitude 0) afterwards.

Reset is not possible during measurement.

The output signals can be used to control a Relay module, which may gate the signal flow, or as the 
input of a Stop module, which may stop or pause the measurement.

Module Installation and Configuration (General Hints)

Trigger Module
Module Selection Menu



Trigger Range Start/Stop Trigger

The trigger range defines the trigger mode and the upper and lower limits.

If an amplitude trigger is used, the incoming data samples will be directly checked against the specified
upper and lower trigger value levels.
· Inside will generate a high level output if the signal amplitude enters or is within the specified upper 

and lower limits, or is equal to these limit values themselves.
· Outside will generate a high level output if the signal amplitude leaves or is outside the specified value 

range.

If a slope trigger is used, the slope of the incoming data samples is used instead of the amplitude itself. 
The slope is calculated as the difference between two successive samples divided by their time 
difference.
Example: value 1: 3.5, value 2: 3.6, sampling rate: 100 Hz = 0.01 sec.

Slope: 
Start/Stop Trigger



 Relay
 Module

This module can control several data streams by means of one control input.

In the worksheet, this module can have up to 15 signal     inputs   and one control input.
The number of signal inputs can be specified using the Channel     Bar.  

Input and Output Characteristics
Number of Inputs: 1 control input, up to 15 signal inputs
Input Block Size: any
Number of Outputs: up to 15 (same as signal inputs)
Output Block Size: same as input block size
Max. Number of Modules: any

The Relay module controls the data stream from its signal inputs by means of its control input. The 
control signal is expected to be TTL compatible. The control input is tagged x.
· If the control signal is TTL high, data at the signal inputs can pass to the module outputs.
· If the control signal is TTL low, the behavior of the module depends on the settings in Blocked Data. If 

Remove is chosen, the flow of data will be stopped; if Replace with Zeroes is chosen, the data not 
belonging to a trigger event are replaced with zeroes.

With Remove the Relay module rearranges data blocks in such a way that it will always try to send out 
complete blocks of the global block     size.   If the control signal switches very fast, the number of blocks at 
the output side of the module may be greater than at the input side.
With Replace with Zeroes the Relay module does not rearrange any data blocks. This setting is very 
useful to combine triggered data channels with "normal" data channels. On the other hand there is no 
data reduction as with Remove.
The Relay module is especially useful when combined with the Start/Stop     Trigger,   the Pre/Post     Trigger,   
the Time     Slice,   and the Digital     Input   modules.

Module Installation and Configuration (General Hints)

Trigger Modules
Module Selection Menu
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Mathematics
 Module Group

This group consists of modules which perform mathematical functions.

Arithmetic

Trigonometry

Scaling

Differentiation / Integration

Logical Operations
Module Selection Menu



 Arithmetic
 Module

The Arithmetic module performs basic calculations with one or more input signals.

Since this module provides different basic operations, you must first select the function     type   when you
install the module.
This module provides four function types:
· Operation with One Operand
· Operation with One Operand and a Constant Value
· Operation with Two Operands
· Operation with Two or More Operands

For Operation with One Operand, Operation with One Operand and a Constant Value and 
Operation with Two or More Operands, a maximum of 16 module entries is available. 
Operation with Two Operands allows up to 8 pairs of module entries.

If illegal calculations occur, such as division by zero, or an overflow, this will be indicated in all display 
functions by strings like E_NUM, E_MAX or E_MIN. However, the running measurement and analysis 
will not be stopped.

Module Installation and Configuration (General Hints)
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Arithmetic One Operand

This arithmetic module performs reciprocal, square, square root and other calculations.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This module performs the following calculations (Channel = input signal value):
function output value
Reciprocal: one divided by Channel
Square: In multiplied by Channel
Square Root: square root of the absolute value of Channel
Absolute Value: absolute value of Channel
exp (x): e to the power of Channel
ln (x): natural (base e) logarithm of the absolute value of Channel
lg (x): decadic (base 10) logarithm of the absolute value of Channel
log (x): dual (base 2) logarithm of the absolute value of Channel
Sum (x): sum of input values (sum of all samples since last reset) 
Difference (x): difference from the preceding Channel
NOP: Channel(no operation)

Hint: Running values can be reset during an experiment using the event-driven actions.

Arithmetic Module



Arithmetic Operand and Constant

This arithmetic module performs calculations with one signal and one constant value, such as 
multiplication with a constant value, offset definition and others.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

The constant value must be entered in the field in the right half of the dialog box.
This module performs the following calculations (Channel = input signal value):
function output value
Constant + Channel: constant plus Channel

(subtraction => addition of a negative constant)
Constant * Channel: constant multiplied by Channel

(division => multiplication by reciprocal of constant)
Constant ^ Channel: constant to the power of Channel
Channel ^ Constant: Channel to the power of constant
Channel mod(c): remainder when dividing Channel by constant 
Extract bit: TTL compatible high, if the corresponding bit is set for the represented integer, 

TTL compatible low otherwise. >
NOP: Channel(no operation)

Arithmetic Module



Arithmetic Two Operands

This arithmetic module performs calculations with two signals, such as addition and multiplication of 
signal values from two channels.

In the worksheet, this module can have up to 8 pairs of signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 8 pairs
Input Block Size: any
Number of Outputs: up to 8 (same as number of input pairs)
Output Block Size: same as input block size
Max. Number of Modules: any

This module performs the following basic calculations:
function output value 
Channel + Channel: channel 0 plus channel 1
Channel * Channel: channel 0 multiplied by channel 1
Channel - Channel: channel 0 minus channel 1
Channel / Channel: channel 0 divided by channel 1
Channel ^ Channel: channel 0 to the power of channel 1

Arithmetic Module



Arithmetic Two or More Operands

This module contains functions that are symmetric for more than two operands.

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any, but the same for all entries
Number of Outputs: 1
Output Block Size: same as input block size
Max. Number of Modules: any

This module applies the chosen function to all of the input channels. The result of the operation is 
contaíned in the output signal. All operations are performed sample by sample.
The following functions are available (In = all input signal values):
function output value
Add: sum of In
Multiply: product of In
OR: If any input is high, output is high 
AND: If all inputs are high, output is high 
Max/Min: maximum or minimum of In
Mean: the mean value of In
Abs. Value: the square root of the sum of the squares of In
Arithmetic Module



 Trigonometry
 Module

This module performs trigonometric calculations on the input signals.
In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

For each module entry one of the following functions can be selected:
· SINE

COSINE
The output values are calculated as sine or cosine functions of the input signal values.
The output range is from -1 to 1.
Input values greater than 10E7 cannot be calculated due to rounding errors of the underlying 
processor functions.

· TANGENT
The output values are calculated as tangent functions of the input signal values.
The output signal is not bounded.

The tangent function will be defined for all input values except , 

, 

, ...
DASYLab will substitute these values with reasonable values slightly larger or smaller.
Input values greater than 10E7 cannot be calculated due to rounding errors of the underlying processor 
functions.
· ARC SINE

ARC COSINE
The output values are calculated as arc sine or arc cosine functions of the input signal values, i.e. 
the inverse functions of sine respectively cosine.
Both functions will only be defined for input values between -1 and 1. For all other values DASYLab
will set the output value to 0.

· ARC TANGENT
The output values are calculated as arc tangent functions of the input signal values, i.e. the 
inverse function of tangent.
The arc tangent function will be defined for all input values.

Output values will range from  to 

.
· HYPERBOLIC SINE

HYPERBOLIC COSINE
HYPERBOLIC TANGENT

The output values are calculated as hyperbolic functions (sinh, cosh, or tanh) of the input signal 
values.
They will be defined for all possible input values, but since they are based on the exponential 
function the results may easily cause overflows or rounding errors.
The definitions of the hyperbolic functions are



      

      

.
The input signals can either be interpreted as degree (0-360) or radian values (0-2p). The appropriate 
unit must be selected in the dialog box.

Module Installation and Configuration (General Hints)
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 Scaling
 Module

Use this module to apply different scaling methods to the signals from the module     entries.  

Since this module provides different basic operations, you must first select the function     type   when you
install the module.
This module provides three function types:
· Linear Scaling with Two Points
· Interpolation using a Table
· Thermocouple Linearization

For all types a maximum of 16 module entries is available.

If illegal calculations occur, such as division by zero, or an overflow, this will be indicated in all display 
functions by strings like E_NUM, E_MAX or E_MIN. However, the running measurement and analysis 
will not be stopped.

Module Installation and Configuration (General Hints)
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Linear Scaling
Input and Output Characteristics

Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

You can select one of the following types of linear scaling:
· Slope and Offset

Values are calculated according to the formula Y = a x + b.
· Definition of Two Points

A linear scaling with two reference points (X1, Y1) and (X2, Y2) is performed.
In this case offset and slope are calculated automatically:

        

· NOP
This function does not calculate on the input values except that they may be cut to the defined upper 
and lower limits (no operation).

In addition, upper and lower limit values can be defined. If the output signal exceeds these levels, it will 
be cut to the respective values.

Scaling



Interpolation
This type linearizes input data by performing an interpolation between different values entered in list 
form.

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This module requires a reference file with pairs of corresponding input and output values. The file 
format is explained in detail in the manual.
The input values will be interpolated according to the pairs of reference values. Between these values a 
piecewise linear interpolation is performed.
If an input value is outside the range defined by the table of input values (i.e. by the maximum and 
minimum values of the first column), the value corresponding to the maximum or minimum value of the 
first column will be output.
The reference file can be entered in the dialog box which appears after pressing the Open button. The 
extension of the file must be *.DPF.

Hint: You can specify a default directory for reference files (Options menu command).

Scaling



Thermocouple Linearization
This type performs predefined linearizations for different types of thermocouples.

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This module allows the linearization of temperature signals generated by thermocouples of different 
types. For proper operation, the data acquisition hardware must be capable of measuring low voltages, 
and the correct type of thermocouple must be used for measuring.

DASYLab uses its own linearization tables, which are slightly different for each type. The input voltage is 
converted to a value which represents the temperature in centigrade.

Cold junction compensation can be integrated in different ways:
· Auto

Some data acquisition devices allow direct cold junction temperature measurement. In that case the 
cold junction mode should be set to auto. DASYLab will then automatically take the cold junction 
temperature provided by the device.

· Manual
Another way is to guarantee a constant environmental temperature by heating or cooling the junction 
point. In this case the temperature can be passed on to DASYLab for a correction of the temperature 
value.

· Off
Cold junction compensation can also be switched off completely (which is the default setting).

Scaling



 Differentiation / Integration
 Module

This module is used to differentiate or integrate a signal value.
In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This module provides two functions:
· Differentiation:

For each sample, the slope of the input signal values is calculated according to the formula

where dist is the time delay between two samples of the input signal. The first sample of the output 
signal will have the same value as the input signal.

· Integral:
For each sample, the integral of all the input signal values since the beginning of the experiment is 
calculated according to the formula

where dist is the time delay between two samples of the input signal.

Hint: Running values can be reset during an experiment using the event-driven actions.

Both functions are the inverse of the other one.

Module Installation and Configuration (General Hints)
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 Logical Operations
 Module

This module performs logical operations with TTL compatible signals.

Since this module provides different basic operations, you must first select the function     type   when you
install the module.
This module provides two function types:
· Unary operations
· Binary operations

For unary operations, a maximum of 16 module entries is available. Binary operations allow up to 8 pairs
of module entries.

Input and Output Characteristics
Number of Inputs: up to 8 pairs or up to 16
Input Block Size: any
Number of Outputs:

unary operations: same as number of inputs
binary operations: same as number of inputs / 2

Output Block Size: same as input block size
Max. Number of Modules: any

This module performs logical operations on the input signals according to the defined function. The 
output signal is a TTL compatible signal.

If Invert Output is selected, TTL High is output instead of TTL Low, and vice versa.
The table below indicates the values of the outputs based on the input values and the selected function.
channel: input value:

a: 0 0 1 1
b: 0 1 0 1

option: output value:
FALSE 0 0 0 0

Channel a 0 0 1 1
Channel b 0 1 0 1

a and b 0 0 0 1
a or b 0 1 1 1

a xor b 0 1 1 0
a implies b 1 1 0 1
b implies a 1 0 1 1

a equivalent b 1 0 0 1

Notes:
· 0 indicates TTL Low (0V), 1 indicates TTL High (5V).
· If FALSE is selected, the output is always 0 (TTL Low).
· Use the Invert Output option to generate further specific output values:

· FALSE plus Invert Output => output always TTL High
· AND plus Invert Output => NAND

· The input signal values may differ from the exact TTL high or TTL low levels. Such signals will be 
interpreted as high if their value is higher than 1.5 and as low if their value is lower than 1.5.

Module Installation and Configuration (General Hints)
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Statistics
 Module Group

This group consists of modules which perform statistical functions.

Statistical Values

Position in the Signal

Histogram

Regression

Counter
Module Selection Menu



 Statistical Values
 Module

Use this module to calculate various statistical parameters of the input signal.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: 1
Max. Number of Modules: any

The following parameters can be set in the module configuration dialog box:
· Operation

This parameter specifies the statistical     operations   to be performed, such as the calculation of 
Maximum, Minimum, or Mean values.

· Mode
Two different modes are available:
· Running means that the specified statistical value will be calculated on the basis of all the data that 

have been acquired by that channel since the beginning of the measurement or the last reset 
event.

· Block Based means that the output value will represent the parameter of the defined number of 
blocks only..

· Number of Blocks:
The Number     of     Blocks   parameter defines how many sample blocks will be collected before the 
specified statistical parameter is calculated.

Hint: Running values can be reset during an experiment by means of the event-driven actions.

Module Installation and Configuration (General Hints)
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Statistical Operations Statistics

The following statistical parameters can be calculated:
function output value
Maximum maximum value of the signal
Minimum minimum value of the signal
Max Position position of the maximum value in the signal
Min Position position of the minimumvalue of the signal

These values are given in seconds or Hertz depending on the type of the signal.
Mean arithmetic mean
RMS value square mean (Root Mean Square)

Variance
where x is the mean value and n is the block size

Standard Deviation square root of the variance

Statistical Values
______________________



Number of Blocks Statistics

If the number of blocks entered (n) is greater than 1, the specified statistical operations will be 
performed on the basis of groups of n input signal blocks. That number of blocks may range from 1 to 
8,192.
At the output, a new value will be generated only every n blocks.

Statistical Values
______________________



Mode Statistics

This parameter defines the range of values which will be the basis of the specified statistical operation.
· In the Running mode, the specified statistical parameter will be calculated on the basis of all the data 

values that have been acquired by that channel since the beginning of the measurement.
With every block of data, the statistical parameter will be updated, so that the output always represents
the most recent evaluation of all the data values that have been sampled.

· In the Block Based mode, the specified statistical value will be calculated separately for each 
individual block of incoming data samples. No former data samples or calculated values are taken into 
account.
Therefore the output always represents the evaluation of the most recent block of samples only.

Statistical Values
______________________



 Position in the Signal
 Module

With this module, up to 15 single values can be extracted from the data block according to their position. 
The values can then be routed via specially separated module outputs into the worksheet.

In the worksheet, this module can evaluate one signal channel via one data     channel.   It can evaluate 
position information at up to 15 additional inputs.

Use the channel     bar   to determine the number of position values to be extracted from the signal and 
thus the number of outputs of this module.

Input and Output Characteristics
Number of input channels: 1, plus up to 15
Block size at the input: same as global block size
Number of output channels: up to 15
Block size at the output: 1
Max. number of modules: any

With this module up to 15 single values can be extracted at various positions from the incoming data 
block. Each extracted value can be output via a separate channel.
The module input to which the incoming data block must be applied is marked with an X.

Position Source specifies the origin of the position information:
· At selection of Setting the module has only the input channel. The positions to be evaluated for are 

specified for each channel at Value / Sample No.
· By selecting Inputs, the module is assigned position inputs additionally to the data input. The 

number of additional inputs depends on the number of positions to be evaluated. The positions are 
then defined by the applied position inputs.
If values beyond the specified limits are applied to the position inputs, these values are 
decreased/increased to the maximum/minimum limit values.

With the item Interpret Value As... you determine how the position specification (i.e. the entry in the 
Value / Sample No. or the value received via the corresponding position input) is interpreted:
· With the Sample No. setting the nth value in the block is isolated and output.
· With the Context-Sensitive setting the position specification is interpreted as time offset for time data 

and/or as frequency line for frequency data.
· For time data, the value in the block will be isolated which corresponds to the elapsed scan time 

(in seconds) since the start of the data block.
· For frequency data, the value in the block will be isolated at the incoming frequency line (Hz).

Statistics Modules
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 Histogram
 Module

This module calculates the histogram of an input signal.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: the number of classes as specified (plus fringe classes, if necessary)
Max. Number of Modules: any

This module divides the amplitude range up into n equal classes, and the number of samples with their 
amplitude values within each class will be counted.
For the definition of a histogram, you must specify an interval (Histogram Range) and the 
Number of Classes. In addition, you can provide two Fringe Classes for values below and beyond the 
range of values to be classified.

The histogram will be calculated for a group     of     blocks   if the number of blocks entered in the dialog box is
greater than one.
In addition, the output values can be normalized to a reference     value.  

Hint: For a convincing display of your histogram, try the Y/t     Chart   module and choose the Bar 
line     style.    To change the line style to Bar, chose the display menu in the chart display window 
and select Colors and Lines. In the Line Style box select Bar. The Y/t Chart will process 
histogram data automatically.

Attention: The output signals of a Histogram module cannot be combined with the output of most 
other modules, since they are neither time nor frequency related.

Module Installation and Configuration (General Hints)

Statistics Modules
Module Selection Menu



Histogram Range
In this dialog box you can specify the range and the classes for the division. Enter the amplitude range
here, which will be divided up into classes, and the number of classes.
Example: The interval from -5.0 to 5.0 is to be divided up into 10 classes.

The resulting 10 classes will be:
[-5, -4), [-4, -3), ..... [3, 4), [4, 5).

The left (lower) boundary value is always assumed to belong to the class, the right (upper) boundary 
value is already outside that class. In the example above, the first class will contain the values from -5 
(inclusive) to lower than -4; the second class will contain the values from -4 (inclusive) to lower than -3,
and so forth.
If two additional fringe classes are generated, they will cover all the values below and beyond the 
range. In the example above, the lower fringe class will contain all the values between -¥ and lower 
than -5, the upper fringe class will contain all the values between 5 (inclusive) and ¥.

Hint: For a convincing display of your histogram, try the Y/t     Chart   module and choose the Bar 
line     style.   The Y/t Chart will process histogram data automatically.

Histogram Module
______________________



Block Count Histogram

If a histogram of data over a long period is to be calculated, this option allows the specification of a 
certain number of blocks to group in one histogram. The number of blocks may range from 1 to 8,192.
Histogram Module
______________________



Normalization Histogram

The Normalization option allows the scaling of the Histogram module's results, so that the results of 
different measurements can be compared.

· If Normalization is enabled, the result can be scaled
· with respect to the Maximum of the histogram
· or with respect to the Total Sum of counted samples.
The histogram will be weighted with a factor so that the maximum or the total sum will be equal to the 
defined reference value.
Tip: If you want the result in a percent scale, set the sum value to 100. The resulting histogram will 

contain the percentage of samples in the specified classes.
· If Normalization is turned off, the result will simply be the number of samples in each class.

______________________



 Regression
 Module

This module will create an output signal which contains a signal with the linear regression line or with the
mean value of the input signal for each block.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

· The Constant Regression option calculates the mean of an input block and supplies a block of the 
same length with this constant at the corresponding output.

· The Linear Regression option calculates the linear regression line of a block and supplies a signal 
which represents this line at the corresponding output.

Module Installation and Configuration (General Hints)
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 Counter
 Module

This module provides different counting algorithms.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: 1, or same as input block size 
Max. Number of Modules: any

This module provides different options for counting events. These types of events can be counted:
function output value: the current number of ...
Blocks ... blocks
Samples ... samples
Positive Edges ... edges from TTL Low to TTL High, i.e. signal changes from below 0.8 to 

above 2.0
Negative Edges ... edges from TTL High to TTL Low
Duration High Level ... seconds since start with level above 1.5
Duration Low Level ... seconds since start with level below 1.5
· Additionally, specify the Count Mode:

· In Block Related mode, only the events in the current block will be counted.
· In Continuous mode, the count results will be calculated on the basis of all the data values that 

have been acquired by that channel since the beginning of the measurement.
· Use Output Mode to specify if the result is to be provided at the output

· as a Single Value for each block, or
· as a Block of the same length as the input signal, representing the current count for each sample.

Hint: Continuous values can be reset during an experiment by means of the event-driven actions.

Module Installation and Configuration (General Hints)
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Signal Analysis
 Module Group

This group consists of modules which perform frequency analysis.

Filtering

Correlation

Data Window

FFT

Polar / Cartesian
Module Selection Menu



 Filter
 Module

This module provides digital signal filtering with infinite impulse response filters.
In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

The filters in DASYLab are stable IIR filters with a very steep slope. These filters are used to cut off 
certain frequency components from the time signal. They are easy to implement and to use, but their 
disadvantage, as compared to analog filters, is that they cannot be used as anti-aliasing filters. Any anti-
aliasing filters would have to be applied before A/D conversion.

DASYLab provides several digital filters of different type, characteristics, and order, with adjustable cut-
off     frequency.  
· The transfer function of the filter is determined by the filter     type.   You can choose between lowpass and

highpass filters. Bandpass and bandstop filters can be created by using a combination of lowpass 
and highpass filters.
Additionally, you can switch off filtering without removing the module (no operation).

· The filter     characteristics   which can be selected are Bessel, Butterworth and Chebyshev with different 
ripples.

Module Installation and Configuration (General Hints)
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Filter Characteristics
· Bessel filters are characterized not only by small overshooting in their step response, but also by very 

low steepness.
· Butterworth filters are maximally flat, with an extremely small passband ripple and medium steepness. 

They show a strong overshooting in their step response, and their transfer function in the passband is 
nearly constant.

· Chebyshev filters have a defined passband ripple. Compared to the other types they have the greatest 
steepness. The ripple in the passband can be set to either 0.5 dB or 2 dB.
Filter Module
______________________



Filter Types
· Lowpass filters are important in many signal analysis applications. They cut     off   or damp high 

frequencies, while lower frequencies can pass the filter nearly unchanged.
Note: Digital lowpass filters cannot substitute analog anti-aliasing filters since aliasing is an effect of 

digitalization itself and not of the following analysis.
· Highpass filters work in just the opposite way of lowpass filters. They damp low frequencies and allow 

frequencies above the cut-off     frequency   to pass unchanged..
· Off: This switch turns digital filtering off without removing the filter module from the worksheet (no 

operation).

Filter Module
______________________



Cut-off Frequency
For all the filter     types,   the adjustable Cut-off Frequency defines the frequency at which the damping of 
the filter is exactly 3 dB. Damping beyond this frequency is dependent on the filter type and the 
defined order of the filter. The frequencies which can be entered here depend on the global 
sampling     rate.   Only frequency values within the following range can be set:

0.001 FN < fg < 0.9 FN.
FN is the Nyquist frequency, i.e. the sampling rate divided by two, and fg is the defined cut-off 
frequency. To avoid stability problems during calculation and application of the filters, DASYLab admits
a frequency range which is smaller than theoretically possible. If values outside this range are entered,
DASYLab will prompt with a message and turn off the filters completely. The measurement will not be 
interrupted.

Filter Module
______________________



Filter Order
The filter order defines the number of poles of the filter. Increasing the number of poles increases the 
steepness, but at the same time increases the phase shift.
The maximum order for lowpass and highpass filters is 10.

Filter Module
______________________



Quality Factor
This function is not implemented in this DASYLab version.

Filter Module
______________________



 Correlation
 Module

This module performs the calculation of correlation functions and coefficients as well as the application 
of the power cepstrum.

Since this module provides different basic operations, you must first select the function     type   when you
install the module.
This module provides two function types:
· Correlation Coefficient and Crosscorrelation
· Autocorrelation and Cepstrum

Up to 16 module entries can be activated.

Module Installation and Configuration (General Hints)
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Correlation Coefficient and Crosscorrelation
Input and Output Characteristics

Number of Inputs: up to 8 pairs
Input Block Size: any; the block sizes of pair members must be identical
Number of Outputs: same as number of inputs
Output Block Size: 1, or same as input block size
Max. Number of Modules: any

In the module configuration dialog box you can choose which of the two functions is to be applied to the 
signal of the selected channel.
· The Correlation Coefficient of the pair of input signals is a single value for each block, which always 

lies between -1 and 1.
· Values near 1 represent a good correlation; the input signals are of similar shape.
· Values near 0 mean that there is no correlation.
· Values near -1 represent a good anti-correlation.

· The result of Crosscorrelation is a full block for each signal input block. Each one represents the 
correlation function. The first value is equal to the correlation coefficient, the other values are the 
correlation coefficients for the periodically shifted signals. The time shift is used as the abscissa of the 
correlation function.

Correlation Module



Autocorrelation and Cepstrum
Input and Output Characteristics

Number of Inputs: up to 16
Input Block Size: any; the block sizes of pair members must be identical
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

In the module configuration dialog box you can choose which of the two functions is to be applied to the 
signal of the currently selected channel.
· Autocorrelation is the crosscorrelation of an input signal with itself; the same signal is used for both 

inputs.
With the Autocorrelation function it is possible to detect an inherent periodicity in the signal itself. High 
values represent a similarity of the signal with its shifted copy.
The Autocorrelation function is scaled so that its first value equals 1.
It is calculated as the inverse Fourier transform of the signal's power spectrum.

· The Cepstrum function is used to detect echoes or multiplicative superpositions in the signal, 
especially in speech analysis.
The Cepstrum function is scaled so that its first value equals 1.
It is calculated as the inverse Fourier transform of the signal's logarithmic power spectrum.

Correlation Module



 Data Window
 Module

This module prepares data for further analysis, especially by an FFT module.
In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as the defined vector     size  
Max. Number of Modules: any

This module prepares data for further analysis in two ways:
· It changes the block size so that an FFT module following after it can be provided with appropriate 

block sizes (powers of two).
The Windowing module represents a buffer which can store blocks or parts of blocks. The output block
size is independent from the input block size and equal to the defined vector     size.  

· It can weight the incoming blocks with different window functions. The effect of discontinuities at the 
edges of the analysis interval on the FFT result will be diminished by this weighting (leakage effect).

The following parameters can be set in the module configuration dialog box:
· DASYLab provides a number of different window vectors. Each of these is characterized by certain 

advantages and disadvantages which recommend it for special types of signals. There is no ideal 
general purpose window, and we can only provide some rough hints concerning their characteristics 
and suitability in our list of Window     Types.  
Generally speaking, a window vector damps the side lobes of singular spectral lines, which is a 
desired effect, but it also widens the main lobe, which is an unwelcome effect, since it reduces the 
spectral resolution and the dynamics of the spectrum.

· Some of the window types need an additional parameter for definition. This value is dependent on the 
window type itself. You will find further details in the comprehensive table of Window     Specifications.  

· In addition, you can activate Amplitude     Correction   in the dialog box.
· In the Overlap Adjustment box you can specify the overlap for an ensuing FFT. If the overlap is greater 

than 0, the defined number of samples will be included in the next block. This causes the module to 
release more data at its output channels than it receives at its input channels. Overlap is entered in 
samples.
The windowing is performed after overlapping. A reasonable value for the overlap is the block size 
divided by two. However, the decision which is the best value depends on the window function that is 
used.

Module Installation and Configuration (General Hints)
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Window Types
· Rectangle
· Bartlet (Triangle)
· Hamming
· Hanning
· Power of Cosine
· Blackman

· Blackman-Harris
· Tukey
· Poisson
· Hanning-Poisson
· Cauchy
· Gauss

Window Specifications
Window Module
______________________



Rectangle Window

This window type does not change the signal at all. 

Window Types
Window Module
______________________



Bartlet Window

This window type weights the signal block with a triangle function, i.e. a piecewise linear function 
which is zero at both ends of the block and 1 in the middle.

Window Types
Window Module
______________________



Hamming Window

This window type weights the signal block with a Hamming function. It may be regarded as a modified 
Hanning window. It is implemented as a cosine function with an offset of 0.08 and does not remove the
discontinuities completely.

Window Types
Window Module
______________________



Hanning Window

This window type weights the signal block with a Hanning function, i.e. a cosine square wave. This 
window corresponds to the power of cosine window with the parameter 2. It is one of the most 
frequently used windows with a well-balanced effect on the damping of the side lobes and the 
widening of the main lobe.

Window Types
Window Module
______________________



Power of Cosine Window

This is a generalization of the Hanning window. To define it completely, the exponent must be 
specified. Frequently used values for the exponent are 1, 2, 3, and 4. Increasing the exponent results 
in a weighting vector which decreases faster at the boundaries. The damping of the side lobes will be 
better, but the main lobe will be wider; so the frequency resolution of the spectrum may be lower.

Window Types
Window Module
______________________



Blackman Window

The Blackman window is a corrected Hamming window with an additional cosine term. It has a better 
damping of the side lobes than the Hamming window.

Window Types
Window Module
______________________



Blackman-Harris Window

This is a further refined modification of the Blackman window with cosine terms up to fourth order. In 
general, its effects are more balanced than those of the Blackman window, but it is more complex to 
calculate.

Window Types
Window Module
______________________



Tukey Window

The Tukey window is a combination of the rectangle and the power     of     cosine   windows. It does not 
influence the amplitude of the time signal in the middle of the transfer block, so the main part of the 
signal energy and of the information in the signal is preserved.
The necessary parameter may vary between 0 and 1. It defines the size of the constant part of the 
window vector. A parameter equal to 0 yields the cosine window, while a parameter equal to 1 results 
in a rectangle window.

Window Types
Window Module
______________________



Poisson Window

The defining function of the Poisson window is a two-sided exponential:

            ½n½ £ N/2
The parameter (a) determines the damping at the boundaries of the analysis interval. Reasonable 
values for a are between 1 and 10.

Window Types
Window Module
______________________



Hanning-Poisson Window

The defining function of the Hanning-Poisson window is the product of the two functions of Hanning 
and Poisson. Reasonable values for the parameter (a) are between 1 and 10.

Window Types
Window Module
______________________



Cauchy Window

The Cauchy window is calculated according to the formula

            ½n½ £ N/2.

Window Types
Window Module
______________________



Gauss Window

The basis of the Gauss window is the Gauss normal distribution function:

            ½n½ £ N/2
Reasonable values for the parameter (the deviation value a) are between 0 and 10.

Window Types
Window Module
______________________



Window Specifications
The following table lists some of the values characterizing the different window types.
Some of these window types need an additional parameter for definition. Its value depends on the 
window type itself.
(If this table is not completely displayed on the screen, please resize or maximize this Help window.)
Window
function

Para-
meter

side lobe
level
(dB)

side lobe
slope

(dB/Oct)

3 dB width of
main lobe
(multiples of
resolution)

amplitude
damping

Rectangle ----- -13 -    6 0.89 1.00
Bartlet ----- -27 -12 1.28 0.50
Hamming ----- -43 -    6 1.30 0.54
Hanning ----- -32 -18 1.44 0.50
Power of 
Cosine

1.00
2.00
3.00
4.00

-23
-32
-39
-47

-12
-18
-24
-30

1.20
1.44
1.66
1.86

0.64
0.50
0.42
0.38

Blackman ----- -58 -18 1.68 0.42
Blackman-
Harris

----- -92 -    6 1.90 0.36

Tukey 0.25
0.50
0.75

-14
-15
-19

-18
-18
-18

1.01
1.15
1.31

0.88
0.75
0.63

Poisson 2.00
3.00
4.00

-19
-24
-31

-    6
-    6
-    6

1.21
1.45
1.75

0.44
0.32
0.25

Hanning-
Poisson

0.50
1.00
2.00

-35
-39
-----

-18
-18
-18

1.54
1.64
1.87

0.43
0.38
0.29

Cauchy 3.00
4.00
5.00

-31
-35
-30

-    6
-    6
-    6

1.34
1.50
1.68

0.42
0.33
0.28

Gauss 2.50
3.00
3.50

-42
-55
-69

-    6
-    6
-    6

1.33
1.55
1.65

0.51
0.43
0.37

Window
function

Para-
meter

side lobe
level
(dB)

side lobe
slope

(dB/Oct)

3 dB width of
main lobe
(multiples of
resolution)

amplitude
damping

Window Module



Vector Size Window

The Window module can process signals of any input block size. The output block size will always be 
the defined vector size. Since this module is generally used in combination with the FFT module, 
which needs a power of two block size, these values are predefined. The vector size may vary 
between 16 and 8,192.

Attention: Any other vector size can be put in for purposes which do not need power of two value, 
but you cannot perform a FFT with these blocks.

______________________



Amplitude Correction Window

Since every weighting function except the rectangle has an integral less than one, its application 
causes lowering of the signals energy by a factor which equals its integral. If Amplitude Correction is 
switched on, this effect will be compensated by a multiplication of the spectrum with the same factor.

Window Module
______________________



 Fast Fourier Transform
 Module

This module provides various FFT functions to calculate and analyze the spectrum of a signal.

Since this module provides different basic operations, you must first select the function     type   when you
install the module.
This module provides four function types:
· Real FFT of a Real Signal
· Complex FFT of a Real Signal
· Complex FFT of a Complex Signal
· Cross Spectrum of Two Real Signals

For the Real FFT of a Real Signal type, a maximum of 16 module entries is available, a maximum of 8 
entries is available for Complex FFT of a Real Signal. Complex FFT of a Complex Signal and 
Cross Spectrum of Two Real Signals allow up to 8 pairs of module entries.

Attention: The Fourier transform as well as the algorithms based on it are very powerful but also 
complex tools for signal analysis. The easy-to-use implementation in DASYLab does not 
completely protect against erroneous results. Please read the general     remarks   regarding the 
FFT for further information.

Module Installation and Configuration (General Hints)

Signal Analysis Modules
Module Selection Menu



FFT: General Remarks
The Fourier Analysis is based on Fourier's theorem that every periodic signal can be decomposed in a 
series of harmonic functions. The methods included in this module allow the calculation and analysis of 
these frequency components.
The fast Fourier transform as well as the algorithms based on it are very powerful but also complex tools
for signal analysis. The easy-to-use implementation in DASYLab does not completely protect against 
erroneous results. The following essential conditions should be taken into account:
· Frequency Components in the signal and the Sampling Rate

This is a condition for every digitalization. The sampling rate must be at least twice as high as the 
highest frequency component in the analog signal (Shannon's theorem). Since this is a theoretical 
limitation for most applications, it is better to have a larger oversampling. In general, an oversampling 
of 5 to 10 is sufficient; otherwise amplitude errors may occur due to the digitalization, though the 
frequency detection may be correct.

· Limited Analysis Intervals
Every digital signal analysis method can only deal with a limited section of the time signal. The signal 
outside this section is always assumed to be a periodic continuation of that section. The length T of the
analysis interval determines the basic frequency:

If - as is generally the case - the time signal contains frequencies which are not an integer multiple of that 
frequency, these frequencies will not be identified as sharp spectral lines but be smeared to several lines. 
This is often called the leakage effect. The selection of a well-suited window     vector   can reduce this 
effect, but it will also lead to undesirable side-effects for the analysis, like the widening of the main lobe.

FFT Modules
Real FFT of a Real Signal
Complex FFT of a Real Signal
Complex FFT of a Complex Signal
Cross Spectrum of Two Real Signals

Signal Analysis Modules
Module Selection Menu



Real FFT of a Real Signal

This is a function to calculate and analyze the discrete spectrum of a signal.

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: must be a power of two
Number of Outputs: same as number of inputs
Output Block Size: same as input block size, or half of the input block size
Max. Number of Modules: any

DASYLab supplies several FFT-based     operations   in this function type. If necessary, the spectrum may 
be transformed into a dB     scale.  

Attention: The Fourier transform as well as the algorithms based on it are very powerful but also 
complex tools for signal analysis. The easy-to-use implementation in DASYLab does not 
completely protect against erroneous results. Please read the general remarks regarding the 
FFT for further information.

Signal Analysis Modules
FFT Modules
Module Selection Menu



FFT Operations
The following FFT-based algorithms are provided:
· Fourier Spectrum

The result is the two-sided amplitude spectrum of the signal. The output block size is the same as the 
input block size.

· Amplitude Spectrum
The result is the one-sided amplitude spectrum. In contrast to the Fourier Spectrum, each frequency 
component except the DC part is twice as large due to the summation of the symmetric frequencies. 
The output block size is half of the input block size.

· Power Spectrum
The power spectrum is the square of the Fourier Spectrum, but only one-sided. The output block length
is half of the input block length.

· Power Density Spectrum
The Power Density Spectrum differs from the Power Spectrum by a factor b representing the frequency 
resolution:

.
· Phase Spectrum

The result is the phase spectrum of the input signal. The output block size is the same as the input 
block size. The output signal is normed to 0 to 360º.

FFT Module



dB Transform FFT
If dB Transform is switched on, the resulting spectrum will be logarithmically transformed according to 
the formula

where x is the input signal and b is one of the following reference values:
· Definable Reference Value
· Maximum of the First Block
· Maximum of All Recent Blocks
· Maximum of the Current Block.

Attention: dB scales can only be compared if the reference value is the same for all the spectra. 
This is generally the case for a defined reference value and for the maximum of the first 
block, but not for the others.

FFT Module
______________________



Complex FFT of a Real Signal

This is a function to calculate and analyze the discrete spectrum of a signal.

Input and Output Characteristics
Number of Inputs: up to 8
Input Block Size: must be a power of two
Number of Outputs: twice the number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

A module of this FFT type provides two outputs for each input. The output signal contains the real 
component and the imaginary part of the FFT of the real signal.
In addition, you can choose the Complex Conjugate of the output signal, which means that for each input 
the imaginary part of the result will be multiplied by -1.
Up to 8 module entries and 16 outputs can be activated. The input block size must be a power of two; 
the output block size is the same as the input block size.
Attention: The Fourier transform as well as the algorithms based on it are very powerful but also 

complex tools for signal analysis. The easy-to-use implementation in DASYLab does not 
completely protect against erroneous results. Please read the general remarks regarding the 
FFT for further information.

Signal Analysis Modules
FFT Modules
Module Selection Menu



Complex FFT of a Complex Signal

This is a function to calculate and analyze the discrete spectrum of a signal.

Input and Output Characteristics
Number of Inputs: up to 8 pairs
Input Block Size: must be a power of two
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

A module of this FFT type provides two inputs and two outputs for each function. You can choose 
between Fourier Analysis and Fourier Synthesis.
In addition, you can choose the Complex Conjugate of the output signal, which means that for each input 
the imaginary part of the result will be multiplied by -1.
Up to 8 functions can be performed simultaneously in each module. The input block size must be a 
power of two at both entries; the output block size at the outputs is the same as the input block size.
Attention: The Fourier transform as well as the algorithms based on it are very powerful but also 

complex tools for signal analysis. The easy-to-use implementation in DASYLab does not 
completely protect against erroneous results. Please read the general remarks regarding the 
FFT for further information.

Signal Analysis Modules
FFT Modules
Module Selection Menu



Cross Spectrum of Two Real Signals

This is a function to calculate the cross spectrum of two signals.

Input and Output Characteristics
Number of Inputs: up to 8 pairs
Input Block Size: must be a power of two
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

A module of this FFT type provides two inputs and two outputs for each function. It calculates the cross 
spectrum of the two input signals. This means that the complex spectra are calculated for both input 
signals, and the first spectrum is multiplied with the complex conjugate of the second.
Up to 8 functions can be performed simultaneously in each module. The input block size must be a 
power of two at both entries; the output block size at the outputs is the same as the input block size.
Attention: The Fourier transform as well as the algorithms based on it are very powerful but also 

complex tools for signal analysis. The easy-to-use implementation in DASYLab does not 
completely protect against erroneous results. Please read the general remarks regarding the 
FFT for further information.

Signal Analysis Modules
FFT Modules
Module Selection Menu



 Polar/Cartesian Coordinates
 Module

This module converts a pair of input signal values defining a curve in Cartesian coordinates into polar 
coordinates and vice versa.

In the worksheet, this module can have up to 8 pairs of signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 8 pairs
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

Either of the following operations can be selected for each pair of module entries:
· Cartesian => Polar: conversion from Cartesian to polar coordinates
· Polar => Cartesian: conversion from polar to Cartesian coordinates

The first member of each input or output pair defines the real part or the amplitude respectively, the 
second member defines the imaginary part or the angle. Angles can be entered in degree (from -180 to 
+180) or radian values (from -p to +p).

Signal Analysis Modules
Module Selection Menu
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Control
 Module Group

This group consists of modules which perform control functions.

Signal Generator

Switch

Slider

PID Control

Time Delay

Setpoint

Latch

TTL Pulse Generator

Stop
Module Selection Menu



Real Time Output
This switch determines the time base at which data will be transferred to other modules.
Using Synchronization (in the Experiment     Setup   dialog box), you can specify whether the internal 
PC clock or the sampling rate generated by thy underlying Hardware is used as time base for all data 
generating modules (Generator, Slider, Switch, ...)
·  If Real Time Output is switched on, data is output in real time. A block is not sent to the next module 

until a full block of data values is ready. This period of time is calculated from the block     size   and the 
sampling     rate   as they have been specified in the Experiment Setup dialog box. Real time output only 
applies to slow data generation. It does not check whether data can be generated fast enough. In case
of pure simulation applications this is check is left to the user in order to provide him with the ability to 
change parameters online. In case of data acquisition applications i.e. if any hardware related module 
is used, timing problems are noticed by the driver interface and result in an appropriate error message 
and stop of measurement.
Example: block size     500

sampling rate 1000 Hz
A signal block will be output every 0.5 seconds.

· If Real Time Output is switched off, data will be provided at the output as fast as possible, i.e. as soon
as the next modules provide the necessary capacity. The time of experiment grows much faster than 
the time of day.
The signals will then be synchronized by the subsequent processing modules, if possible. On the other
hand it is possible to run an experiment in a kind of time-lapse mode with this setting.
To switch Real Time Output off is useful, for example, when data signals from a Generator module are 
to be delivered at a synchronousAnalog     Output.   Time synchronization is then done in the D/A module. 
The Generator module generates data signals quickly enough to provide them in sufficient numbers at 
the D/A module, and no time delay will occur at the output.

The speed of generating data depends on the hardware and on the complexity of the experiment setup.

Control Modules
Module Selection Menu



 Signal Generator
 Module

Depending on the selected function type, this module can generate up to 8 or 16 different standard 
signals simultaneously. In the worksheet it provides these signals to the other modules using its module 
outputs.

Since this module provides different basic operations, you must first select the function     type   when you
install the module.
This module provides four function types:
· Generator without Modulation,
· Generator with Frequency Modulation,
· Generator with Amplitude Modulation,
· Generator with Frequency and Amplitude Modulation.
You can install several Generator modules in one worksheet.

Module Installation and Configuration (General Hints)

Control Modules
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Generator without Modulation

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16
Output Block Size: same as the global block size
Max. Number of Modules: any

You can enter the following parameters separately for each channel:
· the channel     name,  
· the wave     form,  
· the signal     frequency,  
· the amplitude     and     offset   of the signal in Volts,
· the phase     shift,  
· the Output     in     Real     Time   mode.

Generator



Generator with Frequency Modulation

Input and Output Characteristics
Number of Inputs: same as number of outputs
Input Block Size: same as the global block size
Number of Outputs: up to 16
Output Block Size: same as the global block size
Max. Number of Modules: any

Each output channel is connected to one input channel which delivers the Frequency for each sample 
to be generated by that channel.
The setup for Frequency and the option Real Time Output are disabled, since the output rate is generated
from the incoming channel.
The input channel must contain normal time data without gaps. The value of the input signal is used to 
determine the frequency of the generated waveform.

You can enter the following parameters separately for each channel:
· the channel     name,  
· the wave     form,  
· the amplitude     and     offset   of the signal in Volts

Attention: Since the module computes a phase correction every time the frequency changes, it takes 
some computation time to modulate the generator with a fast changing signal.

Generator



Generator with Amplitude Modulation

Input and Output Characteristics
Number of Inputs: same as number of outputs
Input Block Size: same as the global block size
Number of Outputs: up to 16
Output Block Size: same as the global block size
Max. Number of Modules: any

 Each output channel is connected to one input channel which delivers the Amplitude for each sample 
to be generated.
The setup for Amplitude and the option Real Time Output are disabled, since the output rate is generated 
from the incoming channel.
The input channel must contain normal time data without gaps.

You can enter the following parameters separately for each channel:
· the channel     name,  
· the wave     form,  
· the signal     frequency,  
· the offset of the signal in Volts
· the phase     shift,   

Generator



Generator with Frequency and Amplitude Modulation

Input and Output Characteristics
Number of Inputs: twice the number of outputs
Input Block Size: same as the global block size
Number of Outputs: up to 8
Output Block Size: same as the global block size
Max. Number of Modules: any

 Each output channel is connected to two input channels which deliver the Frequency (first input 
channel) and the Amplitude (second input channel) for each sample to be generated.
The setup for Frequency and Amplitude and the option Real Time Output are disabled, since the output 
rate is generated from the incoming channel.

The input channels must contain normal time data without gaps and with the same sampling rate on 
each of two corresponding channels. The value of the input signal is used to determine the frequency of 
the generated waveform.

You can enter the following parameters separately for each channel:
· the channel     name,  
· the offset of the signal in Volts
· the wave     form,   

Attention: Since the module computes a phase correction every time the frequency changes, it takes 
some computation time to modulate the generator with a fast changing signal.

Generator



Wave Form Generator

The Generator module provides several wave forms for standard signals.
Function The generated signal is a ...
Sine: ... sine wave of defined frequency, amplitude, offset, and phase     shift  
Square: ... square wave of defined frequency, amplitude, offset, and phase shift
Triangle: ... triangle wave of defined frequency, amplitude, offset, and phase shift
Saw Tooth: ... saw tooth wave of defined frequency, amplitude, offset, and phase shift
Pulse: ... periodic one-sample impulse of defined frequency, amplitude, offset, and phase shift
Noise: ... noise signal of defined maximum amplitude and offset
Constant: ... constant signal of defined offset
Generator



Frequency Settings Generator

This parameter determines the frequency of the generated signal. The input must be entered in Hertz.
The time resolution, the number of samples per period, is determined by the ratio between the global 
sampling     rate,   which can be specified in the Experiment     Setup   dialog box, and the frequency specified
here.
Example: global sampling rate: 1000 Hz

signal frequency:         10 Hz
number of samples per period = 1000 / 10 = 100 samples

Since signal generation in this module is the digitalization of a mathematical function, the Shannon 
theorem applies as well as in a data acquisition process. If the signal frequency is too high for proper 
digitalization, a warning message will appear.

Generator



Amplitude and Offset Generator

These parameters determine the amplitude range of the generated signal.

Depending on the defined wave     form,   the amplitude of the signal will be within either of the following 
ranges:

· Offset minus Amplitude to Offset plus Amplitude
· Offset to Offset plus Amplitude

A negative amplitude will cause the wave form to be inverted, for example, a pulse with a negative 
amplitude may be generated.
There are no restrictions on either of these values, but they should be set with care regarding further 
calculations.

Generator
______________________



Phase Shift Generator

This parameter determines the phase shift for periodic signals in degrees. Admitted values are 
between 0º and 359º.
A sine with a phase shift of 90º is a cosine.

Generator
______________________



 Switch
 Module

This module can generate up to 8 TTL compatible signals. These signals can be switched on and off.

In the worksheet, this module can have up to 8 signal     outputs.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 8
Output Block Size: same as global block size
Max. Number of Modules: any

This module generates a TTL compatible signal at each of its outputs. In a separate operation window, 
the output can be switched manually between low and high, or it can be set to high for the duration of 
one block.
Combined with a Relay module or a Digital     Output   module, the Switch module can be used to control 
applications and for manual operations in the course of the measurement.

Each module of this type provides an additional operation     window   for manipulation. That window is 
initially provided as an icon at the bottom of the desktop when the module is inserted into the worksheet.
Double-click this icon to open the operation window; then the switches can be used.

Module Configuration
In the module configuration dialog box you can enter the following parameters separately for each 
channel:
· Switch Type

Each channel can be operated as either an On/Off Switch or as a One Shot Switch.
· Real Time Output

Operation Window
The operation window contains (depending on the Switch Type) one or two buttons for each activated 
channel. Beneath the button(s) you will find a display of the actual status of the channel: ON or OFF.
· In the On/Off Switch mode, the signal can be set to TTL High or TTL Low with the two corresponding 

buttons.
· In the One Shot Switch mode, the signal can be set to TTL High for one block of data; after that it will 

automatically be reset to TTL Low again.
To initialize the state of the channel you can click on the buttons in the operation window. However, 
ouput will only be generated while the experiment is running.

> You can integrate several Switch modules in one worksheet. Each of them has its own module     name,   
which is shown ...
· below the icon representing the minimized operation window, and
· in the title bar of that window when it is activated.
Thus the Switch operation windows can be easily identified.

> The function     bar   icons and menu commands to open, minimize and arrange the display windows of 
the Display modules also affect Switch operation windows.

Click here for a survey of these special features.

Module Installation and Configuration (General Hints)
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 Slider
 Module

This module generates up to 16 signals of amplitudes that can be manually modified.

In the worksheet, this module can have up to 16 signal     outputs.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16
Output Block Size: same as global block size
Max. Number of Modules: any

This module generates a signal of adjustable amplitude at its output. The output amplitude can be 
adjusted manually in a separate operation window; the overall range of the amplitude is defined by the 
limiting values entered in the module configuration dialog box.

Each module of this type provides an additional operation     window   for manipulation. That window is 
initially provided as an icon at the bottom of the desktop when the module is inserted into the worksheet.
Double-click this icon to open the operation window; then the slide controls can be used.
The slide controls can be operated using the scrollbar.

Module Configuration
In the module configuration dialog box you can enter the following parameters separately for each 
channel:
· Min. Value / Max. Value

These two entries determine the output range the slider can generate on the selected channel.
· Resolution

Define the resolution of the slider, the number of steps between the minimum and the maximum value.
With a resolution of 100, each click on the upper or lower button in the slider changes the output signal
about 1%. You can define a resolution from 2 to 9,999 steps.

· Real Time Output

Switches
· Options

If there is more than one active channel in the Slider module you can setup the display of the operation
window. You can determine the Number of Rows in the table of the sliders in the operation window and 
you can choose to display With Channel Name.

· Colors
Click this button to setup the colors for all the parts of the operation window.

· Font
Click this button to select the font type and style for the channel     name.   The font size will be computed 
based on the size of the operation window.

Operation Window
The operation window contains one slider and one edit control for each activated channel.
· Use mouse or keyboard to control the slider. (First the slider must get the input focus by clicking on it 

with the mouse.)
· Or you can type the output value in the edit box below the slider.
If an experiment is running, the Slider output changes according to your selection and the value is 
displayed in the edit control.

> You can integrate several Slider modules in one worksheet. Each of them has its own module     name,   
which is shown ...



· below the icon representing the minimized operation window, and
· in the title bar of that window when it is activated.
Thus the Slider operation windows can be easily identified.

> The function     bar   icons and menu commands to open, minimize and arrange the display windows of 
the Display modules also affect Slider operation windows.

Click here for a survey of these special features.

Module Installation and Configuration (General Hints)
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 PID Control
 Module

This module implements a PID control algorithm.

In the worksheet, this module can have up to 8 pairs of signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 8 pairs
Input Block Size: any, but the same for each pair
Number of Outputs: number of inputs divided by 2
Output Block Size: same as input block size
Max. Number of Modules: any

The PID module can calculate up to 8 control signals depending on the corresponding setpoint and the 
current value. For each pair of module entries, the first (upper) entry denotes the setpoint, and the lower 
entry denotes the actual measured value from the controlled system. The output signal of the PID 
module depends on the parameter values specified for the Proportional, Integral and Derivative 
(P     /     I     /     D)     components.  

The output signal can be limited to avoid instabilities. If Control     Limitation   is enabled, the output signal 
will be bounded by the values defined as Maximum and Minimum.

Attention: The PID control block should be used with small block sizes because the control only 
affects subsequent blocks.

Module Installation and Configuration (General Hints)
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P / I / D    Components
The output of the PID module consists of these three components:

· P PID proportional control constant
· I PID integral mode gain constant
· D PID derivative mode gain constant.

The output signal combines these three components according to the following formula:
output = P_comp * DIFF + I_comp * Integral(DIFF) + D_comp * Derivative(DIFF),
where DIFF denotes the difference between the setpoint and the measured value and 
P_ / I_ / D_comp denotes the parameters defined for each of the three components.
______________________



Control Limitation PID

If Control Limitation is enabled, the values specified as Minimum and Maximum will be used as the 
lower and upper limits for the output of the PID module. Values outside these boundaries will be cut to 
the corresponding boundary values.
This feature can be used to avoid instabilities during the control process.
______________________



 Time Delay
 Module

This module generates a time delay in the signal flow by preceding the incoming signal with an 
adjustable number of blocks of zero values. After these initial blocks, the delayed data will be transferred
unchanged.

This module is not included in the basic version.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: same as global block size
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This module delays the incoming signal for an adjustable number of blocks. The delayed part of the 
signal is stored in this module and passed on to the output n blocks later. The first n blocks are filled with
zero values. This module is necessary if an application requires closed data loops.

Module Installation and Configuration (General Hints)
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Setpoint 
Module

This module generates up to 16 TTL signals. Every module can process 8 or 16 signals at once. 

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: 8 (Signal / Signal) or 16 (Signal / Level)
Input Block Size: same as global block size
Number of Outputs: 1 Number of Inputs(Signal/Level) or 2 Number of Inputs(Signal/Signal)
Output Block Size: same as input block size
Max. Number of Modules: any

The module works as comparator with two different operation modes.
· The output signal switches to high, if the inputs signal amplitude exeed a level. The level must be set    

to a static value and cannot be changed during measurement.
· The output signal switches to high, if the inputs signal amplitude (X) exeed anothers inputs signal 

amplitude (Y). The comparation (X>Y or X<Y) cannot be changed during acquisition.

The setpoint module can generate ttl like output signals (high = 5V, low = 0V). The levels high and low  
and may be adapted to other binary output level conventions. 

Control Modules
Module Selection Menu



 Latch
 Module

This module passes an input channel through or keeps the last data value (with constant output) - 
depending on the state of the control signal.

Integrated into the worksheet this module can process up to 8 data     channel     pairs.  
Using the Channel     Bar   you can specify the number of channels and the channel pair to be set 
(selected channel pair).

Input and Output Characteristics
Number of Inputs: up to 8 pairs (1 data input and 1 control input)
Input Block Size: same as global block size
Number of Outputs: up to 8 (same as input pairs)
Output Block Size: same as input block size
Max. Number of Modules: any

This module provides one data input and one control input per channel for each data output. The upper 
one of the two inputs is the control input and the lower one the data input.
· If a TTL high level (5 Volts) is present at the control input the data at the data input is simply passed 

through.
· If a TTL low level (0 Volt) is present at the control input, the last data value (at which the control input 

was at High level) is latched as long as the Low level signal is present.

At the beginning of the measurement TTL low is output until the control input is set to TTL high level the
first time.

Control Modules
Module Selection Menu



 TTL Pulse Generator
 Module

This module can generate TTL compatible signals according to the defined duty cycles.

In the worksheet, this module can have up to 16 signal     outputs.  

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16
Output Block Size: same as global block size
Max. Number of Modules: any

The module generates TTL compatible signals with definable low and high phases. TTL high equals 5, 
TTL low equals 0. Similar to the Generator module, this signal is provided at the global block     size   and 
sampling     rate.  
· Using the durations defined as Phase 1 and Phase 2, the low and high cycles will be generated. The 

phase durations can be defined in seconds, minutes, or hours.
· The Start/Stop switch determines whether Phase 1 is to be high or low.
· If a value is entered for the Stop after ... Cycles option, signal generation will be stopped after the 

entered number of cycles. If no value is entered or if it is 0, the time slice will run continuously.

Module Installation and Configuration (General Hints)

Control Modules
Module Selection Menu



 Stop
 Module

This module can pause or stop the entire measurement if certain predefined conditions are fulfilled.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: ---
Output Block Size: ---
Max. Number of Modules: any

This module can pause or stop a running measurement following conditions dependent on the data 
values. The effect is the same as pausing or stopping the measurement using menu commands or their 
corresponding function     bar   icons.

Action determines whether the measurement is to be paused or stopped.

The action itself will be performed as soon as the defined conditions are fulfilled:
· Blocks after the defined number of data blocks (entered as Parameter)
· Samples after the defined number of samples (entered as Parameter)
· secs / mins / hrs after the defined time (entered in the selected unit as Parameter)
· Low Level at a TTL low level of 0.8 (no Parameter necessary; same as Below Limit with 

Parameter set to 0.8)
· High Level at a TTL high level of 2.0 (no Parameter necessary; same as Exceeding Limit with 

Parameter set to 2.0)
· Below Limit if signal values fall below the defined level (entered as Parameter)
· Exceeding Limit if signal values exceed the defined level (entered as Parameter).
· Never The action will not be performed at all (no operation). (no Parameter necessary)

Module Installation and Configuration (General Hints)

Control Modules
Module Selection Menu



10.12.94



Display
 Module Group

This group consists of modules which display or present data.
Each module from this group provides an additional display window to display the data.

Y/t Chart

X/Y Chart

Chart Recorder

Analog Meter

Digital Meter

Bar Graph

Status Lamp

List Display
Special Display Module Features
Customizing the Display Windows
Module Selection Menu



Display Modules
The modules of the Display module     group   differ from other modules. After selecting a Display module 
from the Module menu or the module     bar,   it appears with two elements: a worksheet symbol on the 
worksheet and an icon at the bottom of the screen.

· The worksheet symbol is integrated into the worksheet and connected to the other modules by 
data     channels,  

· The icon represents a separate window, which you must restore (or "open") whenever you wish to 
use the display function during an experiment.
· The display windows present data blocks in a graphical or numerical way.
· The display windows of some Display modules have separate menu systems to select display 

options or functions.
· While the experiment is running, some of these display options can be influenced by Event-

driven     Actions   if a specified event occurs.
· The text and numerical value format of the display windows is basically determined by the 

International     Settings   as specified in the Windows Control Panel.

You can integrate several Display modules of the same type in one worksheet. Each of them has its 
own module     name   for easy identification.

Customizing the Display Windows
______________________



 Y/t Chart
 Module

In a separate Y/t     Chart     Display     Window,   this module displays blocks of data as time or frequency 
dependent curves.

In the worksheet, this module can have up to 16 signal     inputs.  

Click here for a survey of special display     module     features.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: none or same as inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This module is most useful for displaying fast data, since it always processes at least one complete 
block of input signals to display at one time. Using it with very slow signals may cause long acquisition 
pauses. For slower data inputs, the Chart     Recorder   module would be more appropriate.

Module Configuration

Global Settings
These settings apply to all activated channels.
· You can specify the Display     Width   and X (Time) Scaling.
· If Auto Scaling is selected (in the Display menu of the display     window  ), all values of the data block are 

tested for maximum and minimum values before they are displayed. The chart is scaled and displayed 
using these values.
Use this function to ensure that peaks will be displayed regardless of value.
Note that the scaling can change continuously and will slow down the display speed.

· Set Zooming Options to constrain how zooming expands the display area:
· X and Y Direction

The display area is expanded exactly as selected.
· Only X Direction

The display area zooms only in horizontal direction as selected. The scale of the Y axis remains 
as defined.

· Only Y Direction
The display area zooms only in vertical direction as selected. The scale of the X axis remains as 
defined.

· The number of curves to be displayed can be chosen using the channel     bar.  
· The option Copy     Inputs     to     Outputs   provides the module with one output for each activated input 

channel. Incoming data is provided unchanged at the output.

Channel Specific Settings
These settings apply to the selected channel only.
· The switch Display Channel activates or deactivates the display of the currently selected channel.
· The Unit and Amplitude     Scale   can be specified.
· If you choose the logarithmic scaling, the Y axis is scaled using a logarithmic scale. Use this option, for

example, to display FFT data channels.



Display Window
The data values from all the module entries will be displayed in a display     window   tagged with the same 
module     name.   TheY/t     Chart     Display     Window   can be opened by double-clicking its icon at the bottom of 
the desktop.
The global parameters for the display can be entered in the module configuration dialog box. These
parameters define the scaling of the X (time) axis and the types of X axes, as well as curve-dependent 
values including amplitude scaling and the selection of units.
The number of curves to be displayed can be chosen using the channel     bar.  
Some of these parameters may also be modified in the display window menu     system.   These menus 
offer several additional display options, including the selection of colors, fonts or line styles. In 
addition, all the necessary commands for interactive graphical analysis of curves, like zooming or 
measuring cursors, are available.

Attention: DASYLab distinguishes between different types of data: time-dependent, frequency 
dependent, histogram, continuous, or triggered data. Signals of different types cannot be 
displayed simultaneously in one Y/t Chart display window.
If your experiment setup yields data signals of different types which you wish to display, use 
at least one Y/t Chart module for each type.

Module Installation and Configuration (General Hints)

Customizing the Display Windows

Display Modules
Module Selection Menu



Y/t Chart Display Window
This is the display     window   associated with the Y/t     Chart   module.
It can display up to 16 signal curves simultaneously in one chart.
The data values are always displayed in blocks. As soon as a new block is complete, the previous 
display is deleted and the new values are displayed.
The display style and interactive graphic commands can be chosen from the menu or the function bar.

Axes

Time Scale

Y Scale

Scaling Options

Display

One Chart

Mutiple Charts

Only Curves

Waterfall

Setup Waterfall

Colors and Lines

Font Style

Copy to Clipboard

Print

Grid

Function Bar

Display Y Unit

Show Legend

Show Header

Setup Legend

Setup Header

Survey

Freeze

Continue

Zoom

Unzoom

Cursor

Extended

Horiz.Cursor



Text

Show

Edit New Text String

Delete All Text Strings

Font, Color and Frame

Customizing the Display Windows

Y/t Chart Module



Time Scale Y/t Chart

These settings modify the scaling options for the X axis of the diagram.
All the displayed curves use one joint X axis. It may be chosen either from the module configuration 
dialog box of the Y/t     Chart   module or from the menu or function bar of the corresponding Y/t     Chart   
display window.

These options for scaling the X axis are available:
· Running Time Scale

This option sets the X axis labeling to seconds, minutes and hours from the start of the measurement. 
The X axis will be updated for each block.

· Fixed Time Scale
This time scale uses the internal time scale of each displayed block. The axis will be the same for each
block starting at 0.

· In addition, the duration of the interval to be displayed at one time can be specified in the dialog box. 
The input can be switched between blocks and seconds.
The default is the display of exactly one block.
· If the length is entered in blocks, the corresponding number of blocks will be collected and 

displayed simultaneously.
· If the length is entered in seconds, data will be collected and displayed according to the defined 

time.
If the display interval is too short to contain more than one sample, every sample will be displayed as a
straight horizontal line.

You can switch between the scaling options while the experiment is running.
The maximum number of samples which can be simultaneously displayed in one curve is 60,480.
Note: While a minimum limit does not exist, only one line for every sample is drawn if the chosen 

display width is less than or equal to the sampling rate of a data channel. The maximum setting 
depends on the sample distance of the display channels. A maximum of 60,480 data values per 
channel can be displayed. The experiment stops with an error message if the number of blocks 
or time specification is too large, causing more than 60,480 data values to be displayed.

Y/t     Chart     Display     Window  



 Amplitude Scaling
Choose this command to define the scale ranges for each curve.
· The left part of the dialog box displays the channel list. Each channel activated in the 

module configuration dialog box is represented as Input X (X denoting the number of the activated 
channel).
In that list, select (highlight) the channel whose settings you wish to modify.

> For X/Y Charts, only every second input is offered for selection, as only these inputs are scalable in the 
Y direction.

· The boxes on the right of the dialog box display the scaling parameters for the highlighted channel.
The values for the Lower and Upper Limits, the Channel     Name   and the channel Unit can be entered in 
these boxes.

· If you deactivate Display Channel, that curve will not be drawn, and the drawing area for that curve will 
remain empty (although signals are correctly received at the module input). If you have selected that 
channel's scale to be displayed, it will still be provided in the display window in the One     Chart   mode 
(although none of the traces actually drawn might really refer to it).
If you choose the logarithmic scaling, the Y axis is scaled using a logarithmic scale. Use this option, for
example, to display FFT data channels.

> If only one Y scale, but several channels are displayed in one Y/t Chart module, you can select a single
channel to display its scale by clicking the left mouse button inside the corresponding color or legend 
area (fast switch).

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  



 Scale Assignment
Use this dialog box to determine how many scales, and which ones, are to be provided in the display 
window.
These settings affect multi-trace display, where more than one channel has been activated for display. 
Only the One     Chart   mode will be affected, unless you turn scaling off completely.
Up to four different amplitude scales can be assigned for each display window. These scales can be 
related to the inputs which are to be displayed. The scaling boundaries of these curves are then 
displayed on the related scales.

In the Multiple     Charts   mode, an appropriate scale (derived from the display range values in the 
Amplitude     Scale   dialog box) will always be placed next to the curve display to which it belongs.
In the One     Chart   mode, no more than four different scales can be activated (to leave enough space for 
the drawing area). The scales will be arranged next to each other on the left and on the right of the 
drawing area for the concentrated traces.
· The left part of the dialog box displays the channel list. Each channel activated in the 

module configuration dialog box is represented as Input X (X denoting the number of the activated 
channel).
In that list, select (highlight) the channel you wish to assign to a scale. (Note that those already 
assigned cannot be reused.)

> For X/Y Charts, only every second input is offered for selection, as only these inputs are scalable in the 
Y direction.

· Then press one of the four arrow buttons on the right. At first, you must assign the scales in ascending 
order. But once they have been assigned a channel from the list, you may change any entry anytime.

· To turn a scale off, choose Off in the channel selection list and "assign" it to that scale. You can only 
turn the last of the assigned scales off. If you turn them all off one by one, no scale will be displayed.

Attention: A scale selected here will be displayed even if the associated graph is not displayed 
because you have deactivated Display Channel in the Amplitude     Scale   dialog box.

Attention: As a consequence of the restriction of four scales in the One Chart mode, there may be 
traces drawn in the drawing area for which exact scaling is not possible, as their 
corresponding scales cannot be displayed. Their values may differ considerably from the 
values which those scales suggest that are displayed.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  



One Chart / Multiple Charts

One Chart / combined diagram of all the traces

Multiple Charts / individual diagram for each of the traces
· In the One Chart mode, all the curves will be displayed in one combined diagram. The individual traces 

may cross each other.
· The advantage of this mode is that maximum resolution of the amplitude is available for each 

curve.
· Its disadvantage may be that the diagram becomes confused and that not every scale will be 

displayed.
· In the Multiple Charts mode, each curve is assigned its own area in the display window. This enhances 

the clarity of the display, but the resolution of the amplitudes may be poorer.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
______________________



Only Curves
This command enables you to turn off the scale display and to display just the curves.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
______________________



 Waterfall Display
This command switches the Waterfall mode on or off.
Instead of being completely deleted after each block, the traces are shifted slightly to the upper right, 
and the trace for the new block will be added to the diagram. As a result, the individual blocks will create 
a waterfall display of the whole signal.
Waterfalls cannot display more than one signal. If the Waterfall switch is used in a diagram with more 
than one signal, only the first will be displayed.
The shape of the waterfall display can be modified by choosing the Setup Waterfall command.
· Number of Stored Blocks

The number determines how many blocks or traces in the waterfall display will remain in the buffer 
memory for the reconstruction of the display when the window must be redrawn. (For example, 
redrawing is necessary whenever the window is resized and whenever an overlapping window is 
closed.)

· Remove Hidden Lines
If this flag is set, the waterfall will be drawn without hidden lines. Removing hidden lines intensifies the 
3D effect of the diagram.

· X Shift Offset
Previous curves will be shifted to the right according to this parameter.

· Y Shift Offset
Previous curves will be shifted upwards according to this parameter.

Y/t     Chart     Display     Window  



 Colors and Lines
In this dialog box, you can modify the colors and line styles for all the elements of the display window.
To modify the settings for an object, the object must be first selected in the Object List. Depending on 
the object type, different options are available.
Click on the Color button to open the Windows color definition box for the selected object.
To modify the Line Style and Thickness of the actual traces, first select these items from the list; they 
are always represented as Input X (where X is the number of the activated channel).

> You can choose all the colors of the display window elements directly. Press the right mouse button 
inside a display element to open the color selection box.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
______________________



 Font Style
This command opens the Windows dialog box for font styles, where you can select the font and 
font style (plain, bold, or italics) as well as the font size.
These settings apply to the scales and to the displayed units (if they are to be displayed).

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
______________________



 Grid
This switch toggles the display of a grid in the diagram. The Color and Line Style of the grid can be 
selected in the Colors     and     Lines   box.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
______________________



Function Bar
The function bar displays icons which provide easy access to frequently used functions and options 
from the display window menus. Just click on the icon representing that function.
All the commands represented on the function bar are also available from the menus.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
List     Display     Window  
______________________



Display Y Unit
If this flag is set, the corresponding unit of each channel will be displayed in the list or chart.

· In a List     Display,   the unit is displayed underneath the channel     name.  
· In a Chart     Display,   the unit is displayed above the Y axis.

For displays with several charts, multiple     charts   mode will usually be more suitable.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
List     Display     Window  
______________________



Show/Hide Legend
The Legend function displays the channel     name   and the unit at the left bottom of the window. If the 
legend is hidden, only the channel numbers are displayed.
The Setup Legend menu function changes the display characteristics of the legend.

· The Font setting changes the font, style and size of the font. These settings determine the height and 
width of the legend area.

· The Color setting changes the color of the legend text.
· The Unit setting shows or hides the chosen unit after the channel name.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
______________________



Show/Hide Header
The Header function shows or hides an additional text area at the top of the display window.
The Setup Header menu function changes the display characteristics of the legend text.

· The Text menu function allows you to edit the text string of the header.
· The Font setting changes the font, style, and size of the font. These settings determine the height and 

width of the legend area.
· The Color setting changes the color of the header text.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
______________________



 Copy to Clipboard
This command copies the contents of the window to the Windows clipboard. The curve or list will be 
copied including scaling information. The background color will be maintained (except for 
List     Displays  ).
From the Windows clipboard, you can paste the diagram or list into other Windows applications or 
documents, including PaintBrush and Word for Windows. To do so, choose the appropriate command 
from the target application menu (usually Paste from the Edit menu).

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
List     Display     Window  
______________________



 Print Display Window Contents
Choose this command to print the contents of the current window on the default Windows printer.
On black and white printers, the background color will be ignored, and all objects will be printed in 
black.
> Choose Page     Format   from the File menu to select additional information to be included in the 

printing and to specify the page layout and page frames.
> Choose Printer     Setup   from the File menu to select paper size and paper source, orientation, printer 

resolution, and specific settings for your active printer model.
> To activate a different printer model connected to your system, or to install and configure a new 

printer, choose the Printers option in the Windows Control Panel. Please refer to your Windows 
documentation for further information.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
List     Display     Window  
______________________



 Freeze Display Window
This function freezes the current display. Although the measurement is continued, the diagram or list 
will not be updated until Freeze is turned off.
The Continue function unfreezes the display window.
This function is useful for detailed visual analysis with measuring     cursors,   or before zooming is 
performed.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
List     Display     Window  
______________________



 Continue
This function continues the display in a frozen display window. The current data will be displayed 
again.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
List     Display     Window  
______________________



Zoom / Unzoom

Zoom

Unzoom
· When the Zoom button is pressed, a zoom cursor appears, and a zoom window can be defined in the 

diagram area by pressing the left mouse button and dragging the cursor.
The coordinates of the zoom window will be used as the new boundaries for the axes.
Zooming can be performed several times.

· Unzooming is independent of freezing.
Unzooming always returns to the original scaling. You cannot unzoom in steps, even if you zoomed in 
steps.
Continuing a frozen and zoomed display will not unzoom it.

· Zooming Options can be specified in the Y/t     Chart   configuration dialog box. You can constrain zooming
to Only X Direction, Only Y Direction, or X and Y Direction.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
______________________



 Measuring Cursor
This command inserts two measuring cursors into the diagram and opens a cursor window. The cursors 
can be positioned by dragging them with the mouse or by using the cursor keys of the keyboard.
The cursor window displays the current cursor values. If several traces are drawn in the display window, 
the cursor window offers a channel selection field.
· If the Extended Cursor mode is selected from the menu, additional calculated values will be shown.
· If Horizontal Cursors is selected from the menu, two horizontal cursors will be inserted in the display 

window in addition to the two vertical cursors.
· These values are always displayed in the cursor window:

Yn the amplitude value under cursor n (n can be 1 or 2)
tn the time corresponding to the position of cursor n
dt the time difference between the two cursors
f the frequency between the two cursors.

· The following additional values are only displayed in the Extended Cursor mode:
dY the difference between the amplitude values
dY/dt the mean slope between the cursor positions
Min/Max the minimum and maximum of the interval between the cursors
Integral the integral of the curve between the cursors
RMS the Root Mean Square value between the two cursors.

Y/t     Chart     Display     Window  
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Text
This function allows you to place up to 20 text strings onto the display window for documentation - such 
as before copying     to     the     clipboard   or before printing.
· Activate the option Show in the Text menu. You can now create a text string. You can freeze the chart, 

if desired, and you can also edit while the experiment is running.
· Choose Edit New Text String in the Text menu. Click the left mouse button at any place in the window. A

separate dialog box appears, where you can enter the text string (up to 50 characters).
Press the OK button and the new text will appear inside the display window.
You can change the text position by clicking the left mouse button and dragging the text to any place in
the window.
Up to 20 text strings can be created.

· The appearance of the text string can be configured with the menu functions Font, Color and Frame.
· Print the chart with all text strings now, or copy it into the clipboard, freeze and unfreeze the display 

window or move the text strings, and so on.
· You can hide all the text strings by deactivating the menu function Show in the Text menu. The text 

strings are not deleted by hiding them.
· You can delete all text strings by choosing the menu function Delete All Text Strings in the Text menu.
· The text strings are not saved with the worksheet.

Y/t     Chart     Display     Window  
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Format Text
The Text menu provides functions to change the display characteristics of the
Text  strings in a display window.

· The Font setting changes the font, style, and size of the font. These settings determine the height and 
width of the Text string rectangle.

· The Color setting changes the color of the    text.
· The Frame menu function surrounds the    text with a simple frame.
· For a 3D effect, activate the menu function 3D Frame.
· After you activate the Frame function, you can change the Frame Color.

Y/t     Chart     Display     Window  
X/Y     Chart     Display     Window  
Chart     Recorder     Display     Window  
______________________



 X/Y Chart
 Module

In a separate X/Y     Chart     Display     Window,   this module displays blocks of two dependent signals as an 
X/Y plot.

In the worksheet, this module can have up to 8 pairs of signal     inputs.  

Click here for a survey of special display     module     features.  

Input and Output Characteristics
Number of Inputs: up to 8 pairs
Input Block Size: any
Number of Outputs: ---
Output Block Size: ---
Max. Number of Modules: any

This module displays blocks of two dependent signals as an X/Y plot. The data values are displayed as 
complete data blocks.

Module Configuration

Global Settings
These settings apply to all activated channels.
· You can configure the scaling of the X     axis   and the Y     axis.  
· Use the display option Delete Curves after n Blocks to display more the one data block in a window, 

without deleting previous curves. The display window is reset before displaying the n+1st curve.
· The X Unit and X     Scale   can be specified.
· If you choose logarithmic scaling, the Y axis is scaled using a logarithmic scale.
· The option Copy     Inputs     to     Outputs   provides the module with one output for each activated input 

channel. Incoming data is provided unchanged at the output.

Channel Specific Settings
These settings apply to the selected channel only.
· The switch Display Channel activates or deactivates the display of the currently selected channel.
· The Unit and Amplitude     Scale   can be specified.
· If you choose the logarithmic scaling, the Y axis is scaled using a logarithmic scale. Use this option, for

example, to display FFT data channels.

Display Window
The data values from all the module entries will be displayed in a display     window   tagged with the same 
module     name.   The X/Y     Chart display     window.  can be opened by double-clicking its icon at the bottom of 
the desktop.
Some of these parameters may also be modified in the display window menu     system.   

Attention: DASYLab distinguishes between different types of data: time-dependent, frequency 
dependent, histogram, continuous, or triggered data. Signals of different types cannot be 
displayed simultaneously in one X/Y Chart display window.
If your experiment setup yields data signals of different types which you wish to display, 
use at least one X/Y Chart module for each type.



Module Installation and Configuration (General Hints)
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X/Y Chart Display Window
This is the display     window   associated with the X/Y     Chart   module.
It can display up to 8 pairs of dependent signals as X/Y diagrams.
The display style and interactive graphic commands can be chosen from the menu or the function bar.
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Edit New Text String

Delete All Text Strings

Customizing the Display Windows

X/Y Module



X Axis Scale X/Y Chart

This function determines the scaling of the X axis in an X/Y     Chart   display window.
All X channels are scaled with the chosen X scaling.
You can select the Unit, the display limits Display from... and Display to... and the display mode 
Logarithmic Scaling.
______________________



 Chart Recorder
 Module

In a separate Chart     Recorder     Display     Window,   this module displays curves of data acquired at a low 
speed.

In the worksheet, this module can have up to 16 signal     inputs.  

Click here for a survey of special display     module     features.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: ---
Output Block Size: ---
Max. Number of Modules: any

This module works with complete blocks of data, but continuously shifts the displayed curve from the 
right to the left. It may be used to display the current value of a signal together with its history.

Module Configuration
The module configuration dialog box can be opened by double-clicking on the module symbol.

Global Settings
These settings apply to all activated channels.
· Choose the display size with the Display     Time   parameter. (You can also change the parameter using 

the display window menu.)
· The Display Area selects the time area where the data is displayed. Enter a numerical value at the 

Display Time parameter, and the unit Seconds, Minutes, Hours or Days.
· The option Copy     Inputs     to     Outputs   provides the module with one output for each activated input 

channel. Incoming data is provided unchanged at the output.

Channel Specific Settings
These settings apply to the selected channel only.
· The switch Display Channel activates or deactivates the display of the currently selected channel.
· The Unit and Amplitude     Scale   can be specified.

Display Window
The data values from all the module entries will be displayed in a display     window   tagged with the same 
module     name.   The Chart     Recorder display     window   can be opened by double-clicking its icon at the 
bottom of the desktop.
Some of these parameters may also be modified in the display window menu     system.   These menus also
offer additional display options.

Attention: A Chart Recorder cannot display frequency-dependent data or histogram data, but it can 
display continuous and triggered data simultaneously in one chart.

Module Installation and Configuration (General Hints)
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Chart Recorder Display Window
This is the display     window   associated with the Chart     Recorder   module.
It can display up to 16 curves simultaneously in one chart.
The display style and customization commands can be chosen from the menu or the function bar.

Axes

Time Scale

Y Scale

Scaling Options

Display

One Chart

Mutiple Charts

Only Curves

Colors and Lines

Font Style

Copy to Clipboard

Print

Grid

Function Bar

Display Y Unit

Show Legend

Show Header

Setup Legend

Setup Header

Survey

Freeze

Continue

Zoom

Cursor

Extendt

Horiz.Cursor



Unzoom

Zoom between Cursor

Text

Show

Edit New Text String

Delete All Text Strings

Font, Color and Frame

Customizing the Display Windows

Chart Recorder



 Time Scale Chart Recorder

These settings modify the scaling options for the X axis of the diagram.
All the displayed curves use one joint X axis. It may be chosen either from the module configuration 
dialog box of the Chart     Recorder   module or from the menu or function bar of the corresponding 
Chart     Recorder   display window.

These options for scaling the X axis are available:
· Running Time Scale

This option sets the X axis labeling to seconds, minutes and hours from the start of the measurement. 
The X axis will be updated with every shift of the curves in the display.

· Fixed Time Scale
This option fixes the starting point of the X axis at 0. The labeling will not change during recording.

· Time of Day
Use this option to label the X axis with the current system time in the format of hh:mm:ss. The 
labeling will be updated with every shift of the curves in the display.

Attention: If the measurement has been paused and continued, it will be ignored for the labeling of 
the Time of Day axis.

· Display Time
Choose the display time size of the Chart Recorder. The parameter can be entered in the units 
Seconds, Minutes, Hours or Days. The maximum display time refers to the data block size, sample rate 
and the available memory size.

The parameter Start at Left is selectable in the Time Axis field:
· If Start at Left is selected, the curve will be displayed from the left to the right without shifting until the 

right boundary is reached.
· Otherwise the display will start at the right boundary and shift the curve into the window.

Chart     Recorder     Display     Window  



 Zoom between Cursor
If the Cursor function is active, you can zoom into the curve between the cursor pair. The zooming 
area is limited to the actual cursor positions.
______________________



 Analog Meter
 Module

In a separate display     window,   this module displays data from up to 16 channels.

In the worksheet, this module can have up to 16 signal     inputs.  

Click here for a survey of special display     module     features.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This module displays values in up to 16 channels in a separate display window.

Module Configuration
The module configuration dialog box can be opened by double-clicking on the module symbol or on 
the display window.

Global Settings
These settings apply to all activated channels.
· The option Copy     Inputs     to     Outputs   provides the module with one output for each activated input 

channel. Incoming data is provided unchanged at the output.

Channel Specific Settings
These settings apply to the selected channel only.
· Display from/to

These values limit the display range of the instrument. The parameter from refers to the lower, the 
parameter to refers to the upper range border.

· Unit
Display the unit in the instrument.

· Lower/Upper Mark
The color of the scale can be adjusted. If this function is active, the areas below and beyond the mark 
values are displayed in an additional color, making a simple limit control possible.

· The Analog Meter module displays one value from a block of data. The value to be displayed can be 
selected from the following options:
function displayed value
Last the last value of the current block
Minimum the minimum value of the current block
Maximum the maximum value of the current block
Mean the mean value of the current block
RMS the Root Mean Square value (RMS) of the current block

· Mode
· Activate the Trend parameter to display two arrows in the display of the selected channel. If the 

displayed value differs from the new value, the color of the arrow changes. If the value is equal, no 
color change appears.

· Activate the Peak Hold parameter to add an additional pointer marking the current Maximum and 



Minimum values since the start of the experiment. The additional pointers are set to the inverse 
range maximum when the experiment is started.

Button
The buttons at the bottom of the dialog box open separate dialog boxes to configure the display window.
· Choose Options

· to change the digits and decimals of the numerical value,
· to show/hide the display of the channel     name   and unit,
· to change the arrangement of the individual instruments if more than one channel is displayed.

· Select Color and Font to change the display of the text, pointers and numerical displays.

The format of the numerical values is based on the country-specific     settings   as specified in the 
International dialog box of the Windows Control Panel.

Display Window
Double-click on its icon to open the display     window.  
Click on the right mouse button to change color settings.
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Options Analog Meter

You can select the following options to customize the appearance of the Analog     Meter   display window:
· Numerical Value

· If Show Digital Value is activated, the current numerical value is displayed at the bottom of the 
instrument. The Number of Digits and the number of Decimals can be specified.

· With Unit shows or hides the selected unit at the bottom of the instrument.
· Display:

· If more than one instrument is activated in the module, you can change the Number of Columns. 
The arrangement of the individual instruments within the display window is determined using this 
setting.

· With Channel Name shows or hides the channel     name   at the top of the instrument.
· Pointer Size changes the size of all pointers in the display window.
______________________



Colors Analog Meter

You can define the colors of the Analog     Meter.   Click on one of the elements of the instrument to open 
the color selection dialog box.

· Color Change
The scaling area above and below the selected limits is shown in the selected color. If values fall 
below or exceed the specified limits during the experiment, the color of the numerical output switches 
to the selected color.

· Background
Select the color of the background of the Numerical Value, the channel     name   and the Unit display.

· Text
Select the color of the output of the channel name, the scale and the value.

· Drawing Elements
Select the color of the pointer and the trend display.

· Peak Hold
Select the color of the maximum and minimum Peak Hold.
______________________



Font Analog Meter

Select the font used to display the channel     name   and the numerical values in the Analog     Meter.  
The font size is not adjustable. It is automatically adjusted to fit the window size.
______________________



 Digital Meter
 Module

In a separate display     window,   this module displays the numerical values of up to 16 input signals.

In the worksheet, this module can have up to 16 signal     inputs.  

Click here for a survey of special display     module     features.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This module is used to display up to 16 data channels as a numerical display, like the display of a 
digital meter, in a separate window.

Module Configuration
The module configuration dialog box can be opened by double-clicking on the module symbol or on 
the display window.

Global Settings
These settings apply to all activated channels.
· The option Copy     Inputs     to     Outputs   provides the module with one output for each activated input 

channel. Incoming data is provided unchanged at the output.

Channel Specific Settings
These settings apply to the selected channel only.
· Unit

Display the unit in the instrument.
· Lower/Upper Mark

The coloring of the displayed digits can be adjusted. If this function is active, values above or below 
the set values are displayed in an additional color, making a simple limit control possible.

· The Digital Meter module displays one value from a block of data. The value to be displayed can be 
selected from the following options:
function displayed value
Last the last value of the current block
Minimum the minimum value of the current block
Maximum the maximum value of the current block
Mean the mean value of the current block
RMS the Root Mean Square value (RMS) of the current block

· Activate the Trend parameter to display an arrow in the selected channel if the displayed value differs 
from the new value. If the value is equal, no arrow is displayed.

Button
The buttons at the bottom of the dialog box open separate dialog boxes to configure the display window.
· Choose Options



· to change the digits and decimals of the numerical value,
· to show/hide the display of the channel     name   and unit,
· to change the arrangement of the individual instruments, if more than one channel is displayed.

· Select Color and Font to change the display of the text and numerical displays.

The format of the numerical values is based on the country-specific     settings   as specified in the 
International dialog box of the Windows Control Panel.

Display Window
Double-click on its icon to open the display     window.  
Click on the right mouse button to change color settings.
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Options Digital Meter

You can select the following options to customize the appearance of the Digital     Meter   display window:
· Numerical Value

· The Number of Digits and the number of Decimals can be specified.
· Display

· If more than one instrument is activated in the module, you can change the Number of Columns. 
The arrangement of the individual instruments within the display window is determined using this 
setting.

· With Channel Name shows or hides the channel     name   at the top of the instrument.
______________________



Colors Digital Meter

You can define the colors of the Digital     Meter.   Click on one of the elements of the instrument to open 
the color selection dialog box.

· Color Change
If values fall below or exceed the specified limits during the experiment, the color of the numerical 
output switches to the selected color.

· Background
Select the color of the background of the Numerical Value, of the channel     name   and of the Unit display.

· Text Output
Select the color for the numerical output.
______________________



Font Digital Meter

Select the font used to display the channel     name   and the numerical values in the Digital     Meter.  
The font size is not adjustable. It is automatically adjusted to fit the window size.
______________________



 Bar Graph
 Module

In a separate display     window,   this module displays data in bar graph form.

In the worksheet, this module can have up to 16 signal     inputs.  

Click here for a survey of special display     module     features.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This module is used to display up to 16 data channels, in bar graph form, in a separate window.

Module Configuration
The module configuration dialog box can be opened by double-clicking on the module symbol or on 
the display window.

Global Settings
These settings apply to all activated channels.
· The option Copy     Inputs     to     Outputs   provides the module with one output for each activated input 

channel. Incoming data is provided unchanged at the output.

Channel Specific Settings
These settings apply to the selected channel only.
· Display from/to

These values limit the display range of the instrument. The parameter from refers to the lower, the 
parameter to refers to the upper range border.

· Unit
Display the unit in the instrument.

· Lower/Upper Mark
The color of the displayed bar can be adjusted. If this function is active, the bar area above or below 
the marks are displayed in an additional color, making a simple limit control possible.

· Three different bar graph styles can be selected:
function Values will be displayed by ...
Bar ... a vertical bar.
Triangle ... a small triangle pointing at the scale.
Thermometer ... a vertical bar in the shape of a thermometer.

· The Bar Graph module displays one value from a block of data. The value to be displayed can be 
selected from the following options:
function displayed value
Last the last value of the current block
Minimum the minimum value of the current block
Maximum the maximum value of the current block
Mean the mean value of the current block
RMS the Root Mean Square value (RMS) of the current block



· Activate the Trend parameter to display an arrow in the selected channel if the displayed value differs 
from the new value. If the value is equal, no arrow is displayed.

Button
The buttons at the bottom of the dialog box open separate dialog boxes to configure the display window.
· Choose Options

· to change the digits and decimals of the numerical value,
· to show/hide the display of the channel     name   and unit,
· to change the arrangement of the individual instruments if more than one channel is displayed.

· Select Color and Font to change the display of the text, bars and numerical displays.

The format of the numerical values is based on the country-specific     settings   as specified in the 
International dialog box of the Windows Control Panel.

Display Window
Double-click on its icon to open the display     window.  
Click on the right mouse button to change color settings.
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Options Bar Graph

You can select the following options to customize the appearance of the Bar     Graph   display window:
· Numerical Value

· If Show Digital Value is activated, the current numerical value is displayed at the bottom of the 
instrument. The Number of Digits and the number of Decimals can be specified.

· With Unit shows or hides the selected unit at the bottom of the instrument.
· Scale

· Specify the scale of the bar graph. Possible scales are Per Channel, only one scale in front of the 
1st channel or a display completely Without Scale. The Number of Characters and the number of 
Decimals can be specified.

· Representation
· If more than one instrument is activated in the module, you can change the Number of Columns. 

The arrangement of the individual instruments within the display window is determined using this 
setting. The number of lines will be computed from this setting and from the number of activated 
instruments.

· With Channel Name shows or hides the channel     name   at the top of the instrument.

Bar Graph



Colors Bar Graph

You can define the colors of the Bar     Graph.   Click on one of the elements of the instrument to open the 
color selection dialog box.

· Color Changes
If values fall below or exceed the specified limits during the experiment, the colors of the bar and of the
numerical output switch to the selected color.

· Background
Select the color of the background of the Bar Graph Column, of the Numerical Value, of the 
channel     name   and of the Bar Graph.

· Text Output
Select the colors for the output of the channel name, for the scale, and for the numerical output.

· Drawing Elements
Select the colors of the Columns and of the Trend display.
______________________



Font Bar Graph

Select the font used to display the channel     name   and the numerical values in the Bar     Graph.  
The font size is not adjustable. It is automatically adjusted to fit the window size.
______________________



 Status Lamp
 Module

In a separate display     window,   this module displays the alternating state of up to 8 input signals along 
with a state-specific alphanumeric string and status light.

In the worksheet, this module can have up to 8 signal     inputs.  

Click here for a survey of special display     module     features.  

Input and Output Characteristics
Number of Inputs: up to 8
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

A separate window displays the alternating state of up to 8 input signals along with a state-specific text 
string and status light. The limit which causes the state change is the numerical value 1,5.

Module Configuration
The module configuration dialog box can be opened by double-clicking on the module symbol or on 
the display window.

Global Settings
These settings apply to all activated channels.
· The option Copy     Inputs     to     Outputs   provides the module with one output for each activated input 

channel. Incoming data is provided unchanged at the output.

Channel Specific Settings
These settings apply to the selected channel only.
For each activated channel, this module shows the state of the digital input signal by displaying different 
lights and alphanumeric strings for low and high states.

Display Window
The data values from all the module entries will be displayed in a display     window   tagged with the same 
module     name.   The display window can be opened by double-clicking its icon at the bottom of the 
desktop.
For each channel, the display window contains its channel     name,   an area for displaying the status string,
and the light symbol.
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 List Display
 Module

In a separate List     Display     Window,   this module displays the values of its input signals in list form.

In the worksheet, this module can have up to 16 signal     inputs.  

Click here for a survey of special display     module     features.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: ---
Output Block Size: ---
Max. Number of Modules: any

This module displays numerical data in a table. Data values are updated in blocks, so only few values of 
large data blocks are displayed, depending on the window size and the selected module data buffer. If a 
small block size is selected (e.g. 1 or 2), the old list scrolls up and the new values will be added in the 
list. 
This module can store 9,999 data values/channel.

Module Configuration

Global Settings
These settings apply to all activated channels.
· The option Copy     Inputs     to     Outputs   provides the module with one output for each activated input 

channel. Incoming data is provided unchanged at the output.
· Memory specifies the number of samples which are stored in the List module for each channel. The 

maximum memory size is 9,999 samples for each channel. This parameter also determines how far 
back you can scroll.

· If Show Units is activated, the physical units specified for each channel will be displayed above the 
corresponding columns of the list.

Channel Specific Settings
These settings apply to the selected channel only.
· The switch Display Channel activates or deactivates the display of the currently selected channel.

Button
· Choose Options

· to change the number of digits and decimals of the numerical value,
· to change data format between decimal, scientific or engineering notation.
· to show/hide the time     channel.  

Display Window
The data values from all the module entries will be displayed in a display     window   tagged with the same 
module     name.   The List     Display     Window   can be opened by double-clicking its icon at the bottom of the 
desktop.
Some of these parameters may also be modified in the display window menu     system.  
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Options List

You can select the following options to customize the appearance of the List display window:
· Numerical Value

· Characters
This display defines the number of characters to be displayed for each data channel. In addition to 
Font and Font Size, you can set the width of the display window. The text can have a length of 5 up 
to 20 characters.

· Decimals
Specify the number of decimal places (0 to 5) to be shown for normal measurement values.

· Memory Depth
This value specifies the length of the list.
If this value exceeds the maximum number of values to be displayed, a scroll bar will be shown at 
the left side of the list box. Use this scroll bar to select the section of the list to be displayed.
The maximum memory depth per channel is 9,999.

· Output Format
Specify how the measurement value is to be displayed: in the Normal Format, in the Exponential or in 
the Engineering Format. The Engineering Format corresponds to the Exponential representation but as 
an exponent only 3 or a multiple thereof is used.

· Representation
· With Time Channel

Activating this switch displays a Time     Channel   in addition to the list of numerical values in the 
display window. With Time Channel Type the values to be displayed are specified.

· With Unit shows or hides the selected unit below the Channel Name.

List Module



List Display Window
This is the display     window   associated with the List     Display   module.
It can display the values of up to 16 channels simultaneously in one list.
The display style and interactive commands can be chosen from the menu or the function bar.

Text

List to Clipboard Print

Display

Time Channel

Freeze

Continue

Function Bar

Font Style

Text Color

Background Color

Show Unit

List Module



Time Channel List

A time channel for a data     list   can be defined in this submenu.
The time can be listed in three different modes:
function displayed time value
Time of Day the current time when the sample was acquired
Measurement Time the elapsed time since start of the measurement
Sample Number a continuous numbering of all the lines in the list

The time format of the List display window is basically determined by the International     Settings   as 
specified in the Windows Control Panel.
______________________



 Color List

This command opens the color selection dialog box. The List module allows you to change the color of
the displayed text and lines and the color of the background.
______________________



 Font List

Select the font used by the List     Module.  
You can select the Font, the Font Style (plain, bold, italics and underlined) and the Font Size.
These settings apply to the displayed characters and the title.
______________________
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Files
 Module Group

This group consists of modules for reading and writing data.

Read Data

Write Data

Data Archiving
Module Selection Menu



 Read Data
 Module

This Module is not available in the Demo Version.
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Cut Out
This Module is not available in the Demo Version.

______________________



 Write Data
 Module

This Module is not available in the Demo Version.
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Multiple Files Write Data

This Module is not available in the Demo Version.

Write Data



ASCII Format Write Data

This Module is not available in the Demo Version.

Write Data



DASYLab Format Write Data

This Module is not available in the Demo Version.

______________________



DADiSP Format Write Data

This Module is not available in the Demo Version.

______________________



DIA/DAGO Format Write Data

This Module is not available in the Demo Version.

______________________



Famos Format Write Data

This Module is not available in the Demo Version.

______________________



IEEE 32 Bit Format Write Data

This Module is not available in the Demo Version.

______________________



Remus Format Write Data

This Module is not available in the Demo Version.

______________________



Signalys Format Write Data

This Module is not available in the Demo Version.

______________________



 Backup Data  
 Module

This Module is not available in the Demo Version.

File Modules
Module Selection Menu
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Data Reduction
 Module Group

This group consists of modules which reduce data in various ways.

Average

Block Average

Separate

Multiplexer / Demultiplexer

Cut Block

Time Slice
Module Selection Menu



 Average
 Module

This module calculates different average values of input signals.
In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any, but fixed
Number of Outputs: same as number of inputs
Output Block Size: same as input block size, or as specified
Max. Number of Modules: any

The type of average and the number of samples to average can be specified in the module configuration
dialog box:
· Arithmetic Mean

· Block Mean
The result of this function is one value for each block of n samples, where n is defined by 
Average Samples. This value equals the arithmetic mean of the block.
This function performs a data reduction with a factor n. Use Change Block Length to change the 
output block length to the desired value.

· Running
This function calculates the running average over n samples, where n is defined by 
Average Samples. The start segment contains the mean of the first data sample.
The number of output samples equals the number of input samples.

· Summing
For each sample, this function calculates the mean value of all the previous data. The number of 
output samples equals the number of input samples.
Check With Reset to reset the internal value to 0 and to restart the computation periodically after 
every n samples. The value n is specified by After ... Samples.

· Quadratic Mean
· Block Mean

The result of this function is one value for each block of n samples, where n is defined by 
Average Samples. This value equals the quadratic mean of the block.
This function performs a data reduction with a factor n. Use Change Block Length to change the 
output block length to the desired value.

· Running
This function calculates the running average over n samples, where n is defined by 
Average Samples. The start segment contains the mean of the first data sample.
The number of output samples equals the number of input samples.

· Summing
For each sample, this function calculates the mean value of all the previous data. The number of 
output samples equals the number of input samples.
Check With Reset to reset the internal value to 0 and to restart the computation periodically after 
every n samples. The value n is specified by After ... Samples.

· Exponential Weighted Mean
With this function you compute the (running) mean with the following formula:

s (Tau, n) = sqrt (exp (-k) * sqr (s (Tau, n-1)) + k * sqr (x(n)) ),
where
· n is the sample number,
· x(n) is the sample at sample number n,
· k is the sample distance divided by Tau,
· and Tau is the specified time constant.



Hint: Running values can be reset during an experiment by means of the event-driven actions.
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 Block Average
 Module

This module calculates the block average of its input signals.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any, but fixed
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

This function calculates the arithmetic means of blocks. The output will always represent the mean value
of the different blocks.
Example: block size 4, average of 3 blocks, single values

One new block will be calculated on the basis of the three blocks (a, b and c) as follows:
e1 = (a1 + b1 + c1) / 3
e2 = (a2 + b2 + c2) / 3
e3 = (a3 + b3 + c3) / 3
e4 = (a4 + b4 + c4) / 3

The following averages are provided:
· Single Values

Each output block represents the mean of the specified number of input blocks (see example).
Attention: The number of output blocks will be lower than the number of input blocks.

· Running
This function recalculates the running mean for each input block. The output block always represents 
the current block mean of all the previous input blocks.

· Running with Restart
This function works similarly to the Running average, except that a reset will be performed after n 
blocks, where n is the specified number of blocks.

Hint: Running values can be reset during an experiment by means of the event-driven actions.
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 Separate
 Module

This module achieves data reduction
· by skipping an initial number of samples or blocks,
· then repeatedly passing one sample or block to the connected modules,
· then skipping a number of samples or blocks again.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size, entered block size
Max. Number of Modules: any

· Behavior at Start of Experiment
At start of experiment the specified number of samples or blocks (Ignore ... once) is skipped once. The 
next sample or block will be passed to the connected modules.
With this function you can perform an initial skip.

· Behavior while Experiment is running
After one sample (or block) has been passed to the module output, the number of samples (or blocks)
specified under Ignore ... is read in but not passed to the connected modules.
The next sample (or block) is passed again, then the defined amount of data is ignored, etc.

The Output Block Size can be set from 1 to 8,192 if the data reduction is based on samples and not on 
data blocks.

This module is very useful if you need channels with high and low acquisition rates in one flow chart. 
Most drivers only support equal sampling rates for all channels; then this module can perform the 
necessary data reduction for the slow channels very easily.
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 Multiplexer / Demultiplexer
 Module

Using this module different data channels can be sequentially applied to one data channel, or the values
of one data channel can be distributed to up to 16 channels.

Input and Output Characteristics
Number of Inputs: up to 16, or 1
Input Block Size: any
Number of Outputs: 1, or more
Output Block Size: same as input block size
Max. Number of Modules: any

Since this module provides 2 basic operations, you must first select the function     type   when you install 
the module.
· Multiplexer

With a Multiplexer module, up to 16 channels can be multiplexed onto one channel.
The number of input channels and the multiplex factor are set using the channel     bar.  
The start time, the block size and the sampling rate must be the same for all channels. The generated 
channel will then have the same block size; the sampling rate is multiplied by the number of 
channels.

· Demultiplexer
With a Demultiplexer module, one channel is distributed to a number of channels specified by using 
the channel     bar.  
The sampling rate of the output channels is divided by the number of channels.

Use this module to route a large amount of data through one channel. The data can also be processed 
partially if a Multiplexer module is inserted at the beginning of the channel and a Demultiplexer module at
its end. Thus the worksheet can be simplified to a large extent.
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 Cut Block
 Module

With this module a specified range of values can be extracted unchanged from a data block and routed 
to the output. The remaining values are set to 0.

One module can process up to 16 data     channels   with different settings.

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any

Use Extraction to specify the values for each channel which should be passed on unchanged to the 
output. All other values within the data block are set to 0.
If the limits are set to a size exceeding the block size of the data channel, the data is passed on without 
any modification.

Example: global block size: 512
data from sample no. 10 up to 500
> the values 1 to 9 are set to 0;

the values 10 to 500 are passed on unchanged;
the values 501 to 512 are set to 0 again.

This function can be used to extract only certain frequency parts of an FFT signal and pass those on for 
display or further processing.

Module Installation and Configuration (General Hints)
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 Time Slice
 Module

This module can combine signal segments from different channels by a defined time schedule.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: 1
Output Block Size: same as input block size
Max. Number of Modules: any

The Time Slice module can be used to combine streams of different signals from several input channels 
according to the defined time slice.
Independent of the number of inputs, the module generates only one output signal, which consists of 
signal segments taken consecutively from the activated input channels. The first segment is always 
taken from module entry 0, the second from module entry 1, and so forth.
The size of these segments can be specified for each individual input channel in the 
module configuration dialog box. Their duration (or length) can be defined either as a period of time or as
a number of blocks.
After one segment of the specified size from each activated input channel has been output, the first 
cycle is completed. The Restart at the End of the Cycle flag then determines the output signal:
· If this flag is set, another cycle will start beginning with a segment from channel 0.
· If this flag is not set, the signal from the last activated channel will be output further.

Module Installation and Configuration (General Hints)

Data Reduction Modules
Module Selection Menu
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Special Modules
 Module Group

This group consists of modules for special purposes.

Black Box:
General Remarks

New Black Box

Export/Import Module

(Black Box Files)

Event-driven Actions:
General Remarks

Action

Message

further Special Modules:

Time Base

Signal Adaptation

Module Selection Menu



Black Box: Concept and Handling
With DASYLab's Black Box concept you can set up worksheet elements which are repeatedly required in
your experiments, integrate them into one module (the Black Box), save them to file, and insert them into
future worksheets as ready-to-use units. Similar to an integrated circuit or subroutine, a 
Black Box module contains an encapsulated portion of the worksheet.
Using Black Box modules, you can easily implement standardized modules which perform custom 
algorithms not normally provided in DASYLab.
This modular concept helps to simplify and clarify even the most complex experiment setups by 
considerably reducing the number of elements (modules as well as data channels) to be installed and 
controlled in the worksheet. It also saves time, as subordinate standard tasks need not be set up from 
scratch again and again.

The Black Box module itself has an "inside" and an "outside":
· Inside, it contains a complete worksheet, with modules arranged on a workpad and connected with 

each other through data     channels.   The complexity of that worksheet is the same as that of any other 
DASYLab worksheet. This means, for example, that it may contain up to 256 modules.

· Outside, the Black Box module looks like any other module on the worksheet of which it is an element.
It can be installed and handled in a similar way, it may be configured with several inputs and outputs, 
and it can be connected to the other modules as usual.

Black Box modules offer some additional features:
· On a Black Box worksheet you can insert another Black Box module, which can then contain a 

Black Box module again, and so forth. Thus, the worksheet becomes three-dimensional in a way, with 
the Main Chart (on the actual DASYLab work area) and several layers of subordinate Black Box levels, 
each one embedded into the preceding one.

· You can freely move up and down between levels using menu commands and a function bar icon.
· Data is exchanged between a worksheet and a Black Box worksheet embedded into it using the 

Export     and     Import   module. This module may be provided with up to 16 inputs and outputs.
· Each Black Box module can be saved separately, so that you can easily edit, manage, and insert 

several of them independently.

Various menu commands are available to create, save, open and edit Black Boxes. These Help pages 
will give you further information:

Creating and Editing a Black Box
Export and Import Module
Opening and Saving a Black Box
Black Box Info
Leaving a Black Box

Special Modules
Module Selection Menu



Creating and Editing a Black Box
To insert a Black Box module into your worksheet, choose New Black Box from the Special module     group  
on the Module menu. The Black Box module symbol appears on the DASYLab work area like any other 
module, but at this initial stage it does not yet possess any input or output symbols.
(The Black Box module can also be integrated on the module     bar   to be easily inserted later on.)

Creating a Black Box Worksheet

Double-click the Black Box module symbol in the work area to open the Black Box module. Where 
other modules now display their module configuration dialog box, the Black Box module presents an 
empty worksheet. The work area looks like that of the main chart in DASYLab except for the 
background color, which is different to indicate the new level.
In this work area, you can now create the Black Box worksheet by installing modules, configuring and 
connecting them in the usual way.
Like any other DASYLab worksheet, a Black Box worksheet may contain up to 256 modules, among 
them any number of Black Box modules.
Further Black Box worksheets can be embedded down to any level.

Connecting the Black Box Worksheet to the Main Chart
Data is transferred between the main chart and the subordinate Black Box worksheet embedded into it 
using a special Export     and     Import   module. This module can be selected in the usual way from the 
Special module group on the Module menu (or from the module bar).
Each Black Box worksheet can only contain one Import module and one Export module.

· The Import module provides only outputs (to deliver data coming in from the main chart);
· the Export module provides only inputs (to take up data going out to the main chart).

The module symbol of that Black Box in the preceding worksheet (of which the Black Box is an 
element) provides the corresponding number of input and output symbols respectively.

Configuration
A Black Box can have up to 16 inputs and up to 16 outputs. These are not selected using a 
Channel Selection Bar, as is the case with most of the other modules, but they are created 
automatically when Export/Import modules are installed on the Black Box worksheet.
The number of inputs is independent of the number of outputs; the input block sizes and input rates 
are independent of the output block sizes and output rates.

Returning to Preceding Black Box Levels

A Black Box may be closed either by clicking this function bar icon, or by choosing the corresponding 
command from the Black Box Module submenu on the Edit menu.
This command can have two names: It is either Back to the Main Chart (if the current Black Box is an 
element of the Main Chart), or it is To Preceding Black Box Level (if the current Black Box is itself an 
element of another Black Box worksheet).
Note: You can enter a Black Box (i.e. activate its worksheet for editing) only by double-clicking its 

module symbol on the worksheet.
Note: If you start an experiment from a Black Box worksheet, the program will first return to the Main 

Chart before acquisition begins.

Colors
By default, the worksheet of a new Black Box has a blue background color. But all the usual color 
settings can be selected for each Black Box. Choose the Colors command from the Options menu to 
do so.



These settings will also be saved with the Black Box worksheet.
Hint: It is a good idea to use the background color as an indicator of the Black Box level. You will 

make it easier to find your way through several worksheet levels without losing orientation by 
assigning a clearly defined background color to each of these levels. For example, a color 
code could be: the lower the level, the darker the color.

Module Bar
For each Black Box you can freely configure its own module bar. You can create several customized 
module bars specially adapted for each Black Box task, save them to files and open them again later 
on. Choose the commands from the Module     Bar   submenu on the Edit menu to do so.
These settings will also be saved together with the Black Box worksheet.

Black Box Overview

Special Modules
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 Export / Import Module Black Box
 Module

This module provides the connection between a Black Box worksheet and the main chart (or the 
preceding worksheet) of which that Black Box is an element. It transfers data between these two 
worksheet levels.
To establish the connection, the module must be present on both worksheet levels:
· there is the Export or Import module     symbol   itself (in the Black Box worksheet);
· while the module symbol of that Black Box in the main chart provides the corresponding number of 

output or input symbols respectively.
This module can only be inserted into a Black Box worksheet. Choose Export/Import Module from the 
Black Box module group on the Module menu.
(The Export/Import module can also be integrated on the module bar to be inserted easily later.)

Each Black Box worksheet can contain only one Import module and one Export module.

Since this module provides different basic operations, you must first select the function     type   when you
install the module.
This module provides two function types:
· Import     Data  

The Import module provides only outputs (to deliver the data coming in from the main chart).
· Export     Data  

The Export module provides only inputs (to take up data going out to the main chart).

Up to 16 module entries or outputs can be activated.
Unlike most other modules, the number of inputs is independent of the number of outputs; the input 
block sizes and input rates are independent of the output block sizes and output rates.

Black Box Overview

Special Modules
Module Selection Menu



Export Module (Black Box)

Using this module, the Black Box transfers data from its own worksheet to the main chart (or the 
worksheet on the preceding level).

· The Export module provides only inputs (to take up the data going out to the main chart).
· The Black Box module provides the corresponding number of outputs (to deliver the data from the 

Black Box worksheet to the main chart).

Each Black Box worksheet can contain only one Export module.

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: ---
Output Block Size: ---
Max. Number of Modules: 1

Export and Import Module
Black Box Overview
______________________



Import Module (Black Box)

Using this module, the Black Box receives data from the main chart (or the worksheet on the preceding
level) to process in its own worksheet.

· The Import module provides only outputs (to deliver the data coming in from the main chart to the 
Black Box worksheet).

· The Black Box module provides the corresponding number of inputs (to take up data from the main 
chart and to transfer them to the Import module on the Black Box worksheet).

Each Black Box worksheet can contain only one Import module.

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16
Output Block Size: any
Max. Number of Modules: 1

Export and Import Module
Black Box Overview
______________________



Saving and Opening a Black Box
Open
Black Boxes which are saved to files can be opened (inserted into a worksheet) in three different ways:
· The first 20 Black Box files in the DASYLab directory automatically appear as menu items on the 

Black Box Module submenu of the Module menu. Simply choose the command to install that Black Box 
in your worksheet.
Attention: DASYLab can only list a Black Box file on that menu if a module name was entered for 

that Black Box before saving it.
· You can insert any Black Box - saved in any directory - into your worksheet by choosing Open... from 

the Black Box Module submenu of the Edit menu. The Windows file selection dialog box appears, 
displaying all the Black Box files (standard extension: *.DBB) in the DASYLab directory. You can then 
select or enter the name, directory, and drive of the file to be opened. For details, please see the Help 
page concerning the Open... command from the File menu.

· You can also include Black Box files - like any other module - in a custom module bar. If you click on a 
button in the module bar with the right mouse button, a dialog box will list all the modules available in 
DASYLab including the first 20 Black Box files in the DASYLab directory. Scroll through the list using 
the scroll bar, choose a Black Box by clicking it with the left mouse button, and choose OK to confirm 
your choice. The module bar button now displays the icon of the Black Box assigned to it.
When you have customized your module bar, to add one of the Black Boxes to your worksheet just 
click the icon which symbolizes that Black Box.

Save
To save a Black Box:
· First, open the Black Box you wish to save. (The work area must display the Black Box worksheet. 

You cannot save a Black Box while the DASYLab main chart is active.)
· Make sure you have entered a Module Name and an ID Tag in the Black Box Info dialog box.

· DASYLab can only list a Black Box file on the Module menu if a Module Name has been entered for 
that Black Box before saving it.

· DASYLab can only install a Black Box icon on the module bar if an ID Tag has been entered for that 
Black Box before saving it. If the identifying tag is missing, the Black Box Info dialog box will appear 
when you try to save the Black Box.

· Choose Save As... from the Black Box Module submenu of the Edit menu. The Windows dialog box 
appears, where you can then specify the name, directory, and drive of the file to be saved. DASYLab 
automatically adds its standard extension for Black Box files (*.DBB). For details, please see the Help 
page concerning the Save     As...   command from the File menu.

Attention: If you save a worksheet containing a Black Box, that Black Box will be completely included in 
the file, not just as a reference to a separate Black Box file.
If you modify the Black Box file independently, the Black Box embedded in the worksheet will 
not be updated automatically when you open it again. (You would have to delete the 
previous Black Box version from the worksheet and insert the new version then.)
The advantage of this system is that if you modify or delete the separate Black Box file, this 
will not cause errors in the worksheets incorporating (and possibly based on) the functions 
and settings of the original Black Box.

Black Box Overview
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Black Box Info
In this dialog box you can enter descriptive text and identifying tags for the Black Box module.

· The Module Name helps to identify the module     symbol   in the worksheet.
· The Black Box module symbol in the main chart (or the preceding worksheet level) displays this 

name in its title bar.
· The first 20 Black Box files in the DASYLab directory automatically appear as menu items on the 

Black Box Module submenu of the Module menu. Their Module Names appear as menu 
commands.

· In the Description box you can enter a short comment on the functions implemented in the Black Box.
· The ID Tag is a string of up to 3 characters. It is used to identify the Black Box module in the 

module     bar.   The module bar icon representing that Black Box displays that tag.
Attention: A Black Box can only be saved if an ID Tag has been entered. If the identifying tag is 

missing, the Black Box Info dialog box will appear when you save the Black Box.

Black Box Overview
______________________



Leaving a Black Box
A Black Box may be closed either by clicking this function bar icon, or by choosing the command from 
the Black Box Module submenu on the Edit menu.
This command has two names: It is either Back to the Main Chart (if the current Black Box is an 
element of the Main Chart), or it is To Preceding Black Box Level (if the current Black Box is itself an 
element of another Black Box worksheet).
After a Black Box has been closed, the worksheet on the preceding level is activated.
Note: If you start an experiment from a Black Box worksheet, the program will first return to the Main 

Chart before acquisition begins.
Note: You can enter a Black Box (i.e. activate its worksheet for editing) only by double-clicking its 

module symbol on the worksheet.

Black Box Overview
______________________



The Event-driven Actions Concept
The concept of event-driven actions represents a powerful new set of tools for the automation of actions 
in DASYLab. Based on user-determined conditions, a wide variety of module actions can be triggered, 
including hardcopy of Display instruments, resetting internal values of the Mathematics modules, logging 
of events etc.

Click here for a complete overview of the possible actions, of the 
modules which could trigger such actions and of the parameters 
required.

Sender / Receiver
An event-driven action involves 2 partners: a sender and a receiver.
The sender is an Action module which evaluates an incoming data channel with respect to various 
conditions. It initiates the desired action.
The receiver (specified in the Action module) is the module which performs the action or it is the main 
window in DASYLab.
The assignment of action and receiver is made in the Action module via the Module     Name   of the 
receiver. The assignment to the action is lost if the Name of a module performing an event-driven 
function is changed after setting the action.

Synchronous / Asynchronous Actions
There are two types of event-driven actions: synchronous actions and asynchronous actions.
· Synchronous Actions

Synchronous actions are performed on the data block where the actions occurred. This requires that 
the data stream triggering the action must be synchronous to the data stream the action should 
influence.
(For example, it is not possible to apply a synchronous action which has been initiated by a Relay-
triggered data stream to an untriggered data stream. Such tasks are only suited for asynchronous 
actions.)
Synchronous actions are reasonable in cases where actions must occur at an exact point in time in a 
data stream. A good example is the printout of a special data block.
Further notes:
· Synchronization has to be understood as an additional internal data channel and thus requires 

computing time even if no actions are initiated.
· The action always relates to the beginning of the block if the position within the data block is of 

importance to a synchronous event (for example, at a resetting action).
· The action is performed just once for the evaluated data block if the condition to initiate an action is 

satisfied within an evaluated data block more than once.
· For synchronous actions, the data must arrive at the Action module and at the Receiver module 

with the same block start time. Otherwise, DASYLab will generate an error message.
· Asynchronous Actions

Asynchronous actions are performed immediately, disregarding whether the data initiating the action 
was already processed by the module which should perform the processing.
(If, for example, the Printing action is sent as an asynchronous action to the Y/t Chart module, it could 
be that the corresponding data block is not being printed but an earlier or later data block.)
Asynchronous events feature a larger flexibility and are faster in their execution behavior. Therefore, 
they should be used in such cases where the execution at the time of a certain data block is not 
required. A good example is the activation/deactivation of channels in a display     window.  
Please note that the processing of asynchronous actions does not require any additional computing 
time if no action is initiated (with the exception of the Action module evaluating data, of course).

Action Module



Action List
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 Action
Module

This module is used to initiate various actions in DASYLab or in DASYLab modules. Click here for more 
information on the Event-driven     Actions concept.  

Once integrated into the worksheet, this module can initiate up to 16 different actions via one 
data     channel.  

Input and Output Characteristics
Number of Inputs: 1
Input Block Size: any
Number of Outputs: ---
Output Block Size: ---
Max. Number of Modules: any

The Action module can initiate up to 16 different event-driven actions based on one input channel. Use 
the channel     bar   to specify the number of event-driven actions to be initiated.
The following specifications are required for each action to be initiated:
· the Event condition,
· the Receiver for the action,
· the Action itself and
· the action-depending Parameters.

Event
Use Event to specify the condition for which the input data block is evaluated. The following options are 
available:
Function The action is initiated ...
Rising Edge: ... at the transition from TTL Low (numerical value 0) to TTL High 

(numerical value 5).
Falling Edge: ... at the transition from TTL High (5) to TTL Low (0).
Threshold Overflow: ... at exceeding the specified threshold value.
Threshold Underflow: ... at falling below the specified threshold value.
TTL High Level: ... at TTL High (5).
TTL Low Level: ... at TTL Low (0).
Input larger than Threshold: ... as long as the input value is larger than the threshold value.
Input smaller than Threshold: ... as long as the input value is smaller than the threshold value.
Start/Stop of Measurement: ... at the beginning and/or at the end of the measurement.
Always: The action is constantly initiated.
Never: The action is never initiated (NOP).

Threshold specifies the threshold value required for the corresponding conditions.
Note: Use the conditions Rising/Falling Edge and Threshold Overflow/Underflow as much as possible, 

since a hysteresis is applied to the condition.
For example, a slowly rising signal will trigger an action at the Action module with 
Threshold Overflow only if the threshold is really exceeded. The next action will only be triggered
after the signal has dropped below the lower threshold and then exceeds it again.
With Input larger than Threshold in contrast, an action is initiated for every block for which at 
least one value is larger than the set Threshold. This means the action is initiated whenever a 
block exceeds the Threshold value and for every following block until the signal value falls below
the Threshold value. Under certain circumstances this can initiate many undesired actions, 
requiring a significant amount of computing time.

Receiver



The Receiver entry specifies the module which is to execute the initiated action.
· In the pull-down list box Module all the modules in the worksheet (which can perform actions) are listed

together with the main window of DASYLab.
· Use Channel to specify which channels of the selected module are to perform the actions. Individual 

channels can be separated with spaces or commas. Channel groups are entered with hyphens.

Example: To use the channels 1, 3, 7 and 9 up to 12 of the Receiver module for the event, enter:
1 3 7 9-12      or      1,3,7,9-12

This setting does not influence actions relating to the entire module.

Action
Specify the Action which is to be initiated if the set condition is satisfied.
· In the pull-down list box, all the actions are listed which the selected Receiver module can perform.
· After selecting an Action, you can specify whether it is to be performed synchronously or 

asynchronously.
If the Receiver module can only asynchronously perform the selected action, this setting is selected 
automatically. The synchronous option is disabled.

Parameter
If the selected Action requires additional settings, these can be entered using the Parameter item.
This area of the dialog box contains options adapted to the selected Action. Depending on the selected 
Action, 1 text parameter, up to 4 integer parameters or up to 4 floating point parameters can be entered.
Above each input, a header explains the purpose of the Parameter.

Event-driven Actions
Action List

Special Modules
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Action List
This is an overview of the event-driven actions, of the modules which can perform such actions and of 
the required parameters. 
Action Receiver Description Parameter

Select Window
Arrangement

global function activates previously stored
display     window     arrangement  

number of Window
Arrangement

Load 
Worksheet

global function loads another worksheet after
stopping the current one

file name of the
worksheet

Load and start 
worksheet

global function loads and starts another worksheet file name of the
worksheet

Print Display 
Window 
Contents

Y/t, X/Y, Chart
Recorder, List

prints contents of display window ---

To Clipboard Y/t, X/Y, Chart
Recorder, List

copies contents of display window
to clipboard

---

One Chart Y/t, X/Y, Chart
Recorder

switches display mode 
to One     Chart   mode

---

Multiple Charts Y/t, X/Y, Chart
Recorder

switches display mode 
to Multiple     Charts   mode

---

Fade out 
Channel

Y/t, X/Y, Chart
Recorder, List

deactivates the display 
of one or more channels

list of channels

Fade in 
Channel

Y/t, X/Y, Chart
Recorder, List

activates the display 
of one or more channels

list of channels

Set Title Y/t, X/Y, Chart
Recorder

sets new title
for the display window

any text

Reset resets the internal value ---
with the PID Control, Time Base, Arithmetics, Integral, Average, Statistical     Values,   
Counter, Timer, Time     Slice   modules

Set Value Slider sets the regulating value to a
specific size

---

Set Value Generator sets, adds or multiplies frequency,
amplitude or offset values

---

Message Message displays a Message and/or
logs it (printer/file)

any text

Message with 
Acknowledge-
ment

Message displays a Message and/or
logs it (printer/file).

This message must be
acknowledged by the user 

before it is erased from the screen.

any text

Next File Write Data switches to the next file in multifile
mode

---

For some actions you can specify whether the action is to be performed synchronously or 
asynchronously.

Please refer to the notes in the README file since the features of this module are under constant 
development.

Action Module
Event-driven Actions





 Message
 Module

This module is used to display and output messages initiated by one or several Action modules.
This module does not have any inputs or outputs.

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: ---
Output Block Size: ---
Max. Number of Modules: any

With the Message module you can receive text messages from Action modules and output those on the 
screen or on a printer or write the information into a log file.

Use Options to activate or deactivate additional global functions.
· Manual Input for Messages opens a text input window. Using this window, text messages can be 

generated without influencing the measurement execution speed.
The text can be typed in at the Message to be entered field. After clicking on the Send button the 
message is sent to the connected module and the text is deleted from the input field.

· In the Action module you can select between normal text messages and text messages which must be
acknowledged after their display in the message window.
· With messages which must be acknowledged, a dialog box is displayed for acknowledging the 

message. Message and acknowledgment are logged in the log file and on the log printer.
· If Deactivate Acknowledgment is selected, messages which must be confirmed are not required to 

be acknowledged any more. Messages are not logged in the log file if the message to be 
acknowledged is not confirmed until the occurrence of the next message.

· Use Message Output Device to determine to which output device the message will be sent. Any 
combination of output devices is possible.
With Options specific settings for the output devices Message     Window, Log     Printer,   and Log     File   can 
be made.

Special Modules
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Message Window Options
These options influence the appearance and the format of the text to be displayed by the Message 
module in the message window.
· Use Window Options to determine the behavior of the message window when new messages are 

coming in.
Windows (starting with version 3.1) differentiates between two priorities for the display of windows: 
normal windows (which can overlap and cover each other) and constantly visible windows (e.g. 
Windows Clock or Help windows if the Always on Top setting is activated).
· Window Always on Top: In any case the message window is displayed on top of all other windows 

(also on top of dialog boxes, menus etc.). Legibility is thus guaranteed.
· Open Window at Message: The message window is displayed on top as soon as a new message 

arrives. A minimized message window (icon) will be enlarged.
· Use History Options to specify the representation of the window.

· Display only Last Message: A new message will always overwrite an existing message. Thus, only 
one message is visible - the newest.

· Message with History: All incoming messages are stored. You can page within the already received 
messages.

· Empty at Message Start: At a stop or restart of the message the internal buffer of the message 
window is emptied. In the course of a measurement the buffer contents is preserved.

· Use Additional Information to select further information which will be displayed with the actual 
message.
· Date and Time: The time the message came in will be displayed with the message.
· Time Representation: The time the message came in can be output in Real Time (the current date 

and time) or as the elapsed Time since Start of Measurement.
· Message Number: The number of the current message is logged.
· Sender Module: The name of the module sending the message is output.

· Use Text Formatting to select whether the additional information is to be displayed in a separate line 
and whether an empty line is to be inserted between messages.

· Use the Font switch to select the font, the font type, the font size and the color. Use the Color switch to 
set the color of the background. By default, the messages are black on a white background.

Message



Log Printer Options
These options influence the appearance and the format of the text to be output by the Message module 
on the log printer.
For this function DASYLab does not use the Windows Print Manager nor the default printer selected 
with the Windows Control Panel. The selected log printer is accessed directly and immediately for 
outputting a log message. The program does not wait until a page is full before it starts printing.
Note: A simple matrix printer or ink jet printer with fan-fold paper is certainly well suited for this 

application. Please note, however, that this printer must not be used for other applications at the
same time.

· Use Printer Options to specify the settings for the connected log printer.
· The communication port the log printer is connected to is selected with Interface.
· With the settings Lines per Page, Lines at Top of Page and Lines at Bottom of Sheet you can 

influence the page format of the log printer. Please refer to your printer manual for the relevant 
information.
DASYLab always tries to print the entire message on one page. If the message does not fit 
completely onto the remaining lines of a page already printed on, DASYLab will begin a new page 
for the new text.
Tip: Select 72 Lines per Page for a normal DIN A4 size sheet.

· Use Additional Information to select further information which will be printed with the actual message.
· Date and Time: The time the message came in will be printed with the message.
· Time Representation: The time the message came in can be output in Real Time (the current date 

and time) or as the elapsed Time since Start of Measurement.
· Message Number: The number of the current message is printed.
· Sender Module: The name of the module sending the message is printed.

· Use Text Formatting to select whether the additional information is to be printed in a separate line and 
whether an empty line is to be inserted between messages.

Message



Log File Options
These options influence the appearance and the format of the text to be output by the Message module 
into the log file.
· Use File to specify the name of the log file to be written.
· Use File Options to specify the behavior of DASYLab at the start of a measurement. If Stop if File exists

is selected, the measurement will not be started at all and a warning message will be displayed if the 
selected file exists.

· Use Additional Information to select further information which will be output with the actual message.
· Date and Time: The time the message came in will be output with the message.
· Time Representation: The time the message came in can be output in Real Time (the current date 

and time) or as the elapsed Time since Start of Measurement.
· Message Number: The number of the current message is logged.
· Sender Module: The name of the module sending the message is output.

· Use Text Formatting to select whether the additional information is to be output in a separate line and 
whether an empty line is to be inserted between messages.

Message



 Time Base
 Module

This module either extracts time information from a data channel or from the global sampling rate and 
applies it to the output.

Function Types
Since this module provides different basic operations, you must first select the function     type   when you
install the module.
This module provides two function types:
· The first function type Extract     Time     Base     from     Data     Channel   provides a module with inputs. Time 

information is extracted from the data stream of up to 16 data     channels   and for every data value it is 
applied as time value to the corresponding output.

· The second function type Generate     Global     Time     Base   provides a module without inputs. The time 
information is derived from the global acquisition     rate.  

Settings
Format sets the type of the output data per channel.
· Measurement Time since Measurement Start specifies the number of days which have elapsed since 

the start of the experiment as related to the current channel. Multiplied by 86,400 (seconds per day) 
this value will express the time in seconds.

· X Base in Seconds, Hertz or Pieces outputs ...
· ... for the first function type, the additional information of the time, of the frequency or of the 

number of values for this channel. If, for example, frequency data of an FFT module is involved, the
frequency of a value will be made available at the output.

· ... for the second function type, the global time information in seconds.
In addition, the output values can be reset after a specified number of blocks.

With this module various possibilities open up for further evaluation and control of sequences.

Special Modules
Module Selection Menu



Time Base extracted from Data Channel

This function type of the Time     Base   module extracts time information from up to 16 data     channels   and 
applies it to the output.

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: same as input block size
Max. Number of Modules: any
______________________



Generate Global Time Base
This function type of the Time     Base   module extracts time information from the global acquisition     rate   
and applies it to the output.

Input and Output Characteristics
Number of Inputs: ---
Input Block Size: ---
Number of Outputs: up to 16
Output Block Size: same as global block size
Max. Number of Modules: any
______________________



 Signal Adaptation
 Module

This module synchronizes data streams which have different sampling rates, block sizes or starting 
times.

In the worksheet, this module can have up to 16 signal     inputs.  

Input and Output Characteristics
Number of Inputs: up to 16
Input Block Size: any
Number of Outputs: same as number of inputs
Output Block Size: input block size of the first channel
Max. Number of Modules: any

This module changes parameters like the block size, the sampling rate or the start time of a signal 
representation. The first channel (channel 0) is used as a reference. Its parameters are copied to all the 
other channels (channels 1 to 15).
This module does not perform any calculation of the signal, but it changes its internal representation.

In this version, three adaptation modes are provided. Please note that you cannot switch these modes 
while an experiment is going on.
You can choose one of the following modes:
· Adapt Time only

DASYLab provides its data blocks with a time stamp representing the start time of the block. 
Calculations like addition or multiplication can only be performed on blocks with equal parameters like 
the sampling rate, the start time and the block size.
This mode synchronizes the start time only. It is useful if the other parameters are equal and 
interpolation calculations are to be avoided.

· Full Interpolation
Many modules cannot process data blocks acquired at different sampling rates or block sizes if they 
have not been synchronized.
The Full Interpolation option synchronizes differing data streams by interpolation, by modifying their 
block sizes or their sampling rates as much as necessary for further processing.
The first channel (channel 0) is used as a reference.

· Off
No changes are performed at all. Output data will have the same representation as input data.

Special Modules
Module Selection Menu
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Experiment Menu Commands
The commands of this menu allow you to start, to pause and resume, and to stop an experiment. In 
addition, you can set hardware and global experiment parameters here.

The most frequently used commands of this menu can also be chosen by clicking the corresponding 
icons in the Function Bar or by using keyboard shortcuts.

Start Experiment F5

Stop Experiment CTRL+F5

Pause Experiment CTRL+F6

Resume Experiment CTRL+F6
Start/Stop Experiment at Time

Auto Start

Select Driver

Hardware Setup

Experiment Setup
Main Menu Options



Start Experiment

Experiment menu command: Start

Choose this command, or click the function bar icon, or press F5, to start an experiment.

Click these function bar icons, or choose the corresponding commands from the Experiment menu, or 
press the shortcut keys, to ...

stop the experiment completely:
Stop CTRL+F5

pause the experiment:
Pause CTRL+F6

resume the experiment:
Resume CTRL+F6

Experiment Menu Commands



Pause Experiment

Experiment menu command: Pause

Choose this command, or click the function bar icon, or press CTRL+F6, to pause an experiment. 
(Ö indicates that the experiment has been interrupted.)
This command stops the acquisition of new data, for example from a signal generator module, an A/D or
digital input module, a PID or manual control. Data already acquired and still in the pipes will be 
retained, however, and processed completely.
The Pause command is available only if the worksheet does not contain any module accessing the data 
acquisition hardware. The reason is that DASYLab derives its own clock from the board's master clock. 
This is not available if the measurement is paused. To pause a running experiment, use the Stop 
module.

Click these function bar icons, or choose the corresponding commands from the Experiment menu, or 
press the shortcut keys, to ...

resume the paused experiment:
Resume CTRL+F6

start a completely new experiment:
Start F5

stop the experiment completely:
Stop CTRL+F5

Experiment Menu Commands



Resume Experiment

Experiment menu command: Pause

Choose this command, or click the function bar icon, or press CTRL+F6, to resume an interrupted 
experiment. (Ö indicates that the experiment has been interrupted and can be continued. After the 
experiment has been resumed, this menu command will be unselected.)
This command resumes the acquisition of new data, for example from a signal generator module, an 
A/D or digital input module, a PID or manual control.

Click these function bar icons, or choose the corresponding commands from the Experiment menu, or 
press the shortcut keys, to ...

pause the resumed experiment again:
Pause CTRL+F6

start a completely new experiment:
Start F5

stop the experiment completely:
Stop CTRL+F5

Experiment Menu Commands



Stop Experiment

Experiment menu command: Stop

Choose this command, or click the function bar icon, or press CTRL+F5, to stop an experiment 
completely. All data will be cleared from the pipes.

Click these function bar icons, or choose the corresponding commands from the Experiment menu, or 
press the shortcut keys, to ...

start a completely new experiment:
Start F5

pause the experiment:
Pause CTRL+F6

resume the paused experiment:
Resume CTRL+F6

Experiment Menu Commands



Start/Stop Experiment at Time
Experiment menu command: Start/Stop at Time

Choose this command to start, stop, and repeat an experiment at a specified time.
The dialog box which opens when you choose this command provides three fields where you can 
specify the time at which an experiment is to start, the duration of that experiment, and the interval after 
which that experiment is to be repeated.

Before you can enter any values, you must first select the corresponding function by clicking its option 
button (Start Experiment at Time, and/or Stop Experiment after Time, and/or Restart Experiment after 
Time). A check mark (Ö) in the option button indicates that a function has been activated.
Then you can enter the time specifications:
· Start Experiment at Time:

Specify the point in time at which the experiment is to begin. The default setting is the current date
and time plus five minutes.
You may either type the values for the date, the hour, the minutes, and the seconds, or you can press 
the UP ARROW or DOWN ARROW key to scroll, or you can choose the values from the drop-down list.

· Stop Experiment after Time:
Specify the duration of the experiment, i.e. the space of time after which the experiment is to stop. 
The default setting is a duration of five minutes.
Again, you may type or scroll through and choose the values.

· Restart Experiment after Time:
Specify the interval after which the experiment is to be repeated. There is no default setting for this
interval.
Again, you may type or scroll through and choose the values.
When this function has been activated, the experiment will be repeated according to the specified data
until you
· stop the experiment, or
· de-activate this function by clearing the option button in this dialog box, or
· modify the current worksheet, or
· open or create another worksheet.

While any of the Start/Stop by Time functions is active, a message is displayed in the status     bar   
reminding you of the time at which an experiment is due to start or stop.

Experiment Menu Commands



Auto Start
Experiment menu command: Auto Start

Choosing this option (indicated by Ö) prepares the experiment setup (the worksheet you have saved to 
file) for an automatic start later on. Enter the DASYLab command followed by the worksheet file name
(for example, in the Command Line box of the Program Item Properties dialog box of the Windows 
Program Manager) to start the experiment directly.

See Starting     a     DASY  Lab     Experiment     Automatically   for further hints.

The setting specified here is not part of the worksheet file when you choose the Save or Save     As...   
commands from the File menu. However, it will be saved together with information about the window size
and position when you exit the program.

Experiment Menu Commands



 Hardware Setup
Experiment menu command: Hardware Setup
If you have installed a data acquisition board in your system, you must set its parameters in this box.
The values entered here must correspond exactly to the board configuration to ensure correct data 
processing by DASYLab.
Choose Hardware from the Help menu to obtain further help on this box. The information you will find 
there refers to the data acquisition board type you have declared when ordering your DASYLab 
version.
Experiment Menu Commands
______________________



 Experiment Setup
Experiment menu command: Experiment Setup

In this box, set general parameters for data acquisition and measurement control.

Together with the resources provided by your system and the size of the worksheet you have designed, 
these settings have decisive influence on the overall data processing performance as well as on the 
response time of the individual functions.
The parameters to be specified here are:
· the sampling     rate   per channel (If you operate channels at differing sampling rates, enter the highest 

sampling rate here.);
· the global block     size;  
· the global settings for analog     output   and digital     output;  
· the Synchronization mode, which determines the clock source for all internal data sources of DASYLab

(Generator, Slider, etc.). The two modes available are PC Clock and Data Acquisition Hardware;
· options for Disk     Streaming;  
· the Driver Settings, which contain - depending on the installed hardware - the driver     buffer     size,   the 

acquisition     mode   and the connected parameters Blocks per Series and Delay. 

Experiment Menu Commands



Sampling Rate
Set the Sampling Rate per channel here.
The value entered here always defines the sampling rate for all the channels.
You can specify whether this value represents Hertz, Kilohertz or Megahertz or minutes, seconds or 
milliseconds respectively.
If you wish to operate channels at lower rates, you must reduce their data rate by using Separate or 
Average modules. However, this procedure always yields channel rates which are true divisors of the 
fastest rate (i.e. the global rate).

If you specify a sampling rate which is too high for the data acquisition board type in your system, or if 
the overall sampling rate is too high because you have specified too many channels at high sampling 
rates, you will be warned by DASYLab, either before exiting this box, or before exiting the analog 
channel selection box. Automatically, the sampling rate will then be rounded up or down to the nearest 
accepted value.

With most of the data acquisition boards supported by DASYLab, the sampling rate is generated by the 
board itself. It is therefore easily possible that you enter a value not supported by the hardware. 
However, these values will automatically be adjusted by DASYLab without further information to the 
user.

If you use interrupt driven boards at acquisition speeds too high for the system, some interrupts and the 
corresponding samples may get lost. The indicator on the status bar at the bottom of the DASYLab 
window, next to the buffer indicator, shows whether DASYLab has detected such a situation: If this 
indicator flashes in yellow, interrupts have been lost. If the amount of lost samples is greater than 2%, 
the experiment is aborted.

Some boards cannot indicate lost interrupts by a hardware flag. In these cases DASYLab tries to look for
lost interrupts by software. This software solution cannot guarantee, however, that all lost samples will 
be detected. With these boards it is therefore possible that samples are lost without any indication.

Experiment Setup
Experiment Menu Commands



Driver Buffer
Specify the driver     buffer     memory     size   here which the acquisition board driver can use to store data 
temporarily. The value entered here is in kilobytes.

You can enter any driver buffer value between 4 KBytes and 16,384 KBytes. The default setting is 64 
KBytes. If the on-board memory resources of your computer are limited, you should enter a smaller 
value here. You will be warned if the value you have entered is not valid.

Experiment Setup
Experiment Menu Commands
______________________



Block Size
The Block Size determines the number of values that will be computed by the worksheet modules 
during a single processing cycle. Any value from 1 to 8,192 can be entered here, though powers of 2 are
preferred.

The modules will not process the data completely until the number of values specified here has been 
provided by all the inputs of that module.

The concept of computing the data in blocks increases the speed of the measuring process 
considerably; on the other hand, it strongly influences the real-time performance of the system. 
Therefore, the block size should be selected with great care, taking these principles into account:
· large block size > long latency period (i.e. the response of ensuing modules - like control 

modules - will be slower)
> high data transfer rate

· small block size > short latency period (i.e. the response time of ensuing modules will be 
shorter)
> low data transfer rate

As the actual data transfer capacity of a system depends upon many factors, a general formula of how 
to determine the ideal block size cannot be provided.
As a general rule, it may be said that fast data acquisition operations require large block sizes, while 
small block sizes may be of advantage for slow data acquisition and control operations.

We suggest setting a block size of half the sampling rate for a start, then trying out various other values 
to find the best value for your individual task.

Experiment Setup



Acquisition Mode
Specify the Acquisition Mode here. The available modes depend on the installed hardware and the 
modes supported by the driver.
· Continuous:

After the experiment start, the data will be acquired without interruption at the specified 
sampling     rate   and processed by DASYLab.

· One Series
After the start of the experiment, the data will be acquired without interruption at the specified 
sampling     rate   until a certain amount of data defined by the Blocks     per     Series   setting has been 
reached.

· Running Series
This mode is a repetitive One Series mode. After the specified number of blocks the acquisition is 
interrupted for at least the time specified by Delay. If the delay is too short for DASYLab to process all 
the data, the acquisition will be delayed for a longer time.
The delays are not recognized by the display instruments. This means that in this mode there is no 
time of day correspondence for the data.They are treated as continuous in DASYLab.
This mode is especially useful for fast scope applications.

· Isolated Series
This mode is essentially the same as the Running Series mode. The only difference is that the gaps 
are recognized by DASYLab. The resulting data stream is not continuous.

Quite obviously, this method leads to acquisition gaps between the blocks. Their size depends on the 
number of active channels, on the block size, on the complexity of the ensuing processing arrangement, 
and on the hardware resources.
This mode may be useful in cases where a high sampling rate is essential, while continuous high-speed 
data acquisition and processing cannot be realized, e.g. due to limited hardware resources.
If you wish the acquisition to stop after a certain time, enter the corresponding number of values in the 
Count field. (This value can be freely specified for each channel.) After that number of data has been 
acquired, the acquisition will be stopped automatically.
(The default setting for this field - zero - means that the acquisition process is not supposed to be 
aborted when a certain number of values has been acquired.)

Experiment Setup
Experiment Menu Commands



 Analog Output and Digital Output
In this dialog box, set the general output parameters for analog and digital output individually.
· Output Mode

The Output Mode determines whether the data are sent out synchronously at the acquisition     rate,   or 
asynchronously, which means as fast as possible but in undetermined intervals.
· In the synchronous mode, data is sent out according to the acquisition     rate   specified for each 

output channel.
· In the asynchronous mode, data is sent out as fast as possible. The maximum rate depends on 

your hardware, the speed of your PC and the complexity of the worksheet. You should experiment 
with these rates to find out the best combination for your individual task.

· Output Buffer
· If the Fill once option is selected, the output buffer will be filled only once, with the first block of 

data coming in after the experiment start. When the buffer is full, that first block of data will be sent 
out repeatedly, always beginning with the first data again. Any further values coming in from the 
worksheet will be ignored.

· If Continuous refill is chosen, the output buffer will continuously be filled with the data coming in 
from the worksheet, and these will then be sent out.

· Output Rate
The output frequency defined in this list box only takes effect when the synchronous mode is selected.
Only frequencies which are an integer divider of the global     acquisition     rate   are allowed.
Changing the global acquisition rate also affects the output rate.

· Output Start
The value entered in the Output Start list box defines the number of samples which are to be collected 
before the analog output actually starts. This value must be the same as the global     block     size,   or a 
multiple of it.
This feature can be used for a defined delay or to synchronize the values which come from the 
worksheet.

Analog Output Module
Digital Output Module
Experiment Menu Commands



Disk Streaming
Using this menu item of the Experiment     Setup   window, the fast storage of measurement values can 
be enabled or disabled.

General Notes
Disk Streaming opens up an additional possibility to write DASYLab data onto mass storage media. 
While the Write     Data   module writes data of the data stream of up to 16 channels into a file, 
Disk Streaming stores the data of all channels in a highly compressed 2-byte integer format. Thus the 
amount of required storage space is reduced and the writing procedure is speeded up since only a 
fractional part of the data amount is produced. Additionally, the integer data of the driver need not be 
converted into the floating point data of DASYLab. This is the main reason why Disk Streaming can write 
data gathered at a high acquisition     rate   to the mass storage device. (No other channels should be 
connected to the A/D, Digital or Counter     Input   modules, since this would significantly reduce the time 
advantage.)

Activation
Disk Streaming settings are made entirely in the Experiment Setup dialog box.
In the lower part of the dialog box, Disk Streaming can be enabled or disabled. The name of the next file 
for storing data is displayed to the right of these buttons. 
Select the File Name button to change the name of the streaming file. Then, a file selection window 
opens which contains all the provisions to enter a new file name.
You can set the default     directory   for disk streaming files in the Options menu.
Data is stored in the DASY  Lab     data format (universal format 0). (For a description of this data format, 
please see chapter 6 of the Owner's Manual.)

Options
Using the Options button further settings can be made for Disk Streaming.
· Stop if channels are connected

If this option is enabled, a warning message will be issued and the measurement will immediately be 
stopped if channels are connected to the analog, digital or counter inputs. All channels from all analog 
inputs on the worksheet are streamed rapidly to disk without connecting any wires. This check box will 
alert the user that wires are connected from some analog inputs and streaming to disk will be much 
slower.

· Stop if file is to be overwritten
This option prevents overwriting an existing Disk Streaming file. If a file with the specified name exists 
and would be overwritten, the measurement will be stopped immediately after it has been started, and 
a message will be issued.

· Ring Buffer
This option implements a buffer containing the last n measurement values per channel. n is specified 
at Samples per Channel.

Open Data Files
Disk Streaming files are opened - like other data files too - by using the Read     Data   module. If the file to 
be opened is a Disk Streaming file, the Universal 0 format information is shown in the Data Format field 
of the Read Data module's dialog box. (DASYLab data written without Disk Streaming are stored in the 
Universal 1 data format.)
Using the Channel Group combo box you can select which channels you want to be read from the data 
stream: Analog 0 identifies the first 16 scanned analog channels, Analog 1 the next 16 scanned analog 
channels, and so on. The same applies to Counter X. For Digital Port X the selected port will always be 
displayed, as it was saved with the original worksheet.

Experiment Menu Commands



Automatic Program/Experiment Start
DASYLab features several possibilities to start an experiment automatically. The following survey 
informs you about relevant menu commands which allow you to control an experiment automatically 
under DASYLab. In addition, you will find tips on how to set up automatically controlled experiments by 
making use of batch files and Windows resources.

Hint: The concept of event     driven     actions   enlarges the capabilities of DASYLab in the field of 
automatic measurement control. An Action module can react on detected events with certain 
activities, such as opening and starting a new worksheet, printing displays, resetting values 
etc.

Start/Stop via DDE
DASYLab experiments can be controlled by other applications using DDE. (The menu command which
had to be selected in former DASYLab versions is no longer necessary.)
Additional information regarding DDE can be found in Chapter 6 of the manual.
For demonstration purposes the DASYLab disks contain a small Windows application using DDE to 
start and stop DASYLab.

Start/Stop at Time
Choose the Start/Stop at Time option from the Experiment-menu to start, stop, and repeat an 
experiment at a specified time.
The dialog box which opens when you choose this command provides three fields where you can 
specify the time at which an experiment is to start, the duration of that experiment, and the interval 
after which that experiment is to be repeated.

Using the Auto Start Function
Choosing the Auto Start option from the Experiment menu prepares the experiment setup for an 
automatic start later on.
· Activate the Auto Start option from the Experiment menu (indicated by Ö).
· Choose Save or Save     as...   from the File menu, or click the corresponding function bar icon, to save

your worksheet.
· When you end your DASYLab session, the setting of the Auto Start option will automatically be 

saved together with other window settings.
· When you start DASYLab the next time, type its program file name at the command line together 

with the file name of the worksheet which is to be opened and activated automatically.
Example: DASYLAB D:\WRKSHEET\EXPMT1.DSB

where WRKSHEET is the directory on drive D: where your worksheet files are saved, and 
EXPMT1.DSB is the experiment setup file which is to be started automatically.

Thanks to the Auto Start function, DASYLab will not only open that worksheet, but it will also start 
the experiment at once.

You may now wish to customize this start-up mode to perfection:
· Create a batch file containing the command line described above (including the worksheet file 

name). Save it under a telling file name.
· Add the option to the DASYLab icon displayed in the Windows Program Manager, or even create 

a special icon for that experiment to be always at hand in your DASYLab program group in the 
Windows Program Manager:
· Copy the DASYLab icon in the DASYLab program group of Windows Program Manager (press 

F8, or choose Copy from the Program Manager File menu).
· Select this new copy by clicking it once, then press ALT+ENTER, or choose Properties from the 

Program Manager File menu.
· Add the worksheet file name (including its path) to the DASYLab command in the Command Line

box of the Program Item Properties dialog box of Windows Program Manager, and close the box 
by pressing the ENTER key.

· Thus you can even provide several DASYLab icons with different worksheets and experiment 



setups for automatic starts.
· You can now start any of these experiments directly by clicking the corresponding Program 

Manager icon (or by typing the batch file name).

Starting an Experiment at the same time as Windows
If you copy one of the experiment icons described in the section before to the AUTOSTART group of 
Windows Program Manager, the respective experiment will be started immediately as soon as 
Windows is started.

Starting an Experiment at the Boot-Up of your Computer System
If then you add the Windows command to your AUTOEXEC.BAT file, the experiment will even be 
started when you switch on your computer system. This offers you many interesting possibilities to 
perform measuring tasks automatically.

Main Menu Options



Select Driver

General Notes
DASYLab supports a wide range of data acquisition hardware from different vendors. You will typically 
need a different hardware driver for each manufacturers data acquisition hardware. If you have more 
then one hardware driver installed on your system you may switch between them using the Select Driver 
function.
Note that only one driver can be used at a time.

Activation
The Select Driver dialog box lets you select one out of the installed hardware drivers. The change does not take 
place immediately, but only after leaving and entering DASYLab once again.

Experiment Menu Commands
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View Menu Commands
The commands of the View menu allow you to change the appearance of the DASYLab worksheet.

Some of these functions can also be chosen by clicking on the icons on the function bar.

Overview

Hide

Show Display Windows

Hide Display Windows

Animation

Function Bar

Module Bar

Save Window Arrangement

Select Window Arrangement

Delete current Window Arrangement
Main Menu Options



Overview
View Menu Command: Overview
Choose this option to display the complete DASYLab worksheet at a reduced size in a separate 
window. (Ö indicates that this function has been chosen.)
The additional display gives you an overview of your complete worksheet. However, you cannot edit 
or change it in that separate window.
The display is automatically scaled to the size of the worksheet to be presented.

The   DASY  Lab     Screen  
View Menu Commands
______________________



Hide

View Menu Command: Hide

Choose this function or click on the icon on the function bar, to reduce the DASYLab worksheet window 
to its minimum size.

In its place, a minimized control panel appears which contains only the status bar (displaying the 
current time and the buffer status) and the control icons from the function bar, which allow you to start, 
stop, pause and continue the experiment.

Additionally, all active display windows (analog/digital meters, scopes etc.) are displayed on screen.
This option allows you to concentrate on those elements which are essential for the control and 
evaluation of the actual experiment.

You can restore the original window size by clicking the Restore Size arrow in the upper right hand 
corner of the control window.

> Please note that the effect of clicking this arrow may differ from the effect which you know from other 
Windows applications: The control window is not necessarily enlarged to full screen size, but only to 
the size the worksheet window had when the Hide function was chosen.

View Menu Commands



Show Display Windows

View Menu Command: Show Display Windows

Choose this function or click on the icon on the function bar, to activate all the display windows 
contained in the worksheet.
All the display windows still in icon form will be restored.

Attention: When you activate several display windows of the same type (eg. Y/t Charts or Bar 
Graphs) using this function, they will all be automatically opened in the center of the screen,
on top of each other. Drag the top window to one side to view the next display window.

> To restore only one display window, double-click its icon at the bottom of the computer screen.
> To minimize all the display windows contained in your worksheet simultaneously, choose Hide 

Display Windows from the View menu, or click the function bar icon.

View Menu Commands



Hide Display Windows

View Menu Command: Hide Display Windows

Choose this function or click on the icon on the function bar, to minimize all the display windows 
contained in the worksheet. Each one is represented by an icon at the bottom of the screen.
All the activated display windows will be minimized.

> To minimize one display window individually, click its Minimize button (in the upper right-hand corner 
of the display window).

> To activate all the display windows contained in your worksheet simultaneously, choose Show 
Display Windows from the View menu, or click the corresponding function bar icon.

View Menu Commands



Animation
View Menu Command: Animation
Choose this option to switch the animation of the worksheet on or off (Ö indicates that this function 
has been activated.)
When Animation is active, the data flow will be visualized by the small bar indicators below the output 
symbols of the respective modules.
Data may be processed slower with the Animation function activated, because graphics operations 
always require a considerable part of the system resources.

The   DASY  Lab     Screen  
View Menu Commands
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Function Bar Display
View Menu Command: Function Bar
Choose this option to display the Function     Bar   below the main menu bar of the DASYLab window. (Ö 
indicates that this function has been chosen.)
To enlarge the work area for your worksheet,. remove the function bar from the screen.
To redisplay the function bar, choose this command from the View menu.
The function bar provides easy and convenient access to several functions which you may frequently 
require in your experiment: Just click the icon representing the function.
If you have removed the function bar, you can still use the functions by using the menu commands.
When the mouse pointer is pointing at a function bar icon, a little QuickInfo tag with the name of that 
function will appear. (You will find such tags in all of the module windows providing a function bar, such
as the display     windows   of the Y/t     Chart   or the List     Display   modules.)

The   DASY  Lab     Screen  
View Menu Commands
______________________



Module Bar Display
View Menu Command: Module Bar
Choose this option to display the Module     Bar   on the left hand side of the DASYLab window. (Ö 
indicates that this function has been chosen.)
By removing the module bar you can enlarge the work area for your worksheet.
To redisplay the module bar, choose this command from the View menu.

The   DASY  Lab     Screen  
View Menu Commands
______________________



Save Window Arrangement

View Menu Command: Save Window Arrangement

By choosing this function or clicking the icon on the function bar, you can save the sizes and positions 
of all the activated display     windows   and define an identifying tag for that arrangement.
Using this function you can easily switch between different display window arrangements even while an 
experiment is running. You can save up to 8 different display window setups.

To activate this function,
· click the above function bar symbol, or
· press ALT+SHIFT+Arrangement Number (1-8) on your keyboard, or
· choose the Save Window Arrangement command from the View menu.
The Window Arrangement dialog box appears, displaying the Arrangement Number and Text either of the 
current setup, or - if you have used the keyboard shortcut - of the setup whose number you have typed 
after ALT+SHIFT.
You can now save the current arrangement under any Arrangement Number from 1 to 8 and add a name 
or short description of your choice in the Text field. Click OK, or press ENTER, to complete the procedure.
If an arrangement has already been saved under this number, you will be warned.
The name or description you have entered in the Text field appears in the list of window setups on the 
function bar.

> Choose Select     Window     Arrangement   to re-arrange the display windows in one of the ways you have 
saved before.

> Choose Delete     current     Window     Arrangement   to delete the current setup from the list of saved 
arrangements.

Customizing     the     DASY  Lab     Screen  
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Select Window Arrangement
View Menu Command: Select Window Arrangement

Choose this function to re-arrange the activated display     windows   on the screen in one of the 
arrangements you have saved before. Each of the activated display windows immediately appears in 
exactly the same position and size which has been saved.
Additional display windows (not contained in the arrangement when it was saved) remain in their 
positions while the others return to their defined places on the screen.

To activate this function,
· click on the list box on the function bar (or on the down arrow on its right), or
· press ALT+0 on your keyboard, or
· choose the Select Window Arrangement command from the View menu.
In the function bar list box, the name tags of all the saved arrangements are listed. Click on the name of
the arrangement which you want to restore, or choose that tag by pressing the arrow keys on your 
keyboard; then press ENTER.
Using a keyboard shortcut, you can select any of the saved arrangements directly:
· Press ALT+Arrangement Number (1-8).

Attention: If you restore one of the saved window arrangements as described, the sizes and positions 
of the current display windows will be lost, unless you have saved them under another 
Arrangement Number.

Attention: If you delete one of the display modules contained in the saved window arrangement from 
the worksheet, its display window is irrevocably removed from the saved arrangement, 
too. To restore the original setup, you must not only re-install the display module in the 
worksheet, but also save the display window arrangement again as it was before.

> Choose Save     Window     Arrangement   to save the current sizes and positions of all the activated 
display     windows.  

> Choose Delete     current     Window     Arrangement   to delete the current setup from the list of saved 
arrangements.

Customizing     the     DASY  Lab     Screen  
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Delete current Window Arrangement

View Menu Command: Delete current Window Arrangement
Choose this function, or click the icon on the function bar, to delete the currently displayed setup of 
display     windows   from the list of saved arrangements.
Only the information concerning the sizes and the positions of the display windows are removed; 
the display windows themselves remain in the worksheet unchanged.
To activate this function,

· click the above function bar symbol, or
· press ALT+STRG+Arrangement Number (1-8) on your keyboard, or
· choose the Delete current Window Arrangement command from the View menu.

You will be asked to confirm your decision before the information is actually deleted.
> Choose Save     Window     Arrangement   to save the current sizes and positions of all the activated 

display windows.
> Choose Select     Window     Arrangement   to re-arrange the display windows in one of the ways you have 

saved before.

Customizing     the     DASY  Lab     Screen  
View Menu Commands
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Options Menu Commands
The commands of the Options menu allow you to change the display of the DASYLab worksheet, select 
default directories for all the program and data files, switch the Autorouter function on and off, and define
and edit passwords for your worksheets.

Window Setup

Default Directories

Colors

Autorouter

Password Protection

Password Definition
Main Menu Options



Window Setup
Options Menu Command: Window Setup

Choose this command to change your DASYLab screen settings and program start options.
· Window Type

Choose whether you wish the worksheet background to be a grid.
· Type of Grid

If you have activated the grid, choose the Type of Grid in the next field:
· Dots: Only the grid intersections will be marked by dots.
· Lines: A complete grid will be displayed.

· Spacing
Choose the measure for the screen grid in the next field.
This is also the minimum distance between modules.
The modules you install afterwards will be placed according to this setting (between 8 and 48 points). 
If you change the spacing value, this will not affect the existing worksheet. If, however, you move one
of the original modules, it will be positioned according to the new settings.
The distance selected here should not be less than 16 to leave enough space for the data     channels   
between module symbols.

· Start Options
· By default, a DASYLab copyright information is displayed at program start. In the 

Show Copyright Information box you can choose if you wish this information to be displayed each 
time or not.

· When you open a flow chart, the module     bar   settings which were saved with it will be loaded, too, 
possibly modifying the current module bar settings which you'd rather maintain.
Activate the Load Module Bar with Flow Chart box if the current module bar configuration is to be 
replaced with the new one from the worksheet file.
Deactivate this box if you wish to retain the current module bar configuration whenever you open a 
worksheet file.

The settings specified here are not part of the worksheet file when you choose the Save or Save     As...   
commands from the File menu. However, they will be saved with information about the window size and 
position when you exit the program. When you start DASYLab the next time, you will find the same work 
environment.

Customizing the   DASY  Lab     Screen  
Colors
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Default Directories
Options Menu Command: Default Directories

Using this menu item you can set and modify the locations of drives and directories which DASYLab 
uses by default for loading or saving files. Different directories can be set up for various file types.
When you select this menu item, a dialog box is opened, displaying each file type with the currently valid
directory. The setup can be changed by clicking on the respective switches.

Default drives and default directories can be specified for the following file types:
Item file type

· Worksheet DASYLab worksheet files (extension *.DSB)
· Streaming data files for fast disk     streaming  
· Data data files of the Write     Data   module
· Devices configuration files of the serial     interface   and of the IEEE     interface  
· Other module bar, interpolation and other files

By clicking on a switch a dialog window opens allowing the selection of a drive and a directory. New 
directories can also be created here.

The drives and directories specified here are only used as defaults. If a file name must be assigned 
while working with DASYLab, these pre-set locations are shown in the input window for the respective 
file type. If required, a different drive and directory can be selected.

After the initial installation the DASYLab installation directory is taken for all default settings.

The settings made here are saved in the DASYLAB.INI file in the Windows directory.

Options Menu Commands



Colors
Options Menu Command: Colors

Choose the colors for your DASYLab worksheet display. You can specify colors for the background, the 
grid and the data     channels   (wire core and sleeve separately):
· Select the item the color of which you want to change.
· Point to the color of your choice in the Standard Colors palette, and then click it using the left mouse 

button. Then click OK.
· If you prefer to create your own custom color, click Edit     Colors.  

The settings specified here are not part of the worksheet file when you choose the Save or Save     As...   
commands from the File menu. However, they will be saved with information about the window size and 
position when you exit the program. When you start DASYLab the next time, you will find the same work 
environment.

Customizing the   DASY  Lab     Screen  
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Edit Colors
Options Menu Command: Colors / Edit Colors

You can create custom colors for the background, the grid or the data     channels   (wire core and sleeve 
separately):
· Select the item you want to change.
· From the Standard Colors or the Custom Colors palette, choose the color you want to edit by clicking it

using the left mouse button.
· Choose Edit Colors.
· · To increase or decrease the amount of primary color, brightness and/or saturation used in a color, 

drag the crosshairs and/or the vertical scroll bar with the left mouse button pressed.
· Or type new numbers from 0 to 255 in the corresponding boxes.
· The resulting custom color is displayed in the Custom box.
· To reset all the values for the standard color which comes nearest to the custom color you have just

defined, double-click the Standard box.
· Choose the OK button to change the color of the selected screen element to the custom color.

To return to the color originally displayed on the screen, choose the Cancel button.

The settings specified here are not part of the worksheet file when you choose the Save or Save     As...   
commands from the File menu. However, they will be saved with information about the window size and 
position when you exit the program. When you start DASYLab the next time, you will find the same work 
environment.

Customizing the   DASY  Lab     Screen  
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Save Custom Colors

· To save the custom color you have defined for later use:
· Click any of the boxes in the Custom Colors palette first.
· Then modify its color as described above.
· Click Add Color to Palette.
· Specify further colors from the Custom Colors palette and modify them.
· Choose the OK button to change the color of the selected screen element to the custom color.

To return to the color originally displayed on the screen, choose the Cancel button.



Autorouter
Options Menu Command: Autorouter

Choose this option to switch the Autorouter function on or off (Ö indicates that this function has been 
activated.)
· When the Autorouter is active, DASYLab automatically finds the correct paths for your data     channels.  

DASYLab ensures that the data channels do not run across modules or hide other data channels.
A control window on the Status Bar displays the progress of the autorouting operation.

· When the Autorouter is not active, you can determine the paths of your data channels yourself.
Please note that the Autorouter function cannot automatically rearrange existing data channels so that 
they will take the shortest or the direct way between modules. If, for example, you wish to rearrange a 
data channel or move a junction to a different position to improve the clarity of your worksheet structure, 
you must do this manually.

Creating data channels
Deleting data channels
Rearranging data channels
Options Menu Commands



Password Definition
Options Menu Command: Password Definition

This option allows you to protect a worksheet against unauthorized use or modification.
This protection is activated by:
· clicking the Password     Protection   command (Ö indicates that this function has been chosen),
· specifying the password itself (using the Password Definition command),
· and then saving the worksheet.

Password Protection always affects the entire current worksheet.
If Password Protection has been activated and the worksheet has been stored, it can only be opened 
again by entering the correct password.

A password consists of at least 4 and up to 10 alphanumeric characters. If the number of entered 
characters is less than 4, a warning message will appear when you close the dialog box.
For security reasons the password must be entered twice. If the two entered passwords are not 
identical, they will both be deleted and you can enter them again.
While you type the password, the characters you are entering appear as stars ( * ).
Please note that password recognition is case-sensitive.
A correctly entered password is valid until:
· you exit DASYLab, or
· a different password is entered, or
· you open a different worksheet requiring a (probably different) password, and you enter that new 

password correctly.

If Password Protection is activated without a password being entered at the same time, the user will be 
prompted to specify the password when the worksheet is to be stored.

Attention: If you have forgotten or do not know the password of a protected worksheet, you will not be 
able to use it again. Please take this into consideration when you choose a password, and 
take adequate precautions so that you will always remember your passwords.

Options Menu Commands



Password Protection
Options Menu Command: Password Protection

This option allows you to protect a worksheet against unauthorized use or modification.
This protection is activated by:
· clicking the Password Protection command (Ö indicates that this function has been chosen),
· specifying the password itself (using the Password     Definition   command),
· and then saving the worksheet.

Password Protection always affects the entire current worksheet.
If Password Protection has been activated and the worksheet has been stored, it can only be opened 
again by entering the correct password.
This function is only relevant when you save a worksheet. It does not affect any other function or 
module.

Attention: If you have forgotten or do not know the password of a protected worksheet, you will not be 
able to use it again. Please take this into consideration when you choose a password, and 
take adequate precautions so that you will always remember your passwords.

Options Menu Commands
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DASYLab Glossary
Click the term on which you would like to obtain further information.

Attention: A line indicates the end of each definition. If you cannot find the line at the bottom of a text 
box, your Help window is too small to display all of the text. Enlarge its size by dragging its 
borders or corners pressing the left mouse button, and click the term again.
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Autorouter
The Autorouter automatically finds the correct paths for the data     channels.   DASYLab prevents the 
data channels from running across modules and from hiding other data channels.
When the Autorouter is not active, you can determine the paths of the data channels.
Please note that the Autorouter function cannot automatically rearrange existing data channels so that
they will take the shortest or the most direct way between modules. If, for example, you wish to 
rearrange a data channel or move a junction     point   to a different position to improve the clarity of your 
worksheet structure, you must do this manually.

Related topics:
Creating data channels
Deleting data channels
Rearranging data channels
Options Menu Commands

______________________



Branches

data channel
junction points and branches
no connections
A branch is a data     channel   segment which branches off from another data channel at a junction point. 
Branches allow you to connect the output of one module to the inputs of several other modules.
Data is transferred between modules via these connections.
Data channels and branches are symbolized by lines as shown above.
By creating branches each module output can be connected to up to 16 inputs of other modules.

Related topics:
Creating data channels
Deleting data channels
Rearranging data channels
Autorouter

______________________



Clipboard
The following DASYLab commands allow you to copy information from DASYLab onto the Windows 
clipboard. (You can also click the function bar icons, which has the same effect but is much more 
convenient than choosing the commands from the menus.)

Worksheet to Clipboard (Edit menu command)

To Clipboard (Display menu command in the display windows of the Y/t chart, X/Y chart, and Chart 
Recorder modules)

List to Clipboard (Edit menu command in the display window of the List Display module)

Clipboard button in the File Info... dialog box from the File menu
Once you have copied the information to the Windows clipboard, you can paste it from the clipboard 
into other Windows applications or documents, like PaintBrush or Word for Windows. To do so, choose
the appropriate command from the target application menu (usually Paste from the Edit menu).
______________________



Country-specific Settings
When displaying text, Windows uses country-specific formats for the time, the date, and numbers. 
(These can be specified in the Windows Control Panel. Choose the International icon.)
When DASYLab displays text on the screen, or writes to a file, the following formats will be used as 
specified in the Windows International dialog box:

· The Number Format settings (decimal separator, leading zeros) affect:
· the axes display in the display windows of the Y/t     Chart, X/Y     Chart   and Chart     Recorder   modules;
· the display of numbers in the display windows of the List     Display, Digital     Meter, Bar     Graph   and 

Analog     Meter   modules;
· the formatting of data when Writing Data in the ASCII format;
· the display in all of the dialog boxes requiring numerical input.

· The Time Format settings (12/24 hour, separator, leading zeros) and
· the Short Date Format settings (order, separator, leading zeros) affect:

· the time axis display in the display windows of the Y/t     Chart, Chart     Recorder   and List     Display   
modules;

· the formatting of the time axis data when Writing Data in the ASCII format;
· the display of the current time in the status bar.
______________________



Data Channels

data channel
junction points and branches
no connections
A data channel is the connection between the output of a module and the input of another module.
Data is transferred between modules via these connections.
Data channels and branches are symbolized by lines like the ones shown above.
By creating branches each module output can be connected to up to 16 inputs of other modules.

Related topics:
Creating data channels
Deleting data channels
Rearranging data channels
Autorouter

______________________



DMA
Direct Memory Access (DMA) improves the system performance by allowing external devices to 
directly transfer information to or from the system memory without operation of the system CPU.
Some board drivers supported by DASYLab use DMA.
Depending on the hardware, the D/A transfer capabilities may be restricted.
______________________



Driver Buffer
The driver buffer temporarily stores data coming in from the data acquisition hardware before it is 
processed by the software.
The driver first stores the acquired data to this buffer (this is done in the background); then DASYLab 
reads it from there.
During time-consuming operations - such as moving windows on the screen - the driver continues 
writing data to that memory area, so that no data is lost.
Data acquisition will be stopped automatically if the buffer memory is full.
The memory segment selected here will be claimed completely by the board driver; neither DASYLab 
nor Windows can access it.
The value entered for the driver     buffer     size   in the Experiment     Setup   dialog box of the Experiment 
menu should be increased if you use a high global acquisition rate. Note, however, that a driver buffer 
setting of about 50 to 75% of the total physical memory available should not be exceeded.
______________________



Function Bar
The Function Bar is below the main menu bar of the DASYLab window. It contains icons which provide
easy access to several functions which you may frequently require in your experiment. Just click the 
icon representing that function.
When the mouse pointer is pointing at a Function Bar icon, a tag with the name of that function will 
appear. (You will find QuickInfo in all of the module windows which provide a Function Bar.)
All the Function Bar icons symbolize menu commands. Click here for a list of the icons currently 
integrated and the menu commands they represent.
By removing the Function Bar you can enlarge your worksheet.

Related topics:
The   DASY  Lab   Screen  
View Menu Commands

______________________



Functions of Multiple Input Channels
The following conditions must be fulfilled if data values acquired by two input channels are to be 
processed simultaneously and output through one channel:
· identical block     size   for both input channels,
· identical data type for both input channels (continuous acquisition, trigger etc.),
· identical sampling     rate   for both input channels,
· identical call-up time of blocks for both input channels.
These conditions (except for the last one) are automatically checked at the beginning of an 
experiment. So, if one of these conditions is not fulfilled, you will get an error message from that 
module.
______________________



IRQ (Interrupt Request Level)
The data acquisition board informs the driver about the termination of an operation (e.g. an A/D-
conversion) using the IRQ channel.
As the IRQ function is quite time-consuming, especially under Windows, the DASYLab data acquisition
rate in IRQ mode is limited to a maximum of 20 KHz.
______________________



Latency Period
The time between the acquisition of the data and the completion of its processing, e.g. by display 
or analog/digital output..
______________________



Module Symbols
Each of the modules available in DASYLab can appear in two forms, both indicating the module's 
function in an experiment: Module Bar icons and worksheet symbols.
· Icon: an element in the Module     Bar,   at a slightly reduced scale.

· Click on the Module Bar icon with the left mouse button to add that module to the 
worksheet, where it takes the first available free space.

· Click on a Module Bar icon with the right mouse button to assign any of the modules 
available in DASYLab to that button.

· Symbol: a complete symbol in the worksheet. This symbol also displays the input and output 
channels you have selected.

· Double-click with the left mouse button on the symbol to configure the module.
· Double-click with the right mouse button on the symbol to delete the module from the 

worksheet or to delete its input/output data channels.
· Use the left mouse button to drag and drop the symbol to any position on the worksheet 

(depending on the spacing value entered in the Window     Setup   box of the Options menu).

· The modules from the Display group also have an additional display     window     symbol.  
Please click here for further information on module     configuration.  
______________________



Module Bar
The Module Bar, on the left hand side of the DASYLab window, displays a selection of frequently used 
modules. To add a module to your worksheet, use the left mouse button to click on its icon.
When the mouse pointer is over a module bar icon, the name of the module is displayed above the 
module bar.
When you click on a button in the Module Bar with the right mouse button, you can assign it to any of 
the available modules. You can configure several Module Bars customized for individual experiment 
tasks and save them to files to open them again later. There is also a Default     Module     Bar   provided by 
DASYLab.
To enlarge the work area for your worksheet, you can remove the Module Bar from the screen. After 
you have removed the Module Bar, you can still install the modules by choosing the respective Module 
menu commands. (To install a Signal Generator module, for example, select Control from the Module 
menu, then choose Generator, or press the ALT, M, C, G keys.)
All the Module Bar settings are saved together with the worksheet file when you choose the Save 
or Save     As...   commands from the File menu. The window size and position will also be saved when 
you exit the program. When you start DASYLab the next time, you will find the same work     environment  
as before.
______________________



NOP Function (No Operation)
The NOP function provided by some modules leaves all the incoming data unchanged. This function 
allows you to compare performance with and without operation by temporarily "switching off" the 
module without having to delete it from the worksheet.
______________________



Worksheet
The worksheet graphically displays the complete experiment setup or measurement procedure, 
including all the modules and channels.
The modules represent individual operations beginning with the acquisition or the generation of data 
up to its presentation on screen or printer. A worksheet can contain up to 256 modules.
The maximum size of a worksheet in pixels is 2000 (vertically) by 2000 (horizontally) regardless of the
screen resolution.
The data     channels   represent the connections between modules. By creating branches each module 
output can be connected to up to 16 inputs of other modules.
If the complete experiment setup is too large to be displayed on the screen, choose the Overview 
option in the View menu to show the complete arrangement in a reduced size.
To provide more space for the display of the worksheet, you can also switch off the display of the 
Module     Bar   and/or the Function     Bar   (both options in the View menu).
To print the worksheet, choose the Print option in the File menu. Be certain that the correct printer 
driver and setup has been configured in the Windows configuration menu before you print.

Related topics:
Customizing     the     DASY  Lab     Screen  

______________________



Worksheet Examples
During the DASYLab setup procedure, a number of demo worksheets are copied to the DASYLab 
directory on your hard disk.

You can open these files by choosing the Open command from the File menu, or by clicking the 
corresponding icon in the Function     Bar.  
These worksheet examples can give you some ideas of the wide range of measuring tasks that can be
solved by DASYLab.

If you choose the File     Info   command from the File menu, or click the corresponding icon in the 
Function Bar, you will find information on that worksheet in the Worksheet Information box.
______________________
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